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 Milli Eğitim Bakanlığı tarafından geliştirilen modüller; 

• Talim ve Terbiye Kurulu Başkanlığının 02.06.2006 tarih ve 269 sayılı 
Kararı ile onaylanan, Mesleki ve Teknik Eğitim Okul ve Kurumlarında 
kademeli olarak yaygınlaştırılan 42 alan ve 192 dala ait çerçeve öğretim 
programlarında amaçlanan mesleki yeterlikleri kazandırmaya yönelik 
geliştirilmiş öğretim materyalleridir (Ders Notlarıdır). 

• Modüller, bireylere mesleki yeterlik kazandırmak ve bireysel öğrenmeye 
rehberlik etmek amacıyla öğrenme materyali olarak hazırlanmış, 
denenmek ve geliştirilmek üzere Mesleki ve Teknik Eğitim Okul ve 
Kurumlarında uygulanmaya başlanmıştır. 

• Modüller teknolojik gelişmelere paralel olarak, amaçlanan yeterliği 
kazandırmak koşulu ile eğitim öğretim sırasında geliştirilebilir ve 
yapılması önerilen değişiklikler Bakanlıkta ilgili birime bildirilir. 

• Örgün ve yaygın eğitim kurumları, işletmeler ve kendi kendine mesleki 
yeterlik kazanmak isteyen bireyler modüllere internet üzerinden 
ulaşılabilirler.  

• Basılmış modüller, eğitim kurumlarında öğrencilere ücretsiz olarak 
dağıtılır.  

• Modüller hiçbir şekilde ticari amaçla kullanılamaz ve ücret karşılığında 
satılamaz. 
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AÇIKLAMALAR 
KOD 581MSP038 

ALAN İnşaat Teknolojisi 

DAL/MESLEK  

MODÜLÜN ADI Ölçülendirme 

MODÜLÜN TANIMI 
Bilgisayarla çizilen mimari ve statik proje çizimlerinin 
ölçülendirilmesi ile ilgili konuların işlendiği öğrenme 
materyalidir. 

SÜRE 40/32 (+40/32 Uygulama Tekrarı Yapmalı) 

ÖN KOŞUL Katman Ayarlarını Yapma Modülünü başarmış olmak 

YETERLİK Bilgisayarla çizilen mimari ve statik proje çizimlerinin 
ölçülendirmesini yapmak 

MODÜLÜN AMACI 

Genel Amaç: 

Gerekli ortam sağlandığında bilgisayarla ölçülendirmeyi 
kurallarına uygun olarak yapabileceksiniz. 

Amaçlar: 

1- Nesneyi kuralına uygun seçip düzeltebileceksiniz. 

2- Ölçülendirmeyi kuralına uygun yapabileceksiniz. 

EĞİTİM ÖĞRETİM 
ORTAMLARI VE 
DONANIMLARI 

Ortam: Bilgisayarla çalışılabilecek sessiz ve sakin bir ortam. 

 

Donanım: Bilgisayar, bilgisayar masası 

Çizim programı (AutoCAD 2002 ve Üstü Versiyonları.) 

ÖLÇME VE 
DEĞERLENDİRME 

Her öğrenme faaliyeti sonunda kendinizi 
değerlendirebileceğiniz ölçme araçları yer almaktadır.  

Öğretmeniniz tarafından hazırlanan ölçme araçları ile modül 
sonunda değerlendirmeye tabii tutulacaksınız. 
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GİRİŞ 
 
Sevgili Öğrenci, 
 
Her meslek dalında (mimarî, makine parçaları imalatı, mobilyacılık, giyim endüstrisi, 

inşaatçılık vb. ) imalatların yapılabilmesi için projeler hazırlanır. Hazırlanan bu projelerin en 
önemli noktası yapılacak imalatın ölçüleridir. İster makine aksamı gibi çok küçük olsun, 
isterse de inşaat elemanları gibi çok büyük olsun ne üretilecekse üretilsin ölçü olmadan 
imalat olmaz. 

 
Ölçülendirme hassas bir konudur. Yapılacak imalatlar ölçülendirmedeki değerlere göre 

yapıldığından dikkat edilmelidir. Ölçü kusurları çoğu kez kabul edilemez sorunlar çıkarır ve 
geri dönüşü olmayan hatalara yol açar. 

 
Çağımız bilgi ve bilgisayar çağı. Neredeyse meslek liselerindeki öğrenciler dışında elle 

çizim yapan kimse kalmadı. Onlar da öğrenmek amacıyla elle çiziyorlar. Sistemi kavradıktan 
sonra meslek liselerinde de bilgisayarlı çizime geçiliyor. Uzun lafın kısası (istisnalar dışında) 
artık çizimler elle değil bilgisayarla yapılıyor. Bu sebeple öncelikle her meslek grubundaki 
teknik elemanın kendi mesleği ile ilgili bir çizim programını bilmesi gerekiyor. Sonra da bu 
programın inceliklerini öğrenmesi gerekiyor. 

 
Bu modülü hazırlarken “AutoCAD 2002” programını kullanarak sizlere bilgisayarlı 

çizim ölçülendirmesini anlatmaya çalıştım. AutoCAD 14 ve üstü sürümlerin hemen hemen 
tamamındaki ölçülendirme esas ve kaideleri büyük ölçüde birbirlerine benzemektedir. Yalnız 
üretici firmalar ticarî gerekliliklerden dolayı her yeni sürümde programdaki bazı görsel 
öğeleri değiştirmektedirler. Görsel olarak değişen unsurlar genellikle içerik olarak 
değişmemektedir. Bu nedenle hazırlanan bu modülü programın diğer versiyonlarını kullanan 
kişiler tarafından da rahatlıkla kullanılabileceğini düşünülmektedir. 

 

GİRİŞ 
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ÖĞRENME FAALİYETİ-1 
 

 
 
Gerekli ortam sağlandığında bilgisayarla nesneyi kuralına uygun seçip 

düzeltebileceksiniz. 
 

 
 

 
Elle çizmiş olduğunuz nesneleri düzenlemek istediğinizde bunu yapmak için neler 

yapmamız gerektiğini hatırlayınız. Aynı şeyleri bilgisayarla yapacak olduğunuzda bundan 
farklı olarak kalem, kâğıt ve silgi kullanmayacağınızı göz önünde bulundurarak nasıl 
yapabileceğinizi arkadaşlarınızdan, ders öğretmeninizden ve ilgili kitaplardan araştırınız. 
Bilgilerinizi arkadaşlarınızla paylaşınız. 

 
 

1. NESNE SEÇME VE DÜZENLEME 
 
 

1.1. Nesne Seçme ve Düzenleme Komutları 
 
Düzenleme işlemlerinde (örneğin; ERASE, COPY, MOVE, TRIM vb.) select objects 

mesajıyla komutun uygulanacağı çizim öğeleri seçilir. Select (seçme) işlemleri çizim 
öğelerinin topluca seçilmesini ve seçilen öğelerin topluca düzenlenmesini sağlayan 
yöntemlerden oluşur. Çizim öğeleri tek tek seçilebileceği gibi konumlar nedeniyle ortak 
özellik gösteren öğeler grup olarak da seçilebilir. 

 
Her seçme işleminden sonra, select objects mesajı görüntülenmeye devam eder. 

Seçme işlemini sonlandırmak için Enter tuşuna veya ‘‘Mouse’’un sağ tuşuna basılmalıdır. 
 
Select objects mesajıyla birlikte çizim öğelerinin daha kolay seçilebilmesi için 

ekrandaki ‘‘Mouse’’ un ( + ) şeklinde olan görüntüsü küçük bir kare şeklindeki Pickbox adı 
verilen seçme kutusu haline gelir. AutoCAD seçilen çizim öğelerini, belirginleştirmek için 
(ekranda fark edilmelerini sağlamak için) kesik çizgi olarak görüntüler. 

 
Aşağıda Select objects komutunun farklı durumlar için kullanılan diğer senekleri 

görülmektedir. 

ÖĞRENME FAALİYETİ–1 

AMAÇ 

ARAŞTIRMA 
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Select (Seçme) Yöntemleri 
 
 Kodu İsmi Kapsamı 
 Sl Single: Sadece bir öğe seçilebilir. 
 W Window: Açılan çerçevenin içine tamamı giren öğeler 
 WP Wpolygon: Açılan çokgenin içine tamamı giren  
 C Crossing: Açılan çerçevenin içine tamamı veya bir kısmı giren  
 CP Cpolygon: Açılan çokgenin içine tamamı veya bir kısmı giren  
 F Fence: Çizilen çizgilerin temas ettiği öğeler. 
 G Group: Gruplandırılmış öğeler 
 P Previous: Bir önceki komutta kullanılan öğeler 
 L Last: En son çizilen öğe 
 ALL All: Çizim alanındaki bütün öğeler 
 A Add: Seçilen öğelere yeni öğe ekleme 
 R Remove: Seçilen öğelerden çıkarma 
 U Undo: Seçilen öğeleri seçim sırasının tersine doğru iptal  
 
Select seçenekleri select objects mesajından sonra komut satırına kodu (kısa ismi) 

veya uzun formları yazılarak aktif duruma getirilebilir. 
 

1.2. Nesneleri Seçme 
 

1.2.1. Tekli Seçim 
 
Select objects (Öğe Seçme) komutu kullanılırken yukarıda verdiğimiz SL, W, WP, C, 

P, F, G benzeri komutlar, komut satırına yazılmazsa, yani komut yalın haliyle kullanılırsa; 
küçük bir kare şeklindeki Pickbox adı verilen seçme kutusu ortaya çıkar ve bununla işlem 
yapmak, düzenlemek istediğimiz öğeleri teker teker üzerlerine tıklayarak seçmemiz gerekir. 
Buna Single (tekli seçim) denilir.  

 
Çizdiğimiz şekiller her zaman çok sade veya birkaç çizgiden oluşan şekiller 

olmayacaktır. Genellikle birçok çizgiden ve öğeden oluşacaktır. Bunlarla işlem 
yaparken(ERASE, COPY, MOVE, TRIM ve benzeri gibi) Single olarak bunları seçmemiz 
bizim için zahmetli ve bir o kadar da zaman alıcı olacaktır. Bunu kolaylaştırmak için 
yukarıda verdiğimiz W, WP, C, CP, F, G, P, L komutları kullanılabilir. Bir de bunların 
hiçbirini kullanmadan sadece Select objects komutundan sonra ortaya çıkan Pickbox adı 
verilen seçme kutusu ile ‘‘Mouse’’un sol tuşuna basarak ekranda büyüklüğünü sizin 
belirleyeceğiniz bir dikdörtgen çizerek de yapabilirsiniz. 
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Resim 1 :Farklı durumlarda Select objects komutunun uygulanması 

 
Örnek olarak yukarıdaki resmi inceleyelim. AutoCAD ekranımızda bulunan üç 

yıldızdan ortada olanı silmek istediğimizi kabul edelim. Alttaki komut satırında da 
görüldüğü gibi erase komutunun seçildiği ve sizden bu komutun uygulanacağı objelerin 
seçilmesini bekleyen  “Select objects: ” (Silmek istediğiniz objeleri seçiniz) uyarısı 
görülmektedir. 

 
Ortadaki yıldızı içine alabilecek bir dikdörtgeni çizmek için yıldızın sol üstüne 

‘‘Mouse’’un sol tuşu ile tıkladığımızda komut satırında “Select objects: Specify opposite 
corner:”(Karşı köşeyi belirtiniz.) uyarısı ve ‘‘Mouse’’un sol tuşuna basılı tutarak sol üstten, 
sağ alta doğru çizdiğimizde ekranda aşağıdaki şu görüntü oluşur:  

 
1.2.2. Çoklu Seçim 
 

 
Resim 2 :Farklı durumlarda Select objects komutunun uygulanması-2 
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‘‘Mouse’’un sol tuşunu bırakıp bir kez sol tuşu tıkladığımızda görüntü aşağıdaki şekli 
alır ve komut satırına da dikkat edilirse “Select objects: Specify opposite corner: 10 found” 
“10 nesne seçildi” uyarısı görülür. 
 

 
Resim 3 :Çoklu seçim 

 
Ortadaki yıldızı seçme işlemimiz tamamlanmış ve seçtiğimiz obje anlaşılır olması için 

kesik çizgilerle görünür hale gelmiştir. Bu konumdayken klavyedeki Enter tuşuna bir kez 
bastığımızda veya ‘‘Mouse’’un sağ tuşuna bir kez bastığımızda ortadaki yıldızın (öğenin) 
silindiğini görebiliriz. 
 

 
Resim 4 :Çoklu seçim-2 

 



 

 7

(Burada erase komutu örnek olarak verilmiştir. Seçme işlemi gerektiren bütün 
komutlarda seçimler bu şekilde yapılabilir.) 

 
Dikkat edilirse resimde görüldüğü gibi seçme işlemine sol üstten sağ alta doğru 

yaptığımızda seçme işlemi için oluşturduğumuz dikdörtgen düz bir çizgi ile belirtilmektedir. 
Çizdiğimiz dikdörtgenin içine ancak tam olarak girebilen öğeleri seçebilmektedir. Aynı 
resimde görüldüğü gibi sağ ve soldaki diğer iki yıldızın uçları dikdörtgenin içine girmekle 
birlikte çizgilerinin tamamı dikdörtgenin içine girmediği için seçilmemiştir. 

 
Yukarıda anlattığımız işlemin tersi de vardır. Yani çizmiş olduğumuz dikdörtgeni 

sağdan sola doğru çizecek olursak, bu defa dikdörtgenin kesik çizgilerden oluştuğunu 
göreceğiz.  

 

 
Resim 5: Crossing yöntemi ile çoklu seçim 

 
Bir önceki seçme işleminde yaptığımız işlemin aynısını bu defa sağ üstten sol alta 

şeklinde yaparsak ‘‘Mouse’’un sol tuşunu bıraktığımızda aşağıdaki şekil görülür. 
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Resim 6: Crossing yöntemi ile çoklu seçim-2 

 
Bu konumdayken ‘‘Mouse’’un sol tuşunu bir kez tıkladığımızda görüntü aşağıdaki 

şekli alır.  
 

 
Resim 7: Crossing yöntemi ile çoklu seçim-3 

 
Yukarıdaki şekle dikkat ederseniz silmek istemediğimiz her iki yandaki yıldızların 

uçları da seçilmiştir. Klavyedeki Enter tuşuna bastığımızda ise aşağıda görüleceği gibi 
ortadaki yıldızla beraber diğer iki yıldızında uçlarının silindiği görülür. Bu ise istemediğimiz 
bir durumdur. 
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Resim 8 : Crossing yöntemi ile çoklu seçim-4 

 
Önemli Not!: Kısaca özetleyecek olursak dikdörtgeni soldan sağa doğru yaptığımızda 

çerçevenin içine tam olarak giren öğeler seçilir, ama dikdörtgeni sağdan sola doğru yaparsak 
bu defa çerçeveye tam olarak girenlerin yanında çerçevenin temas ettiği bütün çizim 
öğelerini seçmiş oluruz. 

 
1.2.3. Hızlı Seçim 
 

Baş tarafta anlattığımız kısa yol tuşlarını da kısaca açıklayacak olursak; 
 

Single  (SL)  : 
Çizim öğelerinin Pickbox kutusuyla tek tek seçilmesini sağlar. 

 

 
 

Resim 9: Single yöntemi ile seçim 
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 Window.( W) : 
 

Çapraz iki köşesi tanımlanarak oluşturulan çerçevenin içine tamamen giren çizim 
öğelerini seçer. Window penceresi sürekli çizgi olarak görüntülenir. Window yöntemi 
komut satırına yazılmadan da doğrudan doğruya kullanılabilir. Bunun için seçilmesi istenilen 
öğeleri içine alacak şekilde önce Window penceresinin sol, daha sonra sağ çapraz köşesi 
tanımlanmalıdır. 
 

 
Resim 10 : Window yöntemi ile seçim 

 
 Wpolygon  (WP)  : 

 
En az üç köşesi olan düzensiz bir şekle sahip çerçevenin içine tamamı giren çizim 

öğelerini seçer. 
 

 
Resim 11: Wpolygon yöntemi ile seçim 
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 Crossing  (C)  : 

 
Çapraz iki köşesi tanımlanarak oluşturulan çerçevenin içine tamamı veya bir kısmı 

giren çizim öğelerini seçer. Crossing çerçevesi kesik çizgili olarak görüntülenir. Crossing 
yöntemi seçilmeden (komut satırına yazılmadan) de doğrudan kullanılabilir. Bunun için 
çizim öğesi olmayan bir yerde önce Crossing çerçevesinin sağ köşesi ve daha sonra sol 
çapraz köşesi tanımlanmalıdır. 
 

 
Resim 12 : Crossing  yöntemi ile farklı yönlerden seçim 

 
 Cpolygon  (CP)  : 

En az üç köşesi olan düzensiz bir şekle sahip çerçevenin içine tamamı veya bir kısmı 
giren çizim öğelerini seçer. 

 

 
Resim 13 : Cpolygon yöntemi ile seçim 
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 Fence (F)  : 

 
Çizilecek düz çizgilere temas eden çizim öğelerini seçer. 

 
Resim 14: Fence yöntemi ile seçim 

 
 Group (G)  

Gruplandırılan çizim öğelerinin seçimini sağlar. Çizim öğelerinin devamlı kullanımlar 
için gruplandırılması Object Group işlemiyle gerçekleştirilir. 
 

 Previous (P) 
Bir önceki komutta kullanılan çizim öğelerinin tekrar seçimini sağlar. 

 Last  (L) 
En son çizilen çizim öğesini seçer. 

 All (ALL) 
Çizim alanında yer alan bütün çizim öğelerini seçer. 

 Add (A)  
Seçilen çizim öğelerine başka yeni çizim öğelerinin eklenmesini sağlar. 

 Remove (R) 
Seçilen çizim öğelerinin içinden istenmeyenlerin çıkarılmasını sağlar. 

 Undo (U)  
Seçilen öğeleri seçim sırasına göre sondan başa doğru iptal eder. 
 

1.3. Nesneleri Gruplama 
 
GROUP komutu nesnelerin seçim esnasında birlikte davranmaları için grup 

oluşturmaya yarar. Örnek olarak bir kat planı çizdiğimizi kabul edelim. Bu kat planında 
bulunan bütün oda kapılarını gruplayabiliriz. Herhangi bir işlem için (örneğin renk 
değiştirme vb.) oda kapılarından herhangi birini seçtiğimiz zaman bütün oda kapıları 
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seçilmiş olur. Dolayısıyla işlemler esnasında bizim için büyük kolaylık sağlar. İstenilirse 
grup elemanlarının birlikte davranıp davranmamasını da ayarlayabiliriz. Yani aynı gruba ait 
olmasına rağmen kapılardan herhangi birinin rengini değiştirebilmemiz mümkün olmaktadır. 

 
GROUP komutuna, ekranın en altında bulunan komut satırına GROUP yazarak veya 

screen menü adı verilen Kayar Menüden Tools komutu altında Group seçeneği işaretlenerek 
ulaşılabilir. 

 
Komut çalıştırıldığında şekildeki “Object Grouping” başlıklı diyalog kutusu gelir. 

Diyalog kutusunda üç ana bölüm bulunur. Bunlar; “Group İdentification” “Create Group” ve 
“Chance Group” dur. Ayrıca bunların içinde onay kutuları ve düğmeleri de vardır. Diyalog 
kutusunun en üstünde ise beyaz zeminli bir liste bulunur. Bu listede çizim dosyamızda 
bulunan grup isimleri ve seçilebilme durumları görülür. 
 

 
Resim 15 : Object grouping diyalog kutusu 

 
 Group Name 

Listeden seçilen bir grubun ismi bu dizgi girdi hanesine aktarılır veya yeni bir grup 
oluşturulmaya başlandığında oluşturulacak grubun adı bu haneye girilir. 

 
 Decsription 

Listeden seçilen grubun varsa kısa bir tanım metni bu hanede görülür. Ayrıca yeni bir 
grup oluşturulurken grup ile ilgili bir açıklama metni istenirse bu haneye girilir. 

 
 Find Name 

Bu düğme herhangi bir nesnenin hangi gruba ait olduğunu öğrenmek için kullanılır. 
Düğme işaretlendiğinde diyalog kutusu geçici bir süre için kapanır ve komut satırında; 

“Pick a member of a Group” yazısı okunur. Bununla kullanıcıdan bir nesne seçilmesi 
istenir. Nesne seçildiğinde şekildeki gibi küçük bir pencere açılır ve nesnenin ait olduğu 
gruplar listelenir.  
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Resim 16 : Group member list ve object grouping pencereleri. 

 
 Higligth 

Bu düğme ismi belirtilen grup elemanları öğrenilir. Önce listeden bir grup seçilir, daha 
sonra “Higligth” düğmesi işaretlendiğinde diyalog kutusu görüntüden kaldırılır ve o gruba ait 
nesneler aydınlatılır. (Farklı bir çizgi tipi ile gösterilir.)  

 
 Include Unnamed 

Bu onay kutusu işaretlendiğinde dosyamızda tanımladığımız isimsiz gruplarda listede 
görülür. Yani bu onay kutusu isimsiz grupların listede yer alıp almamasını ayarlar. 

 
 New 

İşaretlendiğinde diyalog kutusu kaybolur ve bizden oluşturduğumuz grubun elemanı 
olacak nesnelerin seçilmesi istenir. Yaptığımız işlemin geçerli olabilmesi için “Group Name” 
satırı doldurulmuş olmalıdır. İsim vermeden grup oluşturmak istiyorsak “Unnamed” onay 
kutusu işaretlenmelidir. 

 
 Selectable 

Bu onay kutusu işaretlenmezse oluşan grubun elemanları tek tek hareket eder. Yani 
grup elemanları seçildiğinde bütün elemanlar seçilmez. Ancak genellikle grubun ortak 
davranıp davranmaması “Chance Group” bölgesindeki “Selectable” düğmesi ile ayarlanır. 

 
 Remove 

Bir gruba ait olan elemanlardan herhangi birini ait olduğu gruptan çıkarmak istersek 
bu komut kullanılır. Önce listeden bir grup seçilir, daha sonra “Remove” düğmesi işaretlenir. 
Diyalog kutusu geçici bir süre gösterilmez ve seçili grubun elemanları aydınlatılır. Kullanıcı 
elemanlardan istediğini seçerek gruptan ayırmış olur. 

 
 Add 

Remove seçeneğinin tersidir. Yani gruba yeni elemanlar ilave etmek için kullanılır. 
Kullanımı “Remove” seçeneğinin aynıdır. 

 
 Rename 

Bir grubun ismini değiştirmek için kullanılır. Listeden ismini değiştirmek istediğimiz 
grup seçilir. Seçilen grubun ismi “Group Name” hanesinde belirir. Bu hanedeki isim 
değiştirilip “Rename” düğmesi işaretlendiğinde grup yeni ismini alır. 
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 Re-Order 
Grubu oluşturan elemanların sıra numaralarını değiştirmek için kullanılır. Seçildiğinde 

aşağıdaki diyalog kutusu ekrana gelir. 
 

    
Resim 17 : Order group diyalog kutusu ve object grouping diyalog kutusu 

 
Listeden bir grup ismi işaretlenerek seçilir. Daha sonra o grupla ilgili sıralama ve diğer 

işlemler yapılabilir. “Highlight” düğmesi işaretlendiğinde aşağıdaki diyalog kutusu ekrana 
gelir. Next düğmesi grubun bir sonraki elemanının, “Previous” düğmesi ise grubun bir 
önceki elemanının aydınlatılarak kullanıcıya gösterilmesini sağlar. 
 
1.4. Ekranı Temizleme 
 
1.4.1. Redraw / Redrawall (Görüntü Temizleme) 
 

Bu komutlar çizim ekranını tazeler ve çizimde oluşan (+) işaretlerini (Blips modunun 
ON durumunda olması halinde) kaldırır. 

 
 Redraw: Yalnız aktif görüntü penceresini (vport) temizler 
 Redrawall: Bütün görüntü pencerelerini (vports) temizler. 

 
Blips modunun açık olması durumunda ekranda oluşan nokta şeklindeki  “+”  işaretleri 

görülmek istenmezse alttaki komut satırına Redraw (veya sadece R ) yazılarak Enter tuşuna 
basılırsa aktif durumda olan penceredeki (Şekle göre sol alttaki penceredir.) “+” işaretleri 
temizlenir. 
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Resim 18: Redraw komutunun uygulanmasından sonra pencerenin temizlenmiş hali 

 
Fakat alttaki komut satırına Redrawall (veya sadece RA ) komutları yazılarak Enter 

tuşuna basılırsa bütün penceredeki “+” işaretleri temizlenmiş olur. 
 

 
Resim 19 : Redrawall  komutunun uygulanmasından sonra tüm pencerelerin temizlenmiş hali 
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Adres 
• Ekran Menüsü:VIEW 1 > Redraw (Redrawall) 
• Kayar Menü:View > Redraw 
• Komut Satırı:REDRAW / R – (REDRAWALL / (RA) 

 
1.4.2. Regen / Regenall (Yeniden Oluşturma) 

 
Regen ve Regenall komutları çizim öğelerinin özelliklerini ve koordinat bilgilerini 

kayıtlı oldukları veri tabanından hesaplayarak çizimi yeniden oluşturur. Bu işlemin 
sonucunda AutoCAD çizim öğelerini en son yapılan görüntü ayarı işlemlerine göre (Fill On 
/ Off, Qtext On / Off  vb.) yeniden oluşturur. 

 
Bu komutlar, 3D modellerde Hide, Shade, Render  vb. komutların sonuçlarını 

kaldırarak görüntüyü temizler. Ayrıca çember ve yayların görüntü üzerindeki eğriselliğini 
düzenler.  

 
Unutulmaması gereken bir husus Redraw-All ve Regen-All komutları ekrandaki 

görüntülerle alakalı komutlardır. Çizimin kalitesi ile ilgili değildir. Bunlar kullanılsa da 
kullanılmasa da çıktı kalitesini etkilemezler. Yani dairesel bir çizim ekranda kırık çizgilerden 
oluşsa da bu komutlar kullanılmadığı halde kâğıda alınan çıktı normal çıkacaktır. 

 
 Regen: Yalnız aktif görüntü penceresine (vport) uygulanır. 
 Regenall : Bütün görüntü pencerelerine (vports) uygulanır. 

 

 
Resim 20 : Regen komutunun uygulanmasından önce dairesel şekillerin kırık çizgilerle 

görüntülenmesi 
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Yukarıdaki şekil herhangi bir çizimde Regen komutunu kullanılmadan önceki hâlidir. 
Özellikle dairesel şekilli öğelerin köşeli hallerine dikkat ediniz! Aşağıdaki diğer şekilde ise 
Regen komutu kullanıldıktan sonra aynı çizimin aldığı hâli gözükmektedir. 
 

 
Resim 21 : Regen komutunun uygulanmasından sonra dairesel şekillerin görüntülenmesi 

 
 Adres 

• Ekran Menüsü:VIEW 1 > Regen (Regenall) 
• Kayar Menü:View > Regen (Regenall) 
• Komut Satırı:REGEN / RE – (REGENALL / (REA) 

1.5. Geometrik Düzenleme Araçları 
 
AutoCAD ’de temel çizim komutlarının dışında ekrandaki grafik elemanların bazı 

işlemlere tabii tutulup (kopyalama, silme, taşıma, sündürülme vb.) düzenlenmesi için 
kullanılacak komutlar birkaç ayrı yerde bulunurlar. En kolay ulaşılabileni toolbars denilen 
araç çubuklarında, ana ekran menüsünde modıfy1 ve modıfy2 satırlarında ve çek-menü 
denilen çizim ekranının en üstündeki satırda modıfy başlıklarının altında bulunur. 
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Resim 22 : Geometrik düzenleme araçlarına ulaşma yolları 

 
AutoCAD ’de çizimlerin A’dan Z’ye tamamlanarak bitirilmesi yerine basit bir şekil 

üzerinde yapılacak düzenlemelerle oluşturulması amaçlanır. Çizme, düzenle (Don’t draw, 
edit) olarak adlandırılan bu yöntemle taslak olarak oluşturulan bu şekillerin boyut, konum ve 
biçimlerinde yapılacak düzenlemelerle tasarım tamamlanır. 
 

 
Resim 23: Geometrik düzenleme araçları (modıfy) araç çubuğu (toolbar) 
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1.5.1. Erase (Silme) 

 
Erase (Sil) komutu resim üzerindeki istenmeyen çizim öğelerini siler. Yani bu 

komutla seçtiğimiz nesnelerin silinmesine olanak tanır. Dikkat edilmesi gereken şeylerden 
birisi; bu komutla seçilen öğelerin tamamı silinir. Eğer çizim öğelerinin bir kısmını silmek 
istiyorsak Trim ve Break komutları (bu komutlar ilerde anlatılacaktır) kullanılır. 

 
 Adres 

• Ekran Menüsü:MODIFY 1 > ERASE 
• Kayar Menü:Modify > Erase 
• Komut Satırı:ERASE (E) 

Erase (Sil) komutunu yukarıdaki adreslerden herhangi birisi ile kullanıldığında alttaki 
komut satırında “select objects:” (silinecek çizim öğelerini seçiniz) uyarısı görülür ve 
ekrandaki ‘‘Mause’’un görüntüsü "Pickbox" seçim kutusu halini alır. Bununla nesneleri 
seçme konusunda anlatılan seçim seçeneklerinden herhangi birisi ile silinecek öğeler 
belirlenir. Daha sonra klavyedeki Enter tuşu veya ‘‘Mause’’un sağ tuşu ile tıklandığında 
seçilen öğeler silinmiş olur. 

 
Aşağıda Erase (Sil) komutu ile ilgili bir örnek görülmektedir; 

 

 
Resim 24 : Erase komutunun uygulanması-1 

 
Ekrandaki görüntü bu şekildeyken, klavyedeki Enter tuşu veya ‘‘Mause’’un sağ tuşu 

ile tıklandığında aşağıdaki gibi seçilen öğeler silinmiş olur. 



 

 21

 
Resim 25 : Erase komutunun uygulanması-2 

 
Komutu sonlandırdıktan sonra seçtiğimiz öğeler çizimimizden silinecektir. Çizimin 

herhangi bir safhasında en son Erase (Sil) komutu ile silmiş olduğumuz öğeleri geri 
getirmek için “OOPS” komutu kullanılır. Komut satırına Oops yazılıp Enter tuşlanırsa en 
son silinen öğe geri gelir. 

 
Bu “OOPS” komutunun, UNDO (Geri Al) komutu ile alakası yoktur ve 

karıştırmamak gerekir. U [UNDO (Geri Al)] komutu en son yapılan işlemi geri alır. Bu işlem 
herhangi bir komutla yaptığımız işlem MOVE, MİRROR, ARRAY, ROTATE vb. işlemler 
olabilir “OOPS” komutu ile arada farklı işlemler yapmış olsak dahi sildiğimiz en son nesne 
geri getirilir. 

 
1.5.2. Copy (Kopyalama) 

 
Copy komutu seçilen çizim öğelerinin bir veya birden fazla kopyasını çizim ekranında 

belirlenen herhangi bir noktada oluşturur. Aynı zamanda nesneler grubunu da 
kopyalayabiliriz. Seçilen çizim öğelerinin kopyalarını orijinallerinde değişiklik yapmadan 
belirtilen noktadan yakalar, diğer bir noktaya yerleştirir. 

 
 Adres 

• Ekran Menüsü:MODIFY 1 > COPY 
• Kayar Menü:Modify > Copy 
• Komut Satırı: COPY (CP) 

 
Copy (KOPYALA) komutunu yukarıdaki adreslerden herhangi birisi ile 

kullanıldığında alttaki komut satırında “select objects:” (Kopyalanacak çizim öğelerini 
seçiniz) uyarısı görülür ve ekrandaki ‘‘Mause’’un görüntüsü "Pickbox" seçim kutusu halini 
alır. Bununla nesneleri seçme konusunda anlatılan seçim seçeneklerinden herhangi birisi ile 
kopyalanacak öğeler belirlenir.  

 
Seçimimizin bittiğini belirtmek için Enter tuşuna bastıktan sonra AutoCAD, 

kopyalamak istediğimiz nesneleri hangi noktasından yakalayarak nereye kopyalamak 
istediğimizi soran aşağıdaki uyarıyı komut satırında gösterir. 
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“Specify base point or displacement, or [Multiple]:” ( Çoğaltma-kopyalama 
işleminde referans alınacak tutuş noktasını (base point) seçiniz). 

 
Tutuş noktası belirlendikten sonra AutoCAD bu noktanın yerleşeceği diğer noktayı 

isteyen aşağıdaki diğer mesaj komut satırında görüntülenir. 
 
“Specify second point of displacement or < use first point as displacement >:” 
 

 
Resim 26 : Copy komutunun uygulanması-1 

 
“Specify base point or displacement, or [Multiple]:” komutunda geçen [Multiple] 

seçeneği ise aynı nesneden birden fazla kopya yapmak istersek kullanacağımız bir komuttur. 
Kopyalamak istediğimiz nesne seçildikten sonra aşağıdaki uyarı gelince, komut satırına 
“Multiple” veya sadece “m” yazıp Enter tuşuna bastığımızda artık kopyalayacağımız 
nesneden istediğimiz kadar kopyasını alabiliriz. 
 

 
Resim 27 : Multiple (çoklu) copy komutunun uygulanması–1 
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1.5.3. Move (Taşıma) 

 
MOVE komutu seçilen çizim öğelerini bulundukları koordinattan başka bir koordinata 

taşır. Nesnelerin doğrultularının değiştirilmeksizin bulundukları yerden başka bir yere 
taşınmaları için kullanılır. 

 
 Adres 

• Ekran Menüsü:MODIFY 2 > Move 
• Kayar Menü:Modify > Move 
• Komut Satırı: MODIFY / (M) 

 
Çoğu düzenleme komutunda olduğu gibi burada da komut çalıştırıldığında AutoCAD 

ekranının en altındaki komut satırında gelen “Select objects:” uyarısı komutun uygulanacağı 
nesnenin seçilmesini ister. Kullanıcı klavyedeki Enter tuşu veya Mause’un sağ tuşu ile 
tıklayarak seçim işlemini bitirinceye kadar bu uyarı aktif olarak kalacaktır. Seçim bitince  
“Specify base point or displacement:” uyarısıyla taşımada referans olacak tutuş noktasının 
belirlenmesini ister. Bu uyarıdan sonra isterseniz taşımak istediğiniz nesnenin üzerindeki 
herhangi bir noktadan, isterseniz de nesnenin dışındaki herhangi bir noktayı referans noktası 
olarak alabilirsiniz. Tutuş noktasını belirledikten sonra “Second point of displacement:” 
uyarısı ile referans noktasının konumlandırılacağı diğer nokta girilmesini ister. Bu noktayı 
nereye taşıyacağınızı belirledikten sonra taşıma işlemi tamamlanmış olur. 

 
Aşağıdaki bayrak şeklindeki yıldızı hilalin içine yerleştirmek istesek; bunun için 

MOVE komutunu seçtikten sonra, yıldızı seçili hale getirip Enter tuşuna basarız. Yıldız 
seçildiği belli olması için kesik çizgilerle ifade edilir. “Specify base point or displacement:” 
uyarısıyla yıldızın sol köşe noktasına tıklanır. Sonra Mause ile sürüklenerek hilalin içinde 
istediğimiz herhangi bir nokta belirlenerek bırakılır. 

 

         
 

Resim 28 : Move komutunun uygulanması 
 
COPY komutundan farklı olarak bu komutta nesne-öğe bulunduğu yerden yeni yerine 

taşınmasıdır. COPY komutunda bilindiği üzere nesnenin kendisi konum olara yerinde 
dururken aynı özelliklerde bir kopyası istenilen yere taşınmaktadır. 

 
COPY komutunda birçok diğer komutlarda olduğu gibi taşımak istediğiniz mesafeyi 

klavyeden komut satırına girerek (Örn: 50, 100, vb.) istediğiniz mesafeye de taşıma işlemini 
yapabilirsiniz. 
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1.5.4. Mırror (Simetrisini Alma - Aynalama)  
 
MIRROR komutu seçilen çizim öğelerini tanımlanacak bir simetri eksenine göre 

simetrisini oluşturur. 
 

 Adres 
• Ekran Menüsü:MODIFY 1 > Mirror 
• Kayar Menü:Modify > Mirror 
• Komut Satırı:MIRROR / (MI-mi) 

 
Bu komut özellikle simetrik şekillerin elde edilmesinde oldukça kullanışlıdır. Sadece 

şeklin yarısı çizilip diğer yarısı MIRROR komutu ile çabucak tamamlanabilir. 
 
Kullanımı şu şekildedir; diğer komutlarda olduğu gibi “Select objects:” uyarısı ile 

komutun uygulanacağı nesnenin seçilmesi istenir. ‘‘Enter’’ la seçim işlemi bitirilince 
“Specify first point of mirror line:” (simetri ekseninin ilk noktasını belirleyin) ve arkasından 
“Specify second point of mirror line:” (Simetri ekseninin ikinci noktasını belirleyin.) 
uyarıları gelir. Belirleyeceğiniz iki noktaya göre seçtiğiniz nesnenin bütün özellikleriyle 
simetrisi alınmış olur. 
 

 
Resim 29 : Mırror komutunun uygulanması–1 

 
MIRROR yapmak istediğimiz nesneyi şeçili hale getirdiğimizde nesne program 

tarafından kesik çizgilerle ifade edilir. 
 

 
Resim 30 : Mırror komutunun uygulanması–2 
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Daha sonra bizden simetri yapmak istediğimiz ekseni girmemiz istenir. Yatay veya 

düşey eksen oluşturmak için Ortho komutu kullanılabilir. (NOT: Bu eksenin mutlaka yatay 
veya düşey olması zorunlu değildir. İstediğimiz herhangi bir doğrultuda simetri alabiliriz.) 
 

 
 

Resim 31 : Mırror komutunun uygulanması–3 
 

Komutun en son iletisi “Delete source objects? [Yes/No] <N>:” (simetrisini aldığınız 
nesnenin ilk halini silmek ister misiniz?) dir. Seçenek değiştirilmediği sürece “N” (no-hayır) 
olarak gelecektir. Bu uyarıyla birlikte ‘‘ENTER’’ la komuttan çıkarsanız simetrisini aldığınız 
nesne ve simetrisi birlikte ekranda kalır. 

 
“Delete source objects? [Yes/No] <N>:” uyarısına “Y” (yes-evet) diyecek olursanız 

simetrisini aldığınız nesnenin ilk konumdaki hali silinir, ekranda sadece simetrisi kalır. 
 
MIRROR komutunun hassas noktalarından biri yazılı öğelerdir. Eğer komutu 

uygulayacağımız nesneler içerisinde TEXT (yazı) varsa program default değer (kurulumda 
kabul edilen temel değer) olarak mirtext değerini < 1 > olarak kabul eder. Bu şekilde de 
MIRROR yapacak olursak yazılı metinleri de ayna üzerinde olduğu gibi ters gösterir. Böyle 
olmasını istemiyorsak screen menu denilen ekran menüsünden bu değeri < 0 > olarak 
değiştirmemiz gerekir. Bu komuta ulaşabilmemizin başka yolu da komut satırına doğrudan 
MIRRTEXT yazıp ENTER’ ladığımızda şeklimiz aynen aynalanırken (simetrisi alınırken) 
yazılı metinlerin bozulmadan aynen kaldığını görürüz. 
 

 
Resim 32: Mırror komutunda mırrtext seçeneğinin uygulanması 
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1.5.5. Rotate (Döndürme) 

 
ROTATE (Döndür) komutu seçilen çizim öğelerini bir referans noktasına göre 

istenilen açıda döndürür. 
 

 Adres 
• Ekran Menüsü:MODIFY 2 > ROTATE 
• Kayar Menü:Modify > Rotate 
• Komut Satırı:ROTATE (RO) 

 
ROTATE (Döndür) komutunun kullanımı sırasında “Base point” (tutuş noktası) 

iletisine yanıt olarak belirtmiş olduğumuz nokta etrafında nesne ya da nesneler 
döndürülecektir. 
 

 
Resim 33 : Rotate komutunun uygulanması 

 
Yukarıdaki örnekte ROTATE komutu girildikten sonra kırmızı renkli şekil “Select 

objects:” 
Uyarısıyla A noktasından B noktasına doğru seçiliyor. “Specify base point:” iletisi ile 

C noktası döndürme merkezi olarak tespit ediliyor. 
Daha sonra “Specify rotation angle or [Reference]:” uyarısı ile bizden döndürme açısı 

istendiğinde 45° klavyeden giriliyor. ENTER yapıldığında işlemimiz tamamlanmış oluyor. 
 
Bu komutla nesneler klavyeden belirleyeceğimiz açı kadar döndürülebildiği gibi, 

“Reference” ek komutuyla referans olarak kullanacağımız herhangi bir doğrultu 
istikametinde de döndürülebilir. “Specify rotation angle or [Reference]:” iletisinden sonra 
klavyaden “R” girildiğinde Specify the reference angle <0>: (Referans alacağınız ilk açıyı 
belirleyiniz!) uyarısı gelir. Kabul edilen değer olarak her zaman “ 0° ” olarak gelir. İstenirse 
klavye ile bir açı değeri girilebildiği gibi MAUSE ile ekranda döndürmek istediğimiz 
doğrultunun herhangi bir noktasını tıklayabiliriz. Noktayı (veya açıyı) belirledikten sonra 
“Specify second point:” iletisi ile program bizden referans aldığımız doğrultunun ikinci 
noktasını belirlememizi ister. İkinci noktayı girdiğimiz anda “Specify the new angle:” 
uyarısı ile son açıyı veya doğrultuyu girmemizi ister. Bu da girildiğinde program ROTATE 
(döndürme) işlemi tamamlanmış olur.  



 

 27

 
1.5.6. Trım (Budama - Kırpma) 

 
TRIM (Budama) komutu birbirleriyle kesişen çizim öğelerinin kesişim noktalarından 

itibaren istenmeyen kısımlarını siler. 
 

 Adres 
• Ekran Menüsü:MODIFY 2 > TRIM 
• Kayar Menü:Modify > Trim 
• Komut Satırı:TRIM  

 
Budama işleminin gerçekleşebilmesi için atılacak kısımların mutlaka bir çizgiyle 

sınırlandırılmış olması gereklidir. Tamamı silinecek olan çizgiler ise ancak ERASE 
komutuyla silinebilir. Budama işlemi ‘‘Mouse’’un sağ tuşuna veya ENTER tuşuna basılarak 
sonlandırılır. 

 
TRIM (Budama) komutu iki aşamalı bir komuttur. İlk önce kesici kenar olarak 

görevlendirilecek nesneler seçilir. Daha sonra kesici kenar olarak görevlendirilen nesnelerin 
üzerinden (veya uzantılarının üzerinden) geçen nesneler, budanacakları taraftan seçilirler. 

 
Aşağıdaki örneği inceleyecek olursak; TRIM komutundan sonra Select objects to 

trim: uyarısıyla şeklin tümünü A noktasından B noktasına doğru seçelim. (Farklı seçim 
yöntemlerinin olduğunu daha önceki konularda anlatılmıştı.) ENTER tuşuyla seçimi 
bitirelim. 

 
Resim 34 : Trım komutunda nesne seçimi. 

 
Seçtiğimiz şekil tamamen kesik çizgilerle gösterilmektedir. Daha sonra,.Pickbox 

seçim kutusu halini alan Mouse ile 1, 2, 3,…,8 ile gösterilen çizgileri tıklayalım. 
 

 
Resim 35 : Trım komutunda seçilen nesnelerin görünümü 
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1, 2, 3,…,8 ile gösterilen çizgileri tıkladıktan sonra şekil aşağıdaki hali almıştır. 

 

 
Resim 36: Trım komutunun uygulanması. 

 
TRIM (Budama) komutunu bitirdiğimizi ENTER tuşu ile veya Mouse’un sağ tuşu ile 

tıklayarak belirledikten sonra şeklimiz aşağıdaki hâli alır. 
 

 
Resim 37 : Trım komutunun uygulanmış hali. 

 
TRIM (Budama) komutunda değişik alt komutlarda vardır. Bunlar, seçme işlemi 

tamamlanıp ENTER tuşlandıktan sonra komut satırında program tarafından şu şekilde ifade 
edilir: 

 
Select object to trim or shift-select to extend or [Project/Edge/Undo]:  
 
[Project]  modu; farklı düzlemlerde konumlanan çizim öğelerinin budama işlemlerini 

kontrol eder. 
 
[Edge]  modu; uzantıları kesişen çizim öğelerinin izafi olarak kesiştikleri noktaya göre 

budama işlemini kontrol eder.  [Extend/No extend] olarak iki seçenek sunulur.  
 
<Extend > : Uzantıları kesişen çizim öğelerini izafi olarak kesiştikleri noktaya 

göre budar. 
< No Extend> :Uzantıları birbirini kesmiş de olsa budama işlemi yapılmaz. 
 

1.5.7. Offset (Paralel Oluşturma - Öteleme) 
 
OFFSET (Paralel Oluşturma- Öteleme) komutu seçilen çizim öğelerini ve birleşik 

çizgileri belirlenebilen bir uzaklıkta ve yönde öteler. 
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 Adres 

• Ekran Menüsü:MODIFY 1 > OFFSET 
• Kayar Menü:Modify > Offset 
• Komut Satırı: OFFSET (O) 

 
OFFSET komutu sadece bir nesne üzerinde etkili olabileceği için nesne seçilirken 

pencere içine alarak seçim işlemi kullanılamaz. Komutun uygulanacağı nesne sadece 
Pickbox seçim kutusu ile sadece işaretlenerek seçilebilir. 

 
Komut yukarıdaki yollardan herhangi biri ile kullanılırken öncelikle komut satırında 

“Specify offset distance or [Through] <Through>:” uyarısı ile kullanıcıdan ya bir öteleme 
mesafesi olacak rakamsal bir değer, ya da mouse ile ekranda tıklayarak girebileceğimiz bir 
uzunluk ölçüsü istemektedir.  

 
Mesafeyi Mouse ile veya klavyeden girdikten sonra program “Select object to offset 

or <exit>:” (OFFSET yapmak istediğiniz objeyi-çizim öğesini belirleyiniz.) uyarısını verir. 
Komutun uygulanacağı nesne Pickbox seçim kutusu ile işaretlenerek gösterildiğinde ekrana; 
“Specify point on side to offset:”( OFFSET yapmak istediğiniz tarafı-yüzeyi gösteriniz.) 
denilir. Mouse ile bu yüzey belirlediğimizde seçtiğimiz nesne istenilen yüzey istikametinde 
OFFSET yapılmış olacaktır.  
 

 
Resim 38 : Değişik nesnelere offset komutunun uygulanması 

 
Yukarıdaki şekilde farklı çizgi çeşitlerinin OFFSET komutuna vermiş olduğu farklı 

durumları anlatılmak istenmiştir. Siyah çizgiler çizgilerin ilk hali, kırmızılar; nesnelerin iç 
tarafı OFFSET yönü olarak belirlenmiş halleri, maviler ise, nesnelerin dış tarafı OFFSET 
yönü olarak belirlenmiş halleridir. 
 

Öteleme uzunluğunu mause ile ekranda tıklayarak girsek dahi bunun rakamsal 
değerini AutoCAD programı kendisi tespit edip aynı çizim dosyasındaki bir diğer OFFSET 
komutunun kullanılması esnasında “xxx mesafesinde mi öteleme yapmak istiyorsunuz?” diye 
belirtecektir. 

 
ENTER tuşu, ‘‘MOUSE’’un sağ tuşu veya ESC tuşu ile komuttan çıkılmadığı sürece 

program girmiş olduğumuz mesafe sabit kalarak istediğimiz nesnelerin paralelini almaya 
devam edebilir. Böylelikle komuta bir kez girerek bütün OFFSET işlerini bir defada 
tamamlayabiliriz. 
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Resim 39 : Offset komutunda mouse ile mesafe verme işlemi  

 
1.5.8. Extend (Uzatma) 

 
EXTEND (Uzatma) komutu uzantıları birbirini kesen fakat kesişmemiş olan çizgileri 

kesişecek şekilde uzatır. Bir başka deyişle uygun nesnelerin başka bir nesneye değene kadar 
uzatılmasını sağlar. 

 
 Adres 

• Ekran Menüsü:MODIFY 2 > EXTEND 
• Kayar Menü:Modify > Extend 
• Komut Satırı:EXTEND (EX) 

 
AutoCAD çizim öğelerini bunların geometrik özelliklerini bozmadan uzatır. Örnek 

olarak Extend komutuyla bir yay uzatılmak istenirse, yine yay olarak uzayacaktır.  
 
Bu komut da iki aşamalıdır. Yani ilk önce sınır kenarlar seçilir, daha sonra bu sınır 

kenarlara kadar uzatılacak nesneler seçilir. 
 

 
Resim 40 : Extend komutunun uygulanması–1 

 
Yayların her iki tarafından da yukarıdaki örnekteki gibi uzatmak istersek “Select 

object to extend” iletisiyle birlikte her iki ucu ayrı ayrı seçmemiz gerekir. 
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Resim 41 : Extend komutunun uygulanması–2 

 
Uzatma yapmak istediğimiz nesne ve yüzey arasındaki diğer çizim öğeleri EXTEND 

komutunun işleyişine engel değildir. AutoCAD tarafından diğer öğeleri yokmuş gibi kabul 
edilerek komut uygulanır. 

 
1.4.11. Fıllet (Yuvarlak Köşe Oluşturma) 
 

FILLET (Yuvarlak Köşe Oluşturma) komutu kesişen veya uzantıları birbirini kesen iki 
doğrunun kesişen uçlarını yuvarlatır. 

 Adres 
• Ekran Menüsü: MODIFY 2 > FILLET 
• Kayar Menü: Modify > Fıllet 
• Komut Satırı: FILLET (F) 

 
FILLET komutu seçildikten sonra komut satırında  
Select first object or [Polyline/Radius/Trim]: iletisi gelir. Burada doğrudan doğruya 

default (önceden kabul edilen) değerler ile işleme devam edebilir, FILLET yapmak 
istediğiniz çizgileri seçmeye başlayabilirsiniz. Bunun yanında [Polyline/Radius/Trim]: 
seçeneklerini de kullanabilirsiniz.  

 
[Polyline]: Polyline birleşik çizgi demektir. Bu çizgi ile çizilmiş şekillerin FILLET 

yapılmasında kullanılır. Ekranda; Select first object or [Polyline/Radius/Trim]: iletisi 
görülünce komut satırına“P” yazılıp ENTER’lenirse bu seçenek aktif olur. Ekrandaki komut 
satırında “Select 2D polyline:” (2D polyline’ı seçiniz) uyarısı alınır. Polyline ile çizilen 
şeklin varsa bütün köşelerini bir defada aynı özelliklere sahip bir şekilde yuvarlatır. 
 

 
Resim 42 : Polyline öğeye fıllet komutunun uygulanması 
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[Radius] :Radius çember ve yay gibi nesnelerin “yarıçapı” anlamındadır. Select first 
object or [Polyline/Radius/Trim]: iletisi görülünce komut satırına “R” yazılıp 
‘‘ENTER’’lenirse ekranda “Specify fillet radius <10.0000>:” uyarısı gelir. Yapmak 
istediğimiz FILLET komutunun yarıçap değerini istediğimiz rakamsal değeri klavyeden 
veya Mouse ile ekranda belirleyeceğimiz uzunluk kadar girebiliriz. 

 
Eğer radius değeri olarak “0” (sıfır) değeri girilirse uzantıları birbirini kesen fakat 

kesişmemiş çizgileri kesişme noktasına kadar uzatır. Kesiştikten sonra uzantıları devam eden 
çizgilerin ise kesiştikten sonra devam eden uzantılarını budar. 
 

 
Resim 43: Fıllet komutunun değişik durumlardaki sonucu. 

 
[Trim ] :Yuvarlatılacak olan köşeyi oluşturan çizgilerin yuvarlatıldıktan sonraki 

durumlarını kontrol eder. Bunun için programın komut satırında Select first object or 
[Polyline/Radius/Trim]: iletisi görülünce komut satırına“T” yazılıp ‘‘ENTER’’lenirse 
ekranda 

 
Enter Trim mode option [Trim/No trim] <Trim>: seçeneği görülür. 
 
<Trim> seçilirse uzantıları birbirini kesen fakat kesişmeyen çizgileri yuvarlatma 

noktasına kadar uzatır. Kesiştikten sonra uzantıları devam eden çizgilerin yuvarlatma 
noktasından sonraki kısımlarını budar. 

 
<No Trim> seçilirse yuvarlatılacak köşeyi oluşturan çizgilerin yuvarlatılacak uçlarında 

hiçbir kırpma – budama işlemi yapmadan yuvarlatma işlemini gerçekleştirir. 
 

 
Resim 44 : Fıllet komutunun “no trim” ve “trim” uygulamaları. 

 
1.5.9. Chamfer (Pahlı Köşe Oluşturma) 

 
CHAMFER (Pahlı Köşe Oluşturma) komutu kesişen veya uzantıları birbirini kesen iki 

doğrunun kesişen uçlarına pah kırar. 
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 Adres 
• Ekran Menüsü :MODIFY 2 > CHAMFER 
• Kayar Menü :Modify > Chamfer 
• Komut Satırı : CHAMFER (CHA) 

 

 
Resim 45 : Chamfer komutunda mesafe ve açı kavramlarının gösterilmesi. 

 
(TRIM mode) Current chamfer Dist1 = 30.0000, Dist2 = 30.0000 mesajında komutun 

mesafe yöntemine göre çalıştığını gösterir. Bu yöntemde Dist1 ve Dist2 olarak iki uzunluk 
değeri kullanılır. “Select first line” ve “Select second line” uyarılarında seçmiş olduğunuz 
çizgilerin pah kırma işleminden sonraki uzunluk mesafeleridir. [Distance] seçeneğinden 
sonra aktif hale gelir. Birinci çizgi uzunluğunu verdikten sonra ikinciyi farklı bir uzunluk 
verebileceğimiz gibi, ‘‘ENTER’’ la çıktığımızda birinci çizgi uzunluğu ile ikinci çizgi 
uzunlukları eşit olarak ayarlanacaktır. 

 
Resim 46 : Chamfer komutunun uygulanması-1 

 

 
Resim 47 : Chamfer komutunun uygulanması-2 
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CHAMFER komutunda seçilen doğrusal öğelerin uçlarının üst üste olması şartı 

yoktur. Ancak nesnelerin seçilmek için ne taraflarına tıklandıkları önem arz etmektedir. 

 
Resim 48 : Chamfer komutunun uygulanması-3 

 
Yukarıdaki örnekte görüldüğü gibi komutu uygulayacağımız yöne göre ( ne tarafın 

kalmasını, ne tarafın silinmesini istiyorsak) birinci ve ikinci çizgileri seçmemiz gereklidir. 
Ayrıca komut çalıştırıldığında komut satırında iletiden önceki mesaj komutun hangi moda 
çalıştığını hangi yönteme göre pah kırılacağı ve yöntemin rakamsal değerleri gösterilir. 
CHAMFER komutu da FILLET komutundaki gibi “Trim” veya “No Trim” (pah işleminden 
sonra uzantıların kırpılıp kırpılmaması) modlarında da işlem yapabilir.  

Komut seçildikten hemen sonra TRIM mode veya NOTRIM mode diye uyarı 
verilmektedir. [N] tuşlarsak NOTRIM moduna geçer ve yukarıdaki örnekte görüldüğü gibi 
CHAMFER komutu uygulanan çizgilerin uçlarını kırpmadan bırakır. Diğer hallerde TRIM 
modu geçerlidir ve çizgilerin uçları kırpılır. 

 

    
Resim 49 : Chamfer komutunun pline öğeye uygulanması 

 
Polyline ile çizilmiş nesneler FILLET komutunda olduğu gibi CHAMFER komutunda 

da bir kerede pahlandırılabilir. Bunun için; komutu girdikten sonra  
Select first line or [Polyline/Distance/Angle/Trim/Method]: uyarısından sonra  “P”  

tuşlandığında Select 2D polyline: iletisi ile sonra Polyline ile çizilmiş nesneyi seçmemiz 
istenir ve anında komut nesneye uygulanır, nesnenin de özellikleri ve uygulanan komut [11 
lines were chamfered] şeklinde ifade edilir. 
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1.5.10. Scale (Ölçekli Büyütme – Küçültme) 

 
SCALE (Ölçekleme) komutu çizim öğelerini istenilen oranda büyütür veya küçültür. 
Bu komut genellikle seçilen nesnelerin boyutlarını değiştirmek için kullanılır. 
 

 Adres 
• Ekran Menüsü: MODIFY 2 > SCALE 
• Kayar Menü: Modıfy > Scale 
• Komut Satırı: SCALE (SC) 

 
Komutu yukarıdakilerden herhangi biri ile seçtiğimizde diğer komutlarda olduğu gibi 

komutu uygulayacağımız nesneyi seçmek için “Select objects:” (Nesneyi seçiniz) uyarısı 
gelir. Objeyi seçtiğimizde ise Specify base point (Referans alacağınız noktayı belirleyin) 
uyarısı iletilir. Bu noktayı da belirledikten sonra “Specify scale factor or 
[Reference]:”uyarısı gelir. Klavye ile bir rakamsal ölçek değeri veya Mouse ile bir uzunluk 
değeri ekranda girilir. Belirtilen ölçek katsayısı hem X hem de Y eksenleri doğrultusundaki 
boyutlarına uygulanır. Ölçek olarak kullandığımız katsayılardan 1’in altındaki değerler 
küçültmeyi üstündeki değerler büyütmeyi gerçekleştirir. Örneğin “scale factor” 0,5 
alındığında seçilen öğeler iki kat küçülür veya 2 alındığında bu öğeler iki kat büyür.  

 
Resim 50 : Scale komutunun küçültme ve büyütme olarak uygulanması 

 
“Specify scale factor or [Reference]:”uyarısından sonra Scale Factor değerini 

klavyeden girmeden de ölçekleme işlemi gerçekleştirilebilir. Klavye ile “R” tuşlayarak bu 
seçeneği aktifleştirebiliriz. Bu defa bizden Specify reference length iletisiyle büyültmek 
(veya küçültmek) istediğimiz ilk uzunluk değerini girmemiz gerekir. Sonrasında Specify new 
length: iletisiyle de bir önceki girdiğimiz değeri ne kadar yapmak istiyorsak o rakamsal 
değeri girmemiz istenir. 
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Resim 51 : Scale komutunun referans belirlenerek uygulanması. 

 
Örneğin yukarıdaki örnekte ilk seçtiğimiz üçgen şeklinde Specify reference length 

iletisine “50” , Specify new length: iletisine de “100” rakamsal değerleri girildi. Enter’la 
komuttan çıkıldığında 50 birim olan üçgenin kenar uzunluğunu 100 birim yapmış oluruz. 
İstenirse küsuratlı değerlerde girebilmek mümkündür. Böylece 2, 3, veya 0,5 gibi rakamsal 
değerler girerek nesneyi büyültüp küçültebileceğimiz gibi nesne üzerindeki herhangi bir 
uzunluğu referans alıp o uzunluğu istediğimiz rakamsal değere kadar küçültüp, 
büyültebiliriz. 

 
1.5.11. Stretch (Sündürme) 

 
STRETCH (Sündürme) komutu seçilen çizgileri diğer çizgilerle olan bağlantılarını 

koparmadan istenilen açıda uzatır veya kısaltır. 
 

 Adres 
• Ekran Menüsü:MODIFY 2 > STRETCH 
• Kayar Menü:Modify > Stretch 
• Komut Satırı: STRETCH (S) 
 

Bu komut sadece çizgileri değil seçilen bir nesnenin bir kısmını diğer parçalarıyla 
bağlantılarını koruyarak taşımamıza da olanak verir. 

 
Komut çalıştırıldığında “Select objects:” uyarısıyla nesne seçim metotlarından biri ile 

sündüreceğimiz nesne-nesneleri seçmemiz istenir. Öğeler seçildikten sonra “Specify base 
point or displacement:” uyarısı ile de sündürmenin başlatılacağı noktanın seçilmesi istenir. 
Tutuş noktası belirlendikten sonra son olarak “Specify second point of displacement” 
Tuttuğumuz noktayı sündürüp bırakacağımız ikinci noktanın girilmesi istenir. 

 
Nesnenin sündürülecek köşelerini belirlerken açmış olduğumuz pencerenin içine 

nesnenin bir kısmı girerse sadece giren kısımlar sündürülür. Ancak nesnenin tamamı 
seçilirse bu defa sündürme değil taşıma (MOVE) işlemi yapılmış olur. 
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Resim 52: Stretch komutunun uygulanması–1 

 
Bu komutla sadece neneleri göz kararı sündürmekle kalmayıp, istediğimiz ölçüde 

uzatıp kısaltabiliriz. Örneğin, mimarî çizimlerde sıklıkla karşılaştığımız pencere çizimlerinde 
pencerenin (veya benzer diğer şekillerin ) özelliklerini değiştirmeden kısaltarak bir başka 
yerde kullanabiliriz.  
 

  
Resim 53: Stretch komutunun uygulanması–2 

 
Örneğin, 110 cm uzunluğundaki bir pencereyi 50 cm uzunluğuna getirerek başka bir 

yerde kullanmak isteyebiliriz. Pencereyi uygun bir şekilde seçtikten sonra (Pencerenin 
tamamını seçmiyoruz! Komut SCALE komutuyla karıştırılmasın!) tutuş noktamızı 
(sündürmeye başlayacağımız noktayı) kısaltmak veya uzatmak istediğimiz taraftan belirleriz. 
Klvyede ki F8 tuşu basılarak programı <Ortho on> (sadece dik ve yatay çizmemize yardımcı 
olan komut) moduna getirmeliyiz. Sonra mouse ile kısaltmak istediğimiz istikamete doğru 
tuttuğumuz nesneyi bir miktar sürükler ve komut satırına klavye ile “60” yazar ve Enter 
tuşuna basarsak 110cm’ lik penceremizin 60 cm kısalarak 50 cm olduğunu görebiliriz. 
 

                  
Resim 54 : Stretch komutunun uygulanması–3 
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Bu şekilde kısaltma yapabildiğimiz gibi aynı işlemleri yaparak nesneleri sündürmek 
suretiyle uzatma işlemi de yapabiliriz. 

 
Resim 55 : Stretch komutunun uygulanması–4 

 
1.5.12. Array (Sıralı Çoğaltma) 

 
ARRAY (Sıralı Çoğaltma) diğer komutlardan farklı olarak kendi içinde 

RECTANGULAR (Doğrusal) ve POLAR (Açısal) olmak üzere ikiye ayrılmıştır. 
RECTANGULAR komutu seçilen çizim öğelerini Column (satır) ve Row (sütün) bilgilerine 
göre doğrusal formda çoğaltır. POLAR komutu ise seçilen çizim öğelerini belirlenen bir 
merkeze göre dairesel formda çoğaltır. 

 
 Adres 

• Ekran Menüsü: MODIFY 2 > ARRAY 
• Kayar Menü: Modıfy > Array 
• Komut Satırı: ARRAY (AR) 

 
Dairesel (POLAR) çoğaltma işleminde açılar saat ibresinin tersi yönünde olur. 

(AutoCAD programının kullanım şeklinde olduğu gibi) Ancak açı değeri olarak negatif (-) 
bir değer girilirse bu defa çoğaltma işlemi saat ibresi dönüş yönüne göre olur. 

 
ARRAY komutun temel felsefesi ve kullanımı basittir. Çoğaltmak istediğimiz nesne 

veya nesneleri seçtikten sonra doğrusal (rectangular) çoğaltacaksak programa satır (rows) 
ve sütun (columns) değerlerinin kaçar tane olduğunu tutma noktaları arasındaki mesafeyi 
girmemiz gerekecektir. Dairesel (polar) çoğaltma yapacaksak bu defa da nesneyi kaç 
derecelik açı ile kaç tane çoğaltacağımızı ve daire merkezini girmemiz gerekir.  
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AutoCAD programının 2002 sürümünde ARRAY komutunun Doğrusal ve Açısal 
çoğaltmaları düzenlemek için birbirine benzeyen iki ayrı menüsü vardır. Açılan bu menüleri 
ve seçeneklerini tanıyacak olursak; 
 

 
Resim 56 : Polar array menüsü 

 
Öncelikle açılan menüde doğrusal çoğaltma yapacaksak Rectangular Array 

seçeneğini, açısal-dairesel çoğaltma yapacaksak Polar Array seçeneğini 
işaretlemeliyiz.(Yukarıdaki menü açısal çoğaltma (Polar Array) seçeneğine ait menüdür.) 

 

Select objects:  düğmesi tıklandığında program sizden çoğaltmak istediğiniz 
nesneyi seçmenizi ister, bu nedenle yukarıdaki menü kaybolur ve Mouse Pickbox seçim 
kutusu halini alır. Nesne veya nesneleri seçim işini bitirip Mouse sağ tıkladığımızda veya 
‘‘enter’’ la çıktığımızda yukarıdaki menü yeniden ekrana gelecektir. 

 
Center point X:… , Y:… seçeneği dairesel çoğalmak istediğimiz nesne veya 

nesnelerin merkezi olacak noktanın “ x , y ” koordinatlarını girmemiz gerekir. Eğer 

koordinatlarla değilde noktasal çalışıyorsak  simgesi ile (Yine açılan menü merkez 
noktayı belirlememiz için kaybolacaktır) merkez almak istediğimiz noktayı Mouse ile 
tıklayarak belirleyebiliriz. 

 
Total number of items: seçeneği ile nesneyi kaç tane çoğaltmak istiyorsak o rakamı 

gireriz. Dikkat edilmesi gereken nokta; çoğaltma işlemi sonucunda nesneden kaç tane elde 
etmek isteniyorsa bu rakama ilk seçtiğimiz nesne de dahil edilmelidir. Yani sonuçta 5 (beş) 
nesne istiyorsak kutucuğa “5” rakamını girmemiz gerekir. İşlem sonucunda program “4” 
tane daha çoğaltarak seçtiğimiz nesne ile birlikte toplam “5” tane yapacaktır. 

 
Angle to fill: seçeneği, açısal-dairesel çoğaltma yapmak istediğimiz açısal değeri (0–

360 derece arasında) girmemiz gereken kutucuktur. Rakamsal bir açı değeri girebildiğimiz 

gibi Mouse ile  simgesini tıklayarak da belirleyebiliriz. 
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Angle between items: seçeneği ile (Türkçe karşılığı: nesneler arasındaki açı 
anlamındadır.) istenirse çoğaltma adedi girilmeden de dairesel çoğaltma yapabiliriz. Dairesel 
çoğaltma yapacağımız açı ile nesneler arasında olmasını istediğimiz açı değerini girerek ilk 
belirlediğimiz merkez açı etrafında ikinci belirlediğimiz açılarla nesneleri çoğaltabiliriz. 
Örnek olarak Angle to fill değeri olarak 360° girmişsek, Angle between items değerine de 15° 
girdiğimizi kabul edelim. Seçilen nesneyi çoğaltma sayısı girilmeden 360° açı etrafında 
15°’lik açılarla çoğaltacaktır. 

 
Rotate items as copied: seçeneği yanındaki kutucuğun dolu olması hallinde 

döndürerek çoğaltmak istediğimiz nesnenin belirlediğimiz açı etrafında dönüp dönmemesini 
sağlayabiliriz. Kutucuk dolu ise nesne merkez açı etrafında döndürülerek çoğaltılır, boş ise 
döndürülen nesne pozisyonunu değiştirmeden çoğaltılır. Açılan menünün sağ tarafındaki 
beyaz görüntü ekranında bunu rahatlıkla görebilirsiniz.  

 
Bunların dışında; 
OK: Kabul anlamındadır. 
CANCEL: Vazgeçmek anlamındadır. 
PREVİEW: Ön izleme anlamına gelir.      

 
Preview seçildikten sonra ekrana yukarıdaki uyarı gelir. Accept yapılan işlemi kabul 

etmek manasındadır, Modify Array menüsündeki değerlerde değişiklik yapmak için menüye 
dönmemize olanak sağlar. Cancel komuttan vazgeçmek anlamındadır. Tıklandığında hiçbir 
değişiklik ve çoğaltma yapmadan komuttan çıkarız. 

 
OK demeden önce yapmak istediğiniz çoğaltma işleminin istediğiniz şekilde olup 

olmadığını Preview düğmesini tıklayarak izleyebilir, daha sonra ok düğmesi ile 
kesinleştirebilirsiniz. Beğenmemişseniz veya vazgeçmişseniz cancel ile komuttan 
çıkabilirsiniz. 

 
Aşağıda açılan ve gerekli kısımları doldurulmuş olan POLAR ARRAY menüsü ve bu 

menünün neticesi olarak çoğaltılmış bir nesnenin ARRAY komutundan önceki ve komut 
sonrası görüntü görülmektedir. 
 

 
Resim 57 : İstenilen değerlerin girildiği polar array menüsü 
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Resim 58 : Girilen değerler sonucunda gerçekleştirilen polar array işlemi. 

 
Yukarıdaki örnekte seçilen nesne özellikle fark edilmesi için değişik renkte 

gösterilmiştir. Çoğaltma rakamına 10 (on) değeri girilmiştir. İşlemin sonucunda nesnenin 
kendisi ile birlikte toplam 10 (on) nesne olmuştur. Dairesel çoğaltma yapmak istediğimiz 
merkez resimde gösterildiği nokta olarak girilmiş ve 360° toplam çoğaltma açısı olarak 
kullanılmıştır. 

 

 
Resim 59: Rectangular array menüsü 

 

Şimdi de RECTANGULAR ARRAY menüsünü tanıyacak olursak burada da  
simgesi ile nesneyi seçebiliyoruz. Farklı olarak Rows (sütunlar) ve Columns (satırlar) 
bilgilerine ihtiyaç duyuluyor. Daha önce de açıklandığı gibi üste ve sağa kaçar tane 
kopyalamak istiyorsak o değerlerin rakamsal olarak girilmesi gereklidir. Row offset:, ve 
Column offset: kutucukları üste ve sağa çoğaltmak istediğimiz nesneler arasındaki 

mesafeleri girmemiz istenir. Yine rakamsal olarak girebildiğimiz gibi  simgelerini 
tıklayarak Mouse ile de belirleyebiliriz. 

 düğmesini tıklayarak da Row offset: ve Column offset: değerleri girilmeden 
Specify unit cell : ve Other corner: uyarıları ile sizden Mouse ile bir dikdörtgenin karşılıklı 
iki köşesini belirlemeniz istenir. Belirlediğiniz köşeleri referans alarak doğrusal çoğaltma 
işlemini gerçekleştirebilirsiniz. 
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Aşağıda üste ve yana 3’er tane olmak üzere, üst üste olanların mesafeleri 50 birim, 

yana doğru olanların mesafeleri 100 birim alınan doğrusal çoğaltmaya uygun bir örnek 
görülmektedir. 
 

 
Resim 60: İstenilen değerlerin girildiği rectangular array menüsü 

 

 
Resim 61 : Girilen değerler sonucunda gerçekleştirilen rectangular array işlemi 

 
Yine buradaki örnekte de seçilen nesne ile çoğaltılanlar özellikle fark edilmesi için 

değişik renkte gösterilmiştir. Yoksa ARRAY komutundan sonra elde edilen nesneler ilk 
seçtiğimiz nesne ile tamamen aynı özelliklere sahiptir. 

 
Bir önceki örnekten farklı olarak Angle of array: kutucuğunun işleyişini anlatmak için 

aşağıdaki örnek ele alınmıştır. Burası doğrusal çoğaltma yapmak istediğimiz nesnelerin 
yatayla yaptığı açı değerinin girildiği kutudur. İstenirse 0°–360° arasıda bir açı değerini 

rakamsal olarak girilebildiği gibi,  simgelerini tıklayarak Mouse ile de belirleyebiliriz. 
(Açı değerini negatif (-) girersek program nesneleri saat ibresi yönünde döndürecektir.) 
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Resim 62 : Açısal değerlerin girildiği rectangular array menüsü 

 

 
Resim 68 : Açısal değerlerin girildiği rectangular array işleminin bitmiş işlemi 

 
1.5.13. Break (Kırmak) 

 
BREAK (Kırmak) komutu; bir çizim öğesini iki parçaya ayırır veya bu öğenin bir 

kısmını siler. Bu komut çember yay gibi nesnelere uygulandığında ilk seçilen noktadan 
ikinci seçilen noktaya doğru saat ibresinin tersi yönünde yol takip ederek silinir. 

 
 Adres 

• Ekran Menüsü :MODIFY 2 > BREAK 
• Kayar Menü :Modify > Break 
• Komut Satırı :BREAK (BR) 

 
Kapalı olmayan çizim öğelerinin uç kısmının silinmesi için ikinci sınır noktayı 

belirleyecek noktanın çizginin dışında tanımlanması yeterlidir. 
 
Komut çalıştırıldığında komutun uygulanacağı nesnenin seçilmesi için “Breac _ 

Select objects:” uyarısı gelir. Nesneyi seçmek için tıkladığımız nokta kırma işleminin 
yapılacağı ilk noktayı da temsil eder. Arkasından Specify second break point or [First 
point]: uyarısı gelir. Komut satırında bu uyarı varken “ f – F ” yazılıp Enter yapılırsa, önce 
ilk noktayı belirlememiz için “Specify first break point:” ve belirledikten sonra arkasından 
ikinci noktayı seçmemizi isteyen “Specify second break point:” uyarıları gelir. 
Belirlediğimiz noktalar arasında kalan kısım program tarafından silinecektir. 
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Önemli özelliklerden birisi de komutu uygulayacağımız nesneyi belirledikten sonra 
gelen “Specify first break point:” ve “Specify second break point:” isteklerine mutlaka 
nesne üzerinde bir nokta vermek zorunda değiliz. İstersek nesnenin dışında herhangi bir 
nokta verebiliriz. Bu şekilde olursa belirlediğimiz noktanın iz düşümü nesne üzerine 
düşürülerek işlem yapılır. 
 

 
Resim 63 : Break komutunun uygulanması–1 

 

 
Resim 70 : Break komutunun uygulanması–2 

 
“Breac _ Select objects:” uyarısından sonra “Specify second break point:” uyarısı 

geldiğinde klavye ile @ ( Alt Gr + Q ) simgesi girilirse, seçtiğimiz nokta itibari ile doğrunun 
hiçbir parçası silinmeden iki parçaya ayrılmış olur. 

 
1.5.14. Pedıt (Birleşik Çizgilerin Düzenlenmesi) 

 
PEDIT (Birleşik Çizgilerin Düzenlenmesi) komutu seçilen nesneleri bileşik çizgiye 

döndürerek ya da hâlihazırda bileşik çizgi olan nesneleri düzenlememizi sağlar. Bu komut 
birleşik çizgi (Pline-Polyline) olarak çizilen çizim öğeleri üzerinde düzenlemeler yapmamızı 
veya ayrı ayrı oluşturulan çizim öğelerini birleşik çizgi (Pline) haline getirmemizi sağlar. 
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 Adres 

• Ekran Menüsü :DRAW 1 > Pline > Pedit :MODIFY > Pedit 
• Kayar Menü :Modıfy > Object > Polyline 
• Komut Satırı : PEDİT (PE) 

 
Komut birleşik çizgileri düzenleyen bir komuttur. Eğer siz komutu 

seçtikten sonra düzenlemek istediğiniz çizgi veya çizgiler tamamen birleşik 
çizgilerden oluşmuyorsa, program seçilen çizgileri birleşik çizgi yapılıp yapılmayacağını 
soran aşağıdaki şu mesajlar görüntülenir. 

 
PEDIT Select polyline or [Multiple]: 
Object selected is not a polyline 
Do you want to turn it into one? <Y> 
 
Bu mesaja Y olarak (evet seçtiğim çizgileri polyline-birleşik çizgi yap) cevap verilirse 

program seçtiğiniz çizgileri birleşik çizgi haline getirecektir. Daha sonra komut satırına 
aşağıdaki gibi mesaj gelecektir. 

 
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Undo]: 
 
Buradaki seçenek ve mesajları inceleyecek olursak: 
 
[Close] 
Birleşik çizgi olarak seçilen şeklin uçları açıksa çizime başlanılan ilk noktayla son 

nokta arsını birleştirerek kapalı şekil oluşturur. Seçilen birleşik çizgi kapalı bir şekil ise 
çizime başlanılan ilk noktayla birleşen son noktanın arasını açar. 

 
[Join] 
Birleşik çizgiye dahil olmayan çizim öğelerini birleşik çizgiye ekler. 
 
[Width] 
Birleşik çizgiye eklenecek diğer çizim öğeleri farklı çizgi kalınlığına sahipse bu 

çizgileri aynı çizgi kalınlığına getirir. 
 
[Edit vertex] 

Birleşik çizgilerin birleşme noktalarında düzenlemeler yapar. Bu seçeneğin 
çalıştırılmasıyla üzerinde düzenleme yapılacak olan birleşik çizginin ilk birleşme noktasına 
X işareti yerleşir. Bu seçenek kullanılarak birleşik çizgilere farklı fonksiyonlar uygular. 
Bunlar şu şekildedir: 

 
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit] 
Kısaca açıklayacak olursak; 

 NEXT: Edit Vertex işlemine başlanıldığında düzenleme işlemi için birleşik 
çizginin ilk birleşme noktasına X işareti yerleşir. Bu seçenek daha sonra sırasıyla 
sonraki noktalara ulaşılmasını sağlar. 
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 PREVİOUS: Bir önceki birleşme noktasına ulaştırır. 
 BREAK: Birleşik çizgiyi iki parçaya ayırır ve istenmeyen kısmını siler 
 INSERT: Birleşik çizgilere yeni çizgiler ilave eder. 
 MOVE: Birleşme noktalarının yerini değiştirir. 
 REGEN: Çizgiler arasındaki kırık görüntüleri düzenler. 
 STRAİGHTEN: İki birleşme noktasının arasını düz çizgi ile birleştirir. 
 TANGENT: Birleşme noktaları için teğet doğrultuyu tanımlar. 
 WİDTH: Belirtilen noktalar arasında kalan çizgilerin genişliğini belirler. 
 EXİT: Vertex komutundan çıkarak Pedit komutuna dönülür. 

 
[Fit] 
Birleşik çizgiyi oluşturan çizgileri birleşme noktalarından geçecek şekilde yaya 

dönüştürür. 
 
 
[Spline] 
Birleşik çizgileri oluşturan çizgilerin birleşme noktalarını ‘‘yay’’ ın kontrol noktaları 

olarak kullanır. Yay birinci ve sonuncu kontrol noktalarından geçecek şekilde oluşur. 
 
[Decurve] 
Birleşik çizgi içindeki yaylar ile FIT ve SPLINE kullanılarak oluşturulmuş yayları düz 

çizgi durumuna getirir. 
 
[Ltype gen] 
Kesikli çizgi kullanılarak yapılan çizimlerde kesişim noktalarına göre çizgilerin 

düzenini kontrol eder. ON ve OFF olmak üzere iki seçenektir. On; çizgi birleşim yerlerine 
kesik çizgilerin boş kısımları gelmez. Off; kesik çizgiyi düz bir çizgiymiş gibi dikkate 
almadan çizer. 

 
[Undo] 
Son yapılan düzenleme işlemini iptal eder. 
 
[Exit] 
Pedit uygulamasını sona erdirir. 

 

 
Resim 64 : Pedıt komutunun plıne öğeye “fit” seçeneği ile uygulanması 
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Resim 65 : Pedıt komutunun plıne öğeye uygulanması 

 
Birden fazla çizgiyi AutoCAD’ la Pline yapmak için PEDİT komutu çalıştırılır. 

Birleştirilecek çizgilerden herhangi biri seçilir. ENTER veya Mouse sağ tuş tıklanır. Gelen 
menüden (Y) yes seçeneği seçilerek ‘‘ENTER’’ lanır. Açılan yeni menüde Join (J) (birleştir) 
seçilerek ‘‘ENTER’’ lanır. Son olarak birleştirmek istediğimiz çizgilerin tamamını seçilir 
‘‘ENTER’’ la onaylanır. Artık farklı şekillerde çizdiğimiz birden fazla çizgiler bir tek PLINE 
olarak değerlendirilir. Burada önemli olan birleştirmek istediğimiz çizgilerin uçlarından 
birbirlerine dokunuyor olması gereklidir. 

 
1.5.15. Undo (Geri Alma) 

 
Gerçekleştirilen komutları geri alma, geri alma işlemlerini kontrol etme komutudur. 

Fakat biz genellikle bir önceki komutun etkisini geri almak için UNDO (Geri Alma) 
komutunu kullanacağımızdan bu komuta özel olarak ihtiyaç duymayacağız. 

 
 Adres 

• Ekran Menüsü :EDIT > UNDO 
• Kayar Menü :Edit > Undo 
• Komut Satırı :UNDO 

 
Klavye ile komut satırına UNDO yazarak komutu çalıştırdığımızda program bizi 
“Enter the number of operations to undo or [Auto/Control/BEgin/End/Mark/Back]” 

uyarısı ile karşılar. En sondaki 1 (Bir) değeri kaç komut geri alınacağının default değeridir. 
Buraya istediğimiz rakamı girdiğimizde, girdiğimiz rakam kadar komut geri alınacaktır. 

 
Genellikle UNDO komutuna girilip, geri almak istediğimiz komut kadar bir değer 

girilerek geri alma işlemi uygulanmaz. Çünkü ne kadar dikkatli kullansak da, kaç komut 
geriye gittiğimizde, nerede olacağımızı kestirebilmemiz gerçekten güç bir durumdur. Ayrıca 
daha önce yapmış olduğumuz çizimleri de kaybedebilme riski de vardır. Bunun için hangi 
yöntemi kullanırsak kullanalım, geri alma işlemini teker teker ve ekranda görerek yapmak 
daha uygun olacaktır. 

 
“Enter the number of operations to undo or [Auto/Control/BEgin/End/Mark/Back]”  
 
Uyarısındaki seçenekleri kısaca açıklayacak olursak: 
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[Auto] 
Bu komutun on ve off olmak üzere iki seçeneği vardır. On modunda ise seçilen bir 

komut ne kadar karmaşık olursa olsun tek bir Undo komutu ile geri alınabilecektir demektir. 
 
[Control] 
Geri alma işlemlerini sınırlar ya da tamamıyla işlemez hale getirir. Bu seçenek 

seçildiğinde komut satırında [All/None/One] <All>:(Tümü, Hiçbiri, Bir) uyarısı gelir. 
İstenilen seçenek kullanılabilir. 

 
[BEgin/End] 
Begin (Başla) ve End (Son) anlamındadır. Başlangıcını ve sonunu belirttiğiniz bir 

aralıkta uygulanan tüm komutların UNDO komutu tarafından tek bir işlem olarak 
algılanmasını sağlar. 

 
[Mark] 
Back (Geri) seçeneği ile birlikte kullanılır. Fakat herhangi bir Begin (Başla) işler 

durumda ise Mark (İşaret) ve Back (Geri) seçenekleri kullanılmaz. 
 
 
[Back] 
En son Mark (İşaret) seçeneği ile işaret atılmış bir noktaya kadar çizimi geri alır. 
 

Undo (geri alma) komutunun etkilemediği komutlar 
 
• ABOUT • END • PSOUT • SAVE 
• AREA • FILES • QSAVE • SAVEAS 
• ATTEXT • GRAPHSCR • QUIT • SHADE 
• COMPİLE • HELP • RCOVER • SHELL 
• CVPORT • HIDE • REDRAW • STATUS 
• DBLIST • ID • REDRAWALL • TEXTSCR 
• DELAY • LIST • REGEN 
• DIST • NEW • REGENALL 
• DXFIN • OPEN • REINIT 
• DXFOUT • PLOT • RESUME 

 

 
1.5.16. Redo (İleri Alma): 
 

En son kullanılan komut bir Undo (Geri Al) komutu ise bu komutun da etkisini geri 
alan bir komuttur. En önemli özelliği bir kere kullanılabilir. 

 
 Adres 

• Ekran Menüsü :EDIT > REDO 
• Kayar Menü :Edit > Redo 
• Komut Satırı : REDO 
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1.5.17. Blıpsmode (İşaret Modu) 

 
BLIPS komutu çizim alanında seçilen koordinat noktalarına izafi olarak artı (+) 

işaretinin konulup konulmamasını kontrol eder. Bu işaret bir çizim öğesi olmayıp görsel 
yardım amacıyla kullanılır. Printer çıktılarında gözükmez. İzafi olan Blips noktaları 
REDRAW, ZOOM, PAN, REGEN vb. ekranı yenileyen komutlar kullanıldığında kaybolur. 

 
“BLIPMODE” 
“Enter mode [ON/OFF] <OFF>”  
 
ON : Blips modu açık. İşaretlenen koordinatlara izafi noktalar konulur. 
OFF : Blips modu kapalı. İşaretlenen koordinatlara izafi noktalar konulmaz. 
 
Komuta ancak klavyeden komut satırına “BLIPMODE” yazarak ulaşabiliriz. Bunu 

yazdığımızda komut satırında; “Enter mode [ON/OFF] <OFF>” uyarısı gelir. Programın 
default değeri OFF dur. Siz bunu ON olarak değiştirirseniz bir dahaki değiştirinceye kadar 
bilgisayar değişik zamanlarda açılıp kapansa da Mouse ile ekranda her tıkladığınız noktaya 
küçük bir + işareti konulacaktır. 

 
Çalışmalarımızda ekranda yaptığımız her işaretleme veya komut satırından girdiğimiz 

noktalar sonucunda işaretlenen yerde veya belirtilen noktada işaretlerin oluşturulması 
sağlanabilir. Bu işaretler çizimin bir parçası olmayıp, sadece görsel bir kolaylık şeklinde 
düşünülebilir. 

 
1.5.17. Ortho (Dikey): 

 
ORTHO komutu yalnız yatay ve düşey doğruların çizilmesine imkân tanır. Eğer Ortho 

modu açık (On) ise ‘‘cursor’’ün merkezi hangi konumda olursa olsun koordinat eksenlerine 
dik veya paralel doğrultuda çizgiler çizilebilir. 

 
On : Ortho modu açık. Yalnız düşey ve yatay doğrular çizilebilir 
Off : Ortho modu kapalı. ‘‘Cursor’’ün hareketi serbesttir. 

 

      
 
     Ortho Off  (Ortho modu kapalı)      Ortho On  (Ortho modu açık) 

Resim 66 : Ortho modunun on (açık) ve off (kapalı) halleri 
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Ortho komutunu aktif hale getirmek veya etkisizleştirmek için (On-Off Halleri) birkaç 
yol vardır. Bunlardan biri klavye üzerindeki  “ F8 ” tuşudur. Bir diğeri AutoCAD ekranının 
en altında bulunan satırda sırasıyla “SNAP, GRID, ORTHO, POLAR …” komutları 
bulunmaktadır. Mause ile ORTHO yazısının üzeri tıklandığında komut modu açık veya 
kapalı hale getirilebilir. Bir başkası da komut satırına direkt olarak “ORTHO” kelimesi 
yazılarak elde edilir. Bu komut, komut satırına yazılıp ENTER tuşuna basıldığında ekrana ; 

 Enter mode [ ON / OFF ] < OFF yazısı çıkar.  
Komutu aktif hale getirmek istiyorsanız komut satırına ON yazıp ENTER tuşuna 

basmalısınız. Komutu devreden çıkarmak istiyorsanız, yani Off konumuna getirmek 
istiyorsanız komut satırına bu defa OFF yazıp ENTER tuşuna basmalısınız. 

 
Her ne kadar Ortho modu ON pozisyonunda iken eğik çizgiler çizemiyorsak da Object 

Snap (Nesne Yakalama) özelliği yardımıyla diğer nesnelere kenetlenerek eğik çizim 
yapabilmemiz mümkündür. 
 

 
Resim 67: Ortho modunun komut satırında gösterilmesi 

 
Diğer Autocad terimlerinde de olduğu gibi bütün komutlar kullanılırken veya devre 

dışı bırakılırken en alttaki komut satırında bunlar görülebilmektedir. Yani sadece komut 
satırına yazarken değil F8 tunşuna basıldığında, ekranın en altındaki ORTHO yazısı 
tıklandığında da komut satırında bunlar görülebilir. 

 
1.5.19. Snap (Kenetlenme) 

 
SNAP (KENETLENME) komutu ‘‘Cursor’’ün (imlecin) hareketlerinin belirlenen 

aralık ve açıda olmasını kontrol eder. Kenetlenme (snap) modu kapalıyken imleç- cursor 
hareket ettirildiğinde durum çubuğundaki koordinatlar (program penceresinin en alt sol 
kenarındaki rakamlar) izlenirse herhangi bir kısıtlama olmadığı görülür. Yani Cursor çalışma 
alanındaki her noktaya ulaşabilmektedir. Snap komutuyla ‘‘Cursor’’un yatay ve dikey 
hareket aralıkları sınırlandırılabilir. Snap modu açıksa Cursor, artık çalışma alanındaki bütün 
noktalara ulaşamaz. Çünkü Cursor belirtilen aralıklarda atlayarak hareket etmektedir. Bu 
durum koordinatlar izlenerek görülebilir. 

 
Komut satırına Snap yazılıp Enter yapıldığında komut satırında: 
“Specify snap spacing or [ON/OFF/Aspect/Rotate/Style/Type] <10.0000>:”  uyarısı 

gelecektir. Bu uyarıya sadece Enter tuşlayarak cevap verdiğimizde komut, komut satırının en 
sonundaki <10.0000> değerini kabul ederek faal hale gelecektir. İstenilirse bu rakamsal 
değer değiştirilip farklı bir pozitif sayı (ondalıklı sayılarda dahil ) girilebilir. Rakamı 
girdikten sonra Enter la çıktığımızda artık Cursor yatay ve düşey istikamette sizin 
belirlediğiniz rakamsal değer kadar sıçyarak gidecektir. Ara değerleri yakalayamayacaktır. 
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Ayrıca Snap modu “F9” ve “Ctrl+B” tuşlarıyla veya ekranın en altında yer alan 
durum satırındaki simgesini Mouse ile tıklayarak da On/Off yapılabilir. Tabiki en son 
girdiğimiz rakamsal değeri sıçrama mesafesi olarak kabul ederek. 
 

 
Resim 68 : Snap modunun komut satırında ve ekranın altında gösterilmesi. 

 
“Specify snap spacing or [ON/OFF/Aspect/Rotate/Style/Type] <10.0000>:” 
Uyarısındaki seçenekleri inceleyecek olursak; 
 
[ON/OFF] :Klavye ile On veya Off seçeneklerinden birisi girilerek komut aktif veya 

pasif hale getirilebilir. Aynı olayın “F9” ve “Ctrl+B” tuşlarıyla da yapılabildiğini 
anlatmıştık. 

 
ON: Snap modu açık. Cursor ayarlanan aralıkta ve biçimde hareket eder 
OFF: Snap modu kapalı. Cursor serbest hareket eder. 
 
[Aspect] :Cursor’un yatayda ve dikeyde farklı aralıklarla hareket etmesi istenilirse bu 

seçenek kullanılır. Örnek olarak Cursor’un yatayda 5 birim, dikeyde 20 birim aralıklarla 
hareket etmesini istersek; “Specify snap spacing or [ON/OFF/Aspect/Rotate/Style/Type] 
uyarısına klavye ile A (a) girip Enter dersek, öncelikle horizontal (Yatay) değeri girmemiz 
istenir. Ardından vertical (Dikey) değeri girmemizi isteyen aşağıdaki satırlar sırası ile gelir. 

 
Command: snap 
 
Specify snap spacing or [ON/OFF/Aspect/Rotate/Style/Type] <10.0000>: a 
Specify horizontal spacing <10.0000>: 5 
Specify vertical spacing <10.0000>: 20 
 
Bu değerleri de girip Enter yapıp çıktığımızda artık Cursor yatayda 5 birim, dikeyde 

20 birim aralıklarla hareket edecektir. 
[Rotate] : Snap modu açıldığında Cursor hareketleri verilen değerlerle sınırlandırılır 

ve (0,0) noktasından itibaren Cursor yatayda ve dikeyde verilen değer kadar atlayarak 
hareket eder. [Rotate] seçeneğinin görevlerinden biri bu başlangıç noktasını değiştirebilir. 
Diğer bir görevi ise Cursor sıçramalarının yatay ve dikeyde değil de istenilen bir açı ve buna 
dik konumda olmasını sağlar. 

 
Command: snap 
 
Specify snap spacing or [ON/OFF/Aspect/Rotate/Style/Type] <10.0000>: r 
Specify base point <0.0000,0.0000>: 10,10 
Specify rotation angle <0>: 35 
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Yukarıda komut satırlarındaki uyarılar incelenecek olursa R ( r ) seçeneği seçildikten 
sonra default değer olarak gelen <0.0000,0.0000> değeri 10,10 olarak değiştirdiğimizde 
(koordinat eksenindeki istediğimiz değeri girebiliriz.) sıçrama açısının değiştirilebileceği 
satıra da 35°’ değerini giriyoruz. Kullanıcı tarafından değiştirilinceye kadar artık yatayla 
35°’ lik açı ile sıçrayarak çizeceğiz demektir. 

 
[Style] :Bu seçenek bize “Standart” veya “Izometrik” olmak üzere iki biçimden birini 

seçmemize imkân verir. Şu ana kadar anlatılan snap modu standart kullanım biçimidir. 
İzometrik biçim ise bize izometrik çizimlerde bize yardımcı olmak üzere düzenlenmiştir. 
Komut satırındaki işleyişi aşağıdaki gibidir.  

 
Command: snap 
 
Specify snap spacing or [ON/OFF/Aspect/Rotate/Style/Type] <10.0000>: s 
Enter snap grid style [Standard/Isometric] <S>: i 
Specify vertical spacing <10.0000>: 30 
 
[Type] :Snap tipi için sunulan iki seçenekten biri olan “Grid”, snap modunun yukarıda 

anlatıldığı tarzda kullanımına karşılık gelir. “Polar” seçeneğinin ise kutupsal izleme modu 
veya nesne kenetlenme izi modu açıkken kullanılabilir. 

 
1.5.20. Grıd (Izgara): 

 
GRID (Izgara) komutu ekranda, noktaların meydana getirdiği bir ızgara 

oluşturulmasını sağlar. Bu ızgaralar yapmış olduğumuz çizimin bir parçası değildir. Printer 
çıktılarında görünmezler. Genellikle görsel bir kolaylık sağladığı için “Snap” modu ile 
birlikte kullanılır. ‘‘Cursor’’un-‘‘İmleç’’in atlamalarını saymak yerine ızgaradaki noktaların 
sayılması daha kolay olacaktır. 

 
Klavyeden GRID (grid) yazılarak ‘‘Enter’’lanır ve komut aktif hale gelir. 

Ekranda Limits denilen çizim sınırları ile belirlediğimiz alan içerisinde görüntülenen 
ızgara, (karelaj da denilebilir genellikle haritacılar bu şekilde kullanır.) noktaların görünüp 
görünmeyeceğini ve kaç birimde bir görüntüleneceğini ayarlayan bir komuttur. Komut 
girildiğinde komut satırında: 

 
Command: GRID 
Specify grid spacing(X) or [ON/OFF/Snap/Aspect] 
 
uyarısı görülür. Komut çalıştırıldığında default olarak grid spacing (ızgara aralığı) 

olarak 0,0000 değeri mevcuttur. Yeni aralık değerini klavyeden rakamsal olarak girebiliriz. 
Aşağıdaki şekilde bu değer 5 olarak girilmiştir. 
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Resim 69 : Grıd modunun komut satırında ve ekranın altında gösterilmesi. 

 
[ON/OFF] 
Ekrandaki ızgara noktalarının görünebilir veya görünmez olmasını kontrol eden 

seçeneklerdir. Klavyedeki F7 tuşu da ‘‘grid’’lerin On veya Off olmasını sağlar. Aynı 
zamanda ekranın en altındaki GRID yazısı da Mouse ile tıklanarak aktif veya pasif olabilir. 

 
[Snap] 
Izgara noktalarının görüntülenmesi gereken aralık değerinin Snap (kenetlenme) 

değerine eşitlenmesini sağlayan bir seçenektir. Bu seçeneğin default olarak kullanılması 
gereklidir ki her Snap değerini değiştirdiğimizde Grid değeri de otomatik olarak 
ayarladığımız değere göre eşitlensin. Bu seçenek seçildiğinde Grid Spacing değeri 0 (sıfır) 
kabul edilmiş demektir. Böylece ızgara arlığı görüntülenmesi gereken değer için snap 
komutunun değerini kullanacaktır. 

 
[Aspect] 
Default olarak Grid Spacing (ızgara aralığı) değeri girdiğimizde bu değer X ve Y 

yönü için eşit olarak değerlendirilir. Aspect (Oran) seçeneği ise ızgara noktalarının X ve Y 
yönünde farklı değerlerle görüntülenmesi için kullanılan bir seçenektir. Komutun işleyişi 
aşağıdaki gibidir.  

 
Command: GRID 
 
Specify grid spacing(X) or [ON/OFF/Snap/Aspect] <10.0000>: A 
Specify the horizontal spacing(X) <10.0000>: 20 
Specify the vertical spacing(Y) <10.0000>: 30 
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X ve Y yönü için istenilen grid değerleri olarak 20 ve 30 değerleri girilmiştir. 
Böylelikle ekrandaki grid noktaları yatay ve düşeyde istediğimiz aralıklarla birbirinden farklı 
olarak gözükecektir. 
 

Ayrıca aşağıdaki komutları komut satırına yazarak snap (kenetlenme) açısını 
değiştirebilmemiz, aynı zamanda da ekrandaki grid görünümünü de o açıya uydurabiliriz. 

Command: SNAP 
 
Specify snap spacing or [ON/OFF/Aspect/Rotate/Style/Type] <10.0000>: R 
Specify base point <0.0000,0.0000>: 
Specify rotation angle <0>: 30 

 
1.6. Özellik Düzenleme Araçları 
 

Çizmiş olduğumuz herhangi bir nesnenin mutlaka aşağıdaki özelliklere sahip olması 
gerekmektedir. Bunlar; 

 
 Renk (Color) 
 Katman (Layer) 
 Çizgi tipi (Linetype) 
 Çizgi kalınlığı (Lineweight) 
 Çizgi kalınlığı ölçeği (Linetype scale) 
 Çıktı ayarlar (Plot style) 
 Kalınlık vs, 

 
Bu özellikler genelde çizim esnasında oluşturulan nesneye verilmektedir. Ancak bazı 

hallerde bu özelliklerin değiştirilmesi gerektiği veya çizdiğimiz andaki şartların değişmesi 
bizi yeni düzenlemelere mecbur bırakabilir. 

 
Aşağıda çalışmalarımızda çok sık kullanacağımız özellik değiştirme komutlarından ve 

yollarından bahsedilecektir. Unutulmaması gereken; burada mevcut çizilmiş olan nesneler 
üzerinde değişiklik yapılmasıdır. Yeni çizmiş olduğumuz bir nesneyi zaten istediğimiz 
özelliklerde çizebileceğimizi biliyoruz. 

 
Özellik düzenleme araçlarına AutoCAD programında ulaşılabilen birden fazla komut 

vardır. Bunlar sırasıyla şöyledir; 
 

 Change (Değiştirmek) 
 Properties (Özellikler) 
 Match Properties (Özellikleri Eşleme) 
 Explode (Patlatma) 

İlerleyen sayfalarda bu özellikler anlatılmaktadır. 
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1.6.1. Change (Değiştirmek) 
 

Seçtiğimiz nesne veya nesneler grubunun renk, katman, çizgi tipi, çizgi tipi ölçek 
katsayısı ve kalınlığını değiştirebilmemizi sağlayan bir komuttur. 

 
Komut satırına klavyeden CHANGE yazıp ‘‘Enter’’ layarak ulaşabiliriz. Komut 

satırında; 
 
Command: CHANGE 
Select objects: 1 found 
Select objects: 
Specify change point or [Properties]: 
 
uyarıları gelecektir. Öncelikle özelliğini değiştirmemizi istediğimiz nesneyi seçmemiz 

istenir, ardından da değişiklik yapacağımız noktayı belirlememiz gerekecektir. 
 
Komutun default sorusu olan “Change point” (değiştirme noktası) iletisine 

vereceğimiz cevap seçmiş olduğumuz nesne ya da nesnelere göre programda değişik 
şekilderde değerlendirilecektir. 

 
Select objects: iletisine bir CIRCLE (çember) seçerek cevap verirsek;, 
Change point  ile belirlediğimiz noktaya kadar çember yarıçapı büyültülecek veya 

küçültülecektir. 
 

 
Resim 70 : Change komutunun bir çembere uygulanması 

 
Çemberin yarıçapını göz kararı veya bir referans noktasına kadar uzatmak yerine 

rakamsal olarak bir değer girerek değiştirmek istersek programın change point  ile istediği 
nokta iletisine Enter ile cevap verirsek bu defa komut satırında; 

Specify new circle radius <no change>: iletisi gelir ve bizden rakamsal bir değer 
girmemizi ister. 
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Select objects: iletisine bir TEXT (yazı) seçerek cevap verirsek; programın Change 

point  ile istediği noktayı ekranda tıklayarak belirlediğimizde yazımızın referans noktası 
seçtiğimiz yeni noktaya taşınacaktır. 

 
Yazının yeni referans noktası belirlendikten sonra komut tamamlanmayacak, diğer 

seçenekler ile devam edilecektir. 
 

 [Enter new text style <Standard>:] Yeni yazı sitili girmemiz istenir 
 [Specify new height <30.0000>:] Yeni yazı yüksekliği girmemiz istenir. 
 [Specify new rotation angle <0>:] Yeni açı girmemiz istenir. 
 [Enter new text <change>:] Yeni yazı metni girmemiz istenir. 

 
Bütün bu isteklere gerek görüyorsak değişiklik yapabilmek için yeni değerler 

girebiliriz. Değişiklik istemiyorsak ENTER yaparak bir sonraki soru grubuna geçebiliriz. Bir 
başka seçenek olarak da herhangi bir anda klavyeden ESC tuşuna basarak o ana kadarki 
yapmış olduğumuz değişiklikler kalmak üzere komuttan çıkabiliriz. 

 
Select objects: iletisine bir LINE (Çizgi) seçerek cevap verirsek; 
Change point iletisine ekranda yeni bir nokta işaretleyerek yanıt verdiğimizde seçmiş 

olduğumuz çizginin yeni göstereceğimiz noktaya yakın olan uç noktasını sündürmüş oluruz. 
 

 
Resim 71 : CHANGE komutunun bir doğru çizgiye (line) uygulanması 

 
Burada önemli olan hususlardan birisi; eğer ORTHO [F8] (diklik ve yataylık 

sağlayan komut) ON (faal) konumda ise çizginin uç noktası Change point ile belirlediğimiz 
yeni noktaya değil, onun yatay veya dikey en yakın noktasına taşınacaktır. 
 

Bunlardan başka, eğer komutun Specify change point or [Properties]:uyarısına  
[Properties]: seçeneğini P ile seçerek cevap verirsek; komut satırında; 

 
Enter property to change [Color/Elev/LAyer/LType/ltScale/LWeight/Thickness]: 

iletisi görülür. 
 
Not: Komut satırındaki ltScale/LWeight/Thickness gibi uyarılara metindeki büyük 

olarak gösterilen harflerle “S” , “LW”, “T”, vb komut satırına girer ve ENTER yaparsak o 
özelliği faal hale getirmiş oluruz. 
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 [Color](C-c) Renk 
Seçtiğimiz nesne ya da nesnelerin rengini değiştirmek için kullanılan seçenektir. 
 
 [Elev](E-e) Yükseklik 
Seçtiğimiz nesne ya da nesnelerin ait olduğu Z düzlemi değerini (± 0,00 noktasından 
olan yükseklik değerini) değiştirmek için kullanılan seçenektir. 
 
 [LAyer](LA-la) Katman 
Seçtiğimiz nesne ya da nesnelerin ait olduğu katmanı değiştirmek için kullanılan 
seçenektir. 
 
 [LType](LT-lt) Çizgi Tipi 
Seçtiğimiz nesne ya da nesnelerin ait olduğu çizgi tipini değiştirmek için kullanılan 
seçenektir. 
 
 [ltScale](S-s) Çizgi Tipi Ölçeği 
Seçtiğimiz nesne ya da nesnelerin ait olduğu çizgi tipi ölçeğini değiştirmek için 
kullanılan seçenektir. 
 
 [LWeight](LW-lw) Çizgi Kalınlığı 
Seçtiğimiz nesne ya da nesnelerin ait olduğu çizgi kalınlığını değiştirmek için 
kullanılan seçenektir 
 
 [Thickness](T-t) Kalınlık 
Seçtiğimiz nesne ya da nesnelerin sahip olduğu çizgi kalınlık değerini değiştirmek 
için kullanılan seçenektir. 

 
1.6.2. Properties (Nesne Özellikleri) 

 
Nesne özelliklerini değiştirmek için kullanılan en önemli komutlardan biridir. Hatta 

sahip olduğu özellikler itibarı ile en iyisidir de denilebilir. Properties komutuyla hemen 
hemen nesnelerin tüm özellikleri değiştirilebilmektedir. 

 
 Adres 

• Ekran Menüsü :MODIFY 1 > PROPERTY 
• Kayar Menü :Modify > Properties 
• Komut Satırı : PROPERTİES  

 
Properties penceresine farklı bir yol olarak da önce nesnelerin seçilmesinin ardından 

ekranda ‘‘Mouse’’ un sağ tuşunu tıklayarak ortaya çıkan listenin en altında bulunan 
Properties seçeneğini seçerek de ulaşabiliriz. 

 
Komut yukarıdakilerden herhangi biri ile çalıştırıldığında ekrana aşağıdaki Properties 

penceresi gelir. 
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Resim 72 : PROPERTİES penceresinin nesne seçilmeden ve bir çember seçildikten sonraki hali. 

 
Eğer herhangi bir nesne seçilmeden komut çalıştırılmışsa (soldaki şekil) pencerede o 

andaki açık olan çizim dosyamızla ilgili bir takım bilgiler bulunur. Bunlardan bazıları 
değiştirilebilir (örneğin, koyu renkle yazılanlar), bazıları da değiştirilemezler. Ama bir nesne 
seçilerek komut çalıştırılmışsa bu defa o nesne ile ilgili bilgiler bulunacaktır. Örneğin 
çizilmiş olan bir çember seçildikten sonra properties komutu çalıştırılırsa (sağdaki şekil ) o 
nesne ile (bura da çember) ilgili bilgiler vardır. 

 
Eğer birden fazla nesne seçilerek komut çalıştırılırsa hepsinin ortak özellikleri veya 

her birinin tek tek özelliklerinin değiştirilebilmesi mümkün olabilmektedir. Bunu yapmak 
için pencerenin en üstündeki liste kullanılır. Bu pencere tıklandığında seçili ne kadar 
nesneden kaçar tane var ise listelenir ve ortak özellikleri (değiştirilebilenler ve 
değiştirilemeyenlerle birlikte) gösterilir. 

 
Seçili nesnelerin özellikleri “Alphabetic” veya “Categorized” sekmelerinde 

görüntülenir. Alphabetic sekmesi işaretlenirse alfabetik sıraya göre, Categorized sekmesi 
işaretlenirse aynı özellikler sınıflandırılarak sunulur. Şekillerde görüldüğü gibi 
değiştirilemeyecek özellikler açık renk tonu ile belirtilmiştir. 

 
Properties penceresinin herhangi bir yerinde ‘‘Mouse’’ un şağ tuşuna basarak kısa yol 

menüsünün açılmasına sebep olur. Burada; “Allow Docking”, “Hide”, “Description” ve 
“Undo” seçenekleri ortaya çıkar. Kısaca açıklayacak olursak; 
 

 Allow Docking: Buradaki seçeneğin seçili olması halinde Properties penceresi sağ 
ve sol kenarlara aynen ‘‘toolbars’’ lar (araç çubukları) gibi sabitlenebileceği 
anlamına gelir. 
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 Hide : Seçeneğin seçili olması halinde Properties 
penceresinin kapatılmasını sağlar. 

 Description:Modunun açık olması Properties 
penceresinin altındaki açıklama kısmının olmasını 
sağlar. 

 Undo: Modunun açık olması Properties 
penceresinde yapılan değişikliklerin adım adım geri alınmasına olanak sağlar. 
Properties penceresinde seçili olan nesne veya nesnelerin değişiklikleri 

(değiştirilebilen özellikleri) aynı anda ekranda da görülebilir, istediğiniz gibi olmayan 
değişiklikleri geri alabilirsiniz.  
 

        
Resim 73: PROPERTİES penceresi kullanılarak çemberin özelliklerinin görülerek 

değiştirilmesi 
 
Yukarıdaki şekillerde görüldüğü gibi üstteki çemberin bir kaç özelliği değiştirilmiştir. 

Bunlar; x ve y koordinatları, çapı, yarıçapı, dolayısıyla alanı ve çevresi, çizgi kalınlığı ve 
renkleridir. 

Unutulmaması gereken bir konu da Properties penceresinde her nesnenin kendi 
özelliklerine uygun menü çıkmasıdır. Yukarıda da görüldüğü gibi çember için açılan 
menüler ile herhangi bir çizgi için açılan menüler aynı olmayacaktır. 
 
1.6.3. Match Properties (Nesne Özelliklerini Eşleme) 
 

Bir nesnede bulunan özelliklerin ( Renk, Çizgi kalınlığı, Katman, Çizgi tipi vb.) 
özellikleri başka bir nesneye bir defada aktarmak için kullanılan bir komuttur. 
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 Adres 

• Ekran Menüsü: MODIFY 1 > Matchprp 
• Kayar Menü: Modify > Match Properties 
• Komut Satırı: MATCHPROPERTIES (MA) 

 
Çalışmalarımız esnasında bazı nesnelerin özelliklerini çalışma alanımızda bulunan bir 

nesneden almasını isteyebiliriz. Hatta hangi özelliklerin alınıp seçilen nesnelere 
aktarılacağını ayarlamakta elimizdedir. Komut yukarıdaki yöntemlerden herhangi biri ile 
çalıştırıldığında ‘‘Mouse’’ un ekrandaki görüntüsü pickbox kutucuğu (  ) halini alır. 
Özellikleri aktarılacak nesne seçildikten sonra bu defa ‘‘Mouse’’ un ekrandaki görüntüsü ( 

 ) haline gelir ve aynı özelliği almasını istediğimiz nesne veya nesnelere tıklayarak 
özellikleri aktarabiliriz. 

 
Komut seçildikten sonra komut satırında aşağıdaki iletiler sırasıyla gelecektir. 
Command: '_matchprop 
Select source object: (özelliklerin alınacağı kaynak objeyi seçiniz) 
Current active settings:  Layer Ltype Ltscale Lineweight Thickness Text Dim Hatch 

(diğer nesneye aktarılabilecek özellikler.) 
 

 Color :Renk 
 Layer :Katman 
 Ltype :Çizgi tipi 
 Ltscale  :Çizgi tipi ölçek katsayısı 
 Lineweight :Çizgi kalınlığı 
 Thickness :Kalınlık ~ yükseklik 
 Text :Yazı 
 Dim :Ölçülendirme 
 Hatch :Tarama 

 
Select destination object(s) or [Settings]: iletisi ile kaynak nesneden alınan 

özelliklerin aktarılacağı hedef nesnenin seçilmesini veya [Settings] ile aktarılacak 
özelliklerin ayarlanabilmesi için Property Setting penceresinin açılmasını sağlayabileceğimiz 
ileti, komut satırında görülür. 

 
Yukarıdaki penceredeki özelliklerden yanında “trick” denilen işaretlerin bulunduğu 

özellikler diğer nesneye aktarılır, işaret olmayanlar ise aktarılmazlar. 
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Resim 74 : Match properties komutu kullanılarak özelliklerinin başka nesneye aktarılması 

 
Yukarıda mavi renkli beşgendeki tüm özelliklerin ( Görünenler: Renk, Çizgi Tipi, 

Çizgi Kalınlığı, vb.) kesik kırmızı çizgili çembere aktarılmasını görüyoruz. 
 

Explode (Patlatma – Öğeleri Ayırma) 
 
EXPLODE (PATLATMA) komutu birden fazla çizim öğesinin bir araya 

getirilmesiyle oluşan çizim öğelerini ayrıştırır. 
 
PLINE (Birleşik Çizgi) POLYGON (Çokgen) DIMENSION (Ölçülendirme) 

HATCH(Tarama) ve BLOCK (Bloklama) komutlarıyla yapılan işlemlerde kullanılan çizim 
öğeleri tek bir çizim öğesi durumundadır. “Select objects” işleminde bütün öğeler birlikte 
seçilir. 

 
 Adres 

• Ekran Menüsü :MODIFY 2 > Explode 
• Kayar Menü :Modify > Explode 
• Komut Satırı :EXPLODE (X) 

 
Bazı AutoCAD nesneleri farklı elemanlardan oluşur ve bu elemanlar ortak hareket 

ederler. Yani elemanlardan birinin seçilmesi bütün nesnenin seçilmesine sebep olur. Bu 
nesnenin teker teker elemanlara ayrılmasını istediğimizde yani grubun dağıtılmasını 
istediğimizde EXPLODE komutunu kullanmamız gerekecektir. 

 
Eğer bu çizim öğelerinden herhangi birisi üzerinde düzenleme işlemi yapılmak 

istenilirse, bu öğe grubu EXPLODE komutuyla ayrıştırılmalıdır. Bir blokta yer alan öğeler 
farklı katmanlardan (Layer) oluşturulmuşsa, EXPLODE komutu uygulandığında blokta yer 
alan her öğe ait olduğu katmanda yerini alacaktır. Ayrıca bu komutla parçalanan öğeler ( 
örneğin, DIMENSION (Ölçülendirme) eski özelliklerini kaybeder sadece alelade 
çizgilerden ibaret hale gelirler. Başka bir örnek vermek gerekirse PLINE (Birleşik Çizgi) ile 
çizilmiş içerisinde yay ve doğru parçalarından oluşan bir nesne tek bir nesne gibi kabul 
görür. Ancak EXPLODE komutu uygulandığında nesne çizgi ve yayların ayrı ayrı kabul 
edildiği öğeler olarak değerlendirilir. 
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Resim 75 : EXPLODE komutu kullanılarak birleşik öğelerin parçalanması. 

 
Yukarıdaki şekillerde sağ taraftaki şekil PLINE (Birleşik Çizgi) ile çizilmiş içerisinde 

iki yay (Arc) ve dört doğru parçasından oluşan nesne tek bir öğe olarak kabul edilir. 
Parçalardan herhangi birini seçmek diğerlerini de seçmek anlamına gelir. Ancak EXPLODE 
komutu uygulandığında nesne iki yay ve dört doğru parçasından oluşan, her bir kendi 
özelliklerini taşıyan birleşik bir nesne halini alır. Aynı şekilde mavi renkli çizilmiş beşgen 
POLYGON komutu ile çizilmiş bir nesnedir. Birleşik hareket ederler. Silmek veya 
kopyalamak gibi işlemlerde tamamı silinir veya kopyalanır. EXPLODE komutu 
uygulandığında şekil beş ayrı doğru parçasından oluşan birleşik bir şekil halini alır. 

 
Aşağıda hazırlanan değerlendirme ölçeğine göre kendinizin ya da arkadaşınızın 

yaptığı çalışmayı değerlendiriniz. Gerçekleşme düzeyine göre evet hayır seçeneklerinden 
uygun olanı kutucuğa işaretleyiniz.  
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DEĞERLENDİRME ÖLÇEĞİ 
 

 
Değerlendirme Ölçeği 

Dersin Adı Bilgisayarla Mimarî ve Statik Proje Çizimi 
Amaç Nesneyi kuralın uygun seip düzeltebilmek. 
Konu Nesneleri seçme 

Değerlendirme Kriterleri Evet Hayır 

1 Kullanacağınız AutoCAD programını sorunsuz bir şekilde açtınız 
mı?   

2 Düzenleme yapmak istediğiniz nesne veya nesneleri öncelikle 
seçmeniz gerektiğini biliyor musunuz?   

3 Programı kullanırken program penceresinin altındaki komut 
satırındaki uyarı ve iletileri okuyor musunuz?   

4 
Seçeceğiniz nesne basit birkaç çizgiden oluşan bir nesne mi? 
Yoksa birçok çizgiden meydana gelen karmaşık bir şekil mi? Bunu 
belirlediniz mi? 

  

5 
Bir düzenleme komutunu bir nesneye uygulamak için; öncelikle 
komutu başlatmak, daha sonra da nesneyi seçmek gerektiğinin 
daha doğru olduğunu tespit ettiniz mi? 

  

6 Nesneleri seçerken ‘‘Mouse’’un ekrandaki görüntüsü Pickbox adı 
verilen seçme kutusu haline geldi mi?   

7 Seçtiğiniz nesnelerin belirli olabilmesi için program tarafından 
kesik çizgilerle gösterildi mi?   

8 
Çerçeve çizerek seçim yaparken; seçme işlemine soldan sağa 
doğru yapmakla, sağdan sola doğru yapmanın farkını 
belirleyebildiniz mi? 

  

9 Seçme işlemi sırasında yanlışlıkla seçtiğiniz nesneleri Remove  
(R) komutunu kullanarak seçili hale gelmekten kurtardınız mı?   

10 
Seçme işleminiz bitince, uygulamak istediğiniz komutun devam 
edebilmesi için klavye ile ‘‘ENTER’’ ya da ‘‘Mouse’’un sağ 
tuşunu kullandınız mı? 

  

 
 

İşaretleme sonucunda eksik olduğunuzu tespit ettiğiniz konuları tekrar ederek 
eksikliklerinizi tamamlayınız. 

DEĞERLENDİRME ÖLÇEĞİ
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ÖLÇME VE DEĞERLENDİRME 
 
 
Bu faaliyet kapsamında hangi bilgileri kazandığınızı aşağıdaki cümleleri doğru veya 

yanlış olarak değerlendirerek belirleyiniz. 
 

Ölçme Soruları (Doğru-Yanlış) 
1.  (   ) Düzenleme yapacağımız nesneleri öncelikle kurallarına uygun biçimde seçmeliyiz. 
2. (   ) Düzenleme yapacağımız nesneleri oluşturan çizgileri teker teker seçmemiz gerekir. 
3. (   ) Çoklu seçme işlemini ancak Mouse ile yapabiliriz. 
4. (   ) Seçme işlemimiz bittiğinde program tarafından kaç tane nesneyi seçtiğimiz bize 

bildirilir.  
5. (   ) Nesneleri seçerken veya düzenlerken komut satırında iletilen uyarı ve bilgileri 

mutlaka okuyup ona göre işlemlere devam etmeliyiz. 
6. (   ) Seçilen nesnelerin renkleri seçili olduğunun anlaşılması için değişir, farklı bir renkle 

gösterilir. 
7. (   ) “Window” ve “Crossing” denilen çoklu seçimlerde seçme işlemine alttan, üstten 

veya sağdan soldan nereden başladığımızın pek de önemi yoktur. 
8. (   ) Birden fazla nesneyi seçerken yanlışlıkla seçtiğimiz nesneleri bu durumdan 

kurtarmak için Previous (P) komutunu kullanabiliriz. 
9. (   ) Nesnelerin özelliklerini değiştirirken kolaylık olması açısında onları 

gruplandırabiliriz. 
10. (   ) GROUP komutuna, ekranın en altında bulunan komut satırına GROUP yazarak 

veya screen menü adı verilen Kayar Menüden Tools komutu altında Group seçeneği 
işaretlenerek ulaşılabilir. 

11. (   ) Redraw ve Redrawall komutları ekran temizleme komutlarıdır. 
12. (   ) Ekranı temizlemek demek, ekranda hiçbir şeyin kalmadan temizlenmesi demektir.  
13. (   ) Redraw sadece aktif pencereyi, Redrawall ise bütün görüntü pencerelerini 

temizlemek için kullanılan komutlardır. 
14. (   ) REGEN ve REGENALL komutları özellikle dairesel çizim öğelerinin hem ekranda, 

hem de kâğıt üzerindeki çıktılarda daha düzgün gözükmesi için kullanılan bir 
komuttur. 

15. (   ) Geometrik düzenleme araç çubuğunun AutoCAD programındaki ismi “Modify Araç 
Çubuğu” dur. 

16. (   ) Eğer bir çizim öğesinin tamamını silmek istiyorsak Erase komutunu, bir kısmını 
silmek istiyorsak Trim veya Break komutu kullanırız. 

17. (   ) Yanlışlıkla sildiğimiz öğeleri ancak UNDO (Geri Al) komutunu kullanarak geri 
getirebiliriz. 

18.  (   ) COPY komutu seçilen çizim öğelerinin bir veya birden fazla kopyasını çizim 
ekranında belirlenen herhangi bir noktada oluşturur. 

19. (   ) Move Komutu ile Copy komutu arasında hiçbir benzerlik yoktur.  
20. (   ) Move Komutunda nesnelerin koordinatları değişirken, doğrultuları da değişir. 
21. (   ) MIRROR komutu seçilen çizim öğelerini tanımlanacak bir simetri eksenine göre 

simetrisini oluşturur. 
22. (   ) Rotate (Döndür) komutunda nesneler ancak klavyeden girilen açı değerleri kadar 

döndürülebilir. 

ÖLÇME VE DEĞERLENDİRME
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23. (   ) TRIM (Budama) işleminin gerçekleşebilmesi için atılacak kısımların mutlaka bir 
çizgiyle sınırlandırılmış olması gereklidir. 

24. (   ) OFFSET komutunda da hemen hemen bütün diğer komutlardaki gibi pencere içine 
alarak seçme işlemi yapılabilir. 

25. (   ) EXTEND (Uzatma) komutu ile uzatılan çizgiler, uzadığı çizginin renk, çizgi 
kalınlığı vb. özelliklerini alırlar. 

26. (   ) Hem FILLET, hem de CHAMFER komutunda gerekli ayarları yaparak dik köşe 
birleşmeleri oluşturmamız mümkündür. 

27. (   ) SCALE (Ölçekleme) komutu çizim öğelerini istenilen oranda büyütme veya 
küçültmede kullanılır. 

28. (   ) SCALE (Ölçekleme) komutunda 2, 3, veya 0,5  gibi rakamsal değerler girerek 
nesneyi büyültüp küçültebileceğimiz gibi nesne üzerindeki herhangi bir uzunluğu 
referans alıp o uzunluğu istediğimiz rakamsal değere kadar da, büyültüp 
küçültebiliriz. 

29. (   ) STRETCH (Sündürme) komutu sadece çizgileri değil seçilen bir nesnenin bir 
kısmını diğer parçalarıyla bağlantılarını koruyarak taşımamıza da olanak verir. 

30. (   ) ARRAY (Sıralı Çoğaltma) komutu kendi içinde RECTANGULAR (Doğrusal), 
POLAR (Açısal) ve VERTICAL (Dikey) olmak üzere üç ayrı bölüme ayrılır. 

31. (   ) BREAK (Kırmak) komutu; Bir çizim öğesini iki parçaya ayırır veya bu öğenin bir 
kısmını siler. 

32. (   ) PEDIT (Çizgi Özelliklerinin Düzenlenmesi) komutu bütün çizgilerde kullanılabilir. 
33. (   ) Çizimin herhangi bir aşamasında UNDO ve REDO (ileri ve geri alma) komutları 

dilediğimiz kadar ileri veya geri gitmemize olanak sağlar. 
34. (   ) BLIPS komutu ile ekranda görülen noktalar istenilirse başka noktalara 

kopyalanabilir veya DELETE – ERASE komutları ile silinebilir. 
35. (   ) ORTHO modu açıkken (ON konumundayken) kesinlikle eğik çizgi çizemeyiz. 
36. (   ) SNAP (KENETLENME) komutu ‘‘Cursor’’ün (imlecin) hareketlerinin belirlenen 

aralık ve açıda olmasını kontrol eder. Bu aralık ve açılar istenildiği gibi program 
kullanıcısı tarafından değiştirilebilir. 

37. (   ) GRID (Izgara) komutu ekranda, noktaların meydana getirdiği bir ızgara 
oluşturulmasını sağlar. Bu ızgaralar yapmış olduğumuz çizimin bir parçası değildir. 
Ancak istenilirse Printer çıktılarında görünebilirler. 

38. (   ) Çizmiş olduğumuz öğelerin Renk, Katman, Çizgi Tipi, Çizgi Kalınlığı vb. gibi 
özellikleri daha sonra farklı komutlar kullanarak değiştirebiliriz. 

39. (   ) CHANGE komutu kullanılarak bir yazı (TEXT) seçildiğinde Programın change point 
ile istediği noktayı ekranda tıklayarak belirlediğimizde yazımız tıkladığımız yeni 
nokta ile ilk konumu arasındaki mesafe kadar büyüyecek veya küçülecektir. 

40. (   ) MATCHPROPERTIES komutu ile bir diğer nesneye aktarılacak özellikler istenilirse 
sınırlandırılabilir. 

 
 
DEĞERLENDİRME  

Cevaplarınızı cevap anahtarı ile karşılaştırınız ve doğru cevap sayınızı belirleyerek 
kendinizi değerlendiriniz. Değerlendirme sonucunda yanlış cevaplarınızı faaliyete dönerek 
tekrarlayınız.  

Cevaplarınızın çoğunluğu doğru ise diğer öğrenme faaliyetine geçiniz. 
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ÖĞRENME FAALİYETİ-2 
 

 
Gerekli ortam sağlandığında bilgisayarla ölçülendirmeyi kuralına uygun 

yapabileceksiniz.  
 
 

 
Kendi meslek grubunuzun ölçülendirme kurallarını gözden geçiriniz. Kâğıt ve kalemle 

ölçülendirme yaparken nelere dikkat ettiğinizi hatırlayınız. Bilgisayarla çizmiş olduğunuz 
çizimleri ölçülendirirken uymanız gereken incelikleri kitaplardan ve ders öğretmeninizden 
öğrenerek arkadaşlarınızla paylaşınız. 

 
2. ÖLÇÜLENDİRME 

 
2.1. Ölçülendirme Komutları 

 
Dimension komutları AutoCAD ile yapılan çizimlerimizi ölçülendirmemizi sağlar.  
 
Daha sonra teferruatlı bir şekilde anlatılacak olan ölçülendirme komutları aşağıda 

programdaki araç çubuğu, İngilizce isimleri ve Türkçe karşılıkları verilmiştir. 

 
Resim 76 : Dimension (ölçülendirme) araç çubuğu 

ÖĞRENME FAALİYETİ-2 

AMAÇ 

ARAŞTIRMA 
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Ölçülendirme konusunda her meslek alanının kendine göre standart bir kabulü vardır. 

Kullanılacak standarda göre ölçülendirme elemanlarının seçimi ve ayarları DimStyle 
komutuyla yapılmalı, daha sonra ölçülendire işlemine başlanılmalıdır. 
 
2.2. Ölçü Biçimi Oluşturma 

 
AutoCAD programında gerçekleştirilen çizimlerin hemen hemen hepsinde çizilen 

grafik elemanların ölçülendirilmesi gerekir. AutoCAD de ölçüleri ölçülendirme komutları 
aracılığı ile oluşturabilirsiniz. Ölçülerin görünüşleri ölçülendirme sistem değişkenleri ile 
kontrol edilir. 

 
Ölçülendirme sonucunda tüm yazı, çizgi, ok gibi elemanların hepsi bir bütündür. Yani 

bir bloktur. Bu yazı ok çizgi gibi elemanlardan oluşan ölçülendirme elemanları içerisinde 
herhangi bir öğeye tek başına ulaşmak isterseniz EXPLODE komutu ile patlatmanız-
dağıtmanız gerekir. Ancak böyle bir işlem komutla ilgili olan bütün özelliklerin kaybolup 
herhangi bir çizim öğesi haline getireceğinden dolayı tavsiye edilmemektedir. 

 
Ölçülendirme komutları diğer birçok komuttan daha komplikedir. Yani karmaşık ve 

birleşik komutlardan oluşur. Bir ölçülendirme öğesi grup halinde davranan elemanlardan 
oluşur. Bütün bunların ayrı ayrı düzenlenmesi gerekecektir. Şimdi ölçülendirme elemanlarını 
tanıyacak olursak; 
 

 
Resim 77 : Ölçülendirme elemanlarının tanıtılması 

 
Unutulmaması gereken konulardan biri de her meslek grubu ölçülendirme ayarlarını 

farklı olarak yapmaktadır. Bu sebeple AutoCAD kullanıcıları hangi meslek grubundaysa 
uygulayacağı ölçülendirme biçimini buna göre ayarlamalıdır. 
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Ölçü öğelerini etkileten sistem değişkenlerinin ayarlanıp bir isim altında 
toplanmasıyla bir ölçü biçimi stili oluşturulur. İstenilen sayıda ölçü biçimi oluşturmak 
mümkündür. DDIM veya DIMSTYLE komutları komut satırına yazılarak veya ölçülendirme 
araç çubuğundaki  simgesi tıklanarak “Dimension Style Manager” diyalog kutusu ile 
yeni ölçü biçimleri oluşturmak veya mevcut ölçü biçimlerinin parametrelerini değiştirmek 
gibi işlemler yapılabilir. 
 

 
Resim 78 : “Dimension style manager” menüsü 

 
Bu diyalog kutusunun elemanları aşağıda açıklanmaya çalışılmıştır. 
 

 Styles 
Bu bölümde dosyada bulunan ölçü sitilleri listelenir. Eğer daha önce sizin hazırlamış 

olduğunuz bir ölçülendirme stili var ise o da bu listede bulunacaktır. 
Üzerini Mouse ile tıkladığınızda o stile ait ayarlar gelecektir. Ayrıca listede 
bulunan isimlerden herhangi birinin üzerine sağ tıklandığında ekrana “Set 
current, Rename, Delete” seçeneklerinin bulunduğu bir kısayol menüsü 
açılacaktır. Bunlardan Set current elemanı seçilen biçimin güncel yapılmasını, Rename 
elemanı seçilen stilin isminin değiştirilmesini, Delete ise silinmesine olanak sağlar. 

 
 List 

Bu bölümde All Styles ve Style in Use elemanları bulunur. All Styles seçimi Styles 
bölümündeki bütün sitillerin görüntülenmesini, Style in Use seçimi ise Styles bölümünde 
sadece stillerin görüntülenmesi anlamına gelir. 

 
 Don’t list styles in Xrefs 

Bu onay kutusunun işaretlenmesi ile referans dosyalarındaki ölçü stillerinin Styles 
bölümünde görüntülenmemesi sağlanır. İşaretlenmemesi durumunda ise tersi olacaktır. 

 
 Preview of 

Styles bölümünden seçilen veya farklı düzenlemeleri (Modify) yapılan ölçülendirme 
stillerinin bir grafik temsilinin yapıldığı alandır. 
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 Description 
Güncel stil ile Styles bölümünde seçilen stil arasındaki farklılıkların gösterildiği 

bölümdür. 
 

 Set Current 
Styles bölümünde işaretlenen ölçü stilinin güncel yapılması için bu düğme kullanılır. 

Artık oluşturulacak ölçü öğeleri güncel stildeki parametreleri dikkate alacaktır. 
 

 New 
Bu düğme işaretlendiğinde “Create New Dimension Style” diyalog kutusu gelir. Bu 

diyalog kutusu ile yeni ölçü stilleri oluşturulur. 
 

 Modify 
Styles listesinde seçilen bir ölçü stilinin parametrelerinde değişiklik yapmak için bu 

düğme işaretlenir. Bu düğme işaretlendiğinde “Modify Dimension Style” diyalog kutusu 
gelir. 

 
 Override  

Styles listesinden güncel stil seçilmemişse, bu düğme kullanılamaz. Yeni 
oluşturulacak ölçü öğelerinin parametrelerini bazıları hariç güncel stildeki parametrelerden 
almasını istiyorsak ya yeni stil oluştururuz, ya da bu düğme ile Styles bölümünde style 
overrides oluştururuz. Bu düğme kullanılırsa yeni bir ölçü stili oluşturulmamış, dolayısıyla 
dosyamızın büyüklüğü çok daha az artırılmış olur 

 
 Compare 

Bu düğme işaretlendiğinde Compare Dimension Style diyalog kutusu gelir ve iki stil 
arasında karşılaştırma yapılabilir. Bu diyalog kutusu ile bir ölçü biçiminin parametrelerinin 
değerleri de öğrenilir. Compare ve With listelerinde dosyamızda bulunan ölçü stilleri vardır. 
Bu listelerden herhangi ikisi seçilerek diyalog kutusunun alt bölümündeki boşlukta iki stil 
arasındaki farklılıklar görülebilir. 

 

 
Resim 79 : “Compare dimension style manager” menüsü 

 
2.2.1. Yeni Bir Ölçü Biçimi Oluşturmak 
 

“Dimension Style Manager” diyalog kutusundaki “New” düğmesi ile yeni bir ölçü 
biçimi oluşturabileceğimizi öğrenmiştik. AutoCAD programında default değer olarak 
bulunan ölçülendirme stillerindeki (Örn: İso-25 v.b.) değerlerin, biçimlerin bazılarını veya 
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tamamını kendi kullanacağımız ölçülendirme biçimine uygun hale getirmek için 
değiştirmemiz gerekecektir. “New” düğmesi tıklanıldığında ekrana yandaki “Create New 
Dimension Style” diyalog kutusu açılacaktır. Buradaki değişkenleri kısaca açıklayacak 
olursak; 

 

   
Resim 80 : “Create new dimension style” menüsü 

 
 New Style Name 

Bu haneye yeni oluşturmak istediğimiz ölçülendirme biçiminin ismi girilir. Çizim 
dosyanızın adı veya kullandığınız ölçülendirme biçiminin mimari, metal işleri, ağaç işleri vb. 
gibi isim verebilirsiniz. 

 
 Start With 

Bu liste açıldığında dosyamızda tanımlı bulunan ölçü stillerinin isimleri görünür. 
Bunlardan birisi seçildiğinde seçilen ölçülendirme biçiminin değerleri bizim yeni oluşturmak 
istediğimiz ölçü biçiminin başlangıç değerleri olacaktır. 

 
 Use For 

Bu listede başta All Dimension (Tüm ölçülendirme biçimleri) olmak üzere Doğrusal, 
Açısal, Yarıçap, Çap, Koordinat ve Tolerans ölçülendirme elemanları bulunur. Yeni 
oluşturduğumuz ölçülendirme biçiminin bütün ölçülendirme biçimlerini de kapsamasını 
istiyorsak All Dimension seçeneğini işaretlememiz gerekir. Ancak yapmış olduğumuz 
değişiklikler sadece doğrusal veya açısal ölçülendirmeleri kapsamasını istiyorsak bu defa 
Linear Dimension veya Angular Dimension seçeneklerini işaretlememiz gerekecektir. All 
Dimension seçeneğinin dışında yeni oluşturulacak ölçülendirme biçiminin hangi tip ölçü 
öğelerine yansımasını istiyorsak bu listeden seçebiliriz. 
 
2.3. Ölçü Biçimi Hassas Ayarları 
 

Ölçü biçimi oluşturma konusunda anlatıldığı gibi yeni bir ölçülendirme biçimi 
oluşturmak için. DDIM, DIMSTYLE veya  simgesi tıklanarak açılan  
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Resim 81: “DIMSTYLE ve NEW DIMSTYLE menüleri” 

 
“Dimensiom Style Manager” diyalog kutusundaki “NEW” düğmesi ile yeni bir 

ölçülendirme biçimi oluşturmak istediğimizi programa iletiriz. Açılan “Create New 
Dimension Style” diyalog kutusundaki gerekli boşlukları doldurup “Continue” düğmesi 
tıklandığında; ekrana aşağıdaki New Dimension Style: CAHİT diyalog kutusu gelir. 
 

 
Resim 82 : Yeni Oluşturulan “DIMSTYLE” menüsü. 

 
Daha önce de söylenildiği gibi açılan ekrandaki ölçülendirme ayarları AutoCAD 

programının default ayarları başlangıç kabul edilir. Ekranda görünen temsili ölçülendirme 
şekli o ayarlara ait görüntülerdir. Daha sonra kullanıcı tarafından [Lines and Arrows], 
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[Text], [Fit], [Primary Units], [Alternate Units], [Tolerances] sekmelerinde (sayfaları) 
bulunan değerler değiştirilebilir. Değiştirilen seçenekler aynı zamanda pencere üzerindeki 
temsili ölçülendirme şekli görülebilir. 
 
2.3.1. Çizgiler ve Oklar (Lines and Arrows) 
 

 
Resim 83 : Yeni oluşturulan “DIMSTYLE” menüsünde. “lines and arrows” bölümü. 

 
Dört bölümden oluşan bu sayfada ölçü çizgileri, uzantı çizgileri, oklar ve merkez 

işareti ayarları yapılır. 
 

 “Dimension Lines” bölümü: 
 
Bu bölümde ölçü çizgisi ile ilgili ayarlar yapılır. 
 

• Color: Bu listeden seçilecek olan renk ölçü çizgilerinin rengini tespit eder. 
• Line weight: Ölçü çizgilerinin çizgi kalınlığının belirlenmesini sağlar.  
• Extend beyond ticks: Ölçülendirme sınır işareti olarak ok değil de 

‘Architectural tick’ ‘Oblique’ ‘İntegral’ veya ‘None’ kullanılırsa bu sayısal 
girdi hanesi kullanılabilir olur. Bunların dışında aktif değildir. Buraya girilen 
rakamsal değer ölçü çizgisinin uzantı çizgilerini taşma miktarıdır. 

 
• Baseline spacing: Buraya girilen değer oluşturulan ölçü öğelerindeki ölçü 

çizgileri aralarındaki mesafeyi ayarlar. 
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Resim 84 : “Baseline spacing” (ölçü çizgileri. arasındaki mesafenin) gösterilmesi 
 

• Suppress: Buradaki ‘Dim Line 1’ ve ‘Dim Line 2’ onay kutuları ile birinci 
veya ikinci uzantı çizgilerinin görünür veya görünmez olması ayarlanır. 
Örneğin ‘Dim Line 1’ onay kutusu işaretli ise birinci ölçü çizgisi 
görünmez.  

 
Resim 85 : “Dim line” komutunun on veya off olması durumları. 

 
Şekil üzerindeki yazıların ON olması demek açılan penceredeki ‘Dim Line 1’ ve ‘Dim 

Line 2’ onay kutularının dolu olması demektir. OFF olması ise boş olması anlamındadır. 
 

 “Extension Lines” bölümü: 
 
Bu bölümde uzantı çizgileri ile ilgili ayarlar yapılır. 

 
• Color: Bu listeden seçilecek olan renk uzantı çizgilerinin rengini tespit eder. 
• Line weight: Uzantı çizgilerinin çizgi kalınlığının belirlenmesini sağlar.  
• Extend beyond dim lines: Buraya girilen sayısal değer uzantı çizgilerinin 

ölçü çizgisini geçme miktarını belirler. 
• Offset from origin: Buraya girilen sayısal değer uzantı çizgilerinin 

başlangıç noktasından ne kadar uzakta çizilmeye başlanacağını ayarlar.  
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Resim 86 : Ölçülendirme .uzantı çizgilerinin mesafesi ve nesneye olan uzaklıklarının 

gösterilmesi 
 

• Suppress: ‘Ext Line 1’ ve ‘Ext Line 2’ onay kutuları ile birinci ve ikinci 
uzantı çizgilerinin görünürlük ayarlamaları yapılır. Örneğin ‘Ext Line 1’ 
onay kutusu işaretlenirse birinci uzantı çizgisi görünmez. 

 

 
Resim 87 : “Ext Line” Komutunun ON veya OFF olması Durumları 

 
 “Arrowheads” bölümü: 

 
Bu bölümde kullanılan sınır çizgisi işaretlerinin (okların) biçimi ve büyüklüğü 

ayarlanır. 
 

• 1st 
Bu listeden ok veya ok yerine kullanılacak sembol belirlenir. Bu listeden seçilen 

sembol, “2nd” listesine de yansır. Listeden herhangi bir sembol seçilebilir veya en alttaki 
“User Arrow” seçeneği seçilirse ekrana yeni bir diyalog kutusu açılır ve bizden herhangi bir 
çizim dosyamızdan mevcut bir blok seçilerek ok sembolü yerine kullanılabilmesini sağlar. 

 
• 2nd 

Bu listeden ikinci uzantı çizgisi üzerindeki ok yerine kullanılacak sembol seçilir. Bu 
listeden seçilen sembol “1st” listesine yansımaz. (Genellikle hemen hemen bütün meslek 
dallarında ölçülendirme sınır işaretleri (Arrowheads) her ikisi de aynı olur. Ancak listede 
olan sembollerden beğenilen olmazsa yine User Arrow seçeneği işaretlenerek istenilen blok 
kullanılır. 
 

• Leader 
Bu listeden de Leader (açıklayıcı bilgi) komutu tarafından kullanılacak olan sembol 

belirtilir. 
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• Arrow size 
Bu haneye girilen rakamsal değer ok ( veya sizin belirleyeceğiniz diğer sembollerin) 

büyüklüklerini ayarlar. 
 

 “Centre Marks for Circles” bölümü: 
 
Bu bölümde DIMCENTRE komutu ile oluşturulan merkez işareti ve merkez çizgisi ile 

ilgili ayarlar yapılır. Type ve Size olmak üzere iki bölümden oluşur. 
 

• Type 
Listede ‘None’, ‘Mark’ ve ‘Line’ seçenekleri vardır. 

• None 
Çember ve yayların merkezine işaret veya çizgi konulmayacağını, 

• Mark 
Çember ve yayların merkezlerine merkez işareti konulacağını, 

• Line 
Merkez çizgisi oluşturulacağını belirtir. 
DIMCENTRE komutu bu ayarlardan etkilenir. 

• Size 
Buraya girilen rakamsal değer ölçü çizgisi veya işareti ile ilgili boyutları ayarlar. 
 

2.3.2. Ölçü Metni (Text) 
 
“New Dimension Style” diyalog kutusunun TEXT sekmesi işaretlendiğinde karşımıza 

alttaki sayfa açılır. Bu sayfadaki değişkenler üç ana bölümden meydana gelir. Genel olarak 
ölçü yazısının teknik özellikleri ayarlanır. Sağ üstteki grafik çizimden de yapılan 
değişiklikler, diğer yapılmış olan değişikliklerle birlikte izlenebilir. 
 

 
Resim 88 : NEW DIMENSİON STYLE menüsü içinde text sekmesi. 

 
 “Text Appearance” bölümü 

Ölçü yazısının biçim ve boyut ayarlarının yapıldığı bölümdür. Beş bölümden oluşur. 
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• Text Style 
Bu listeden dosyamızdaki mevcut yazı stillerine ulaşılabilir. Bunlardan birisi 

seçildiğinde ölçü öğelerinin yazı stili belirlenmiş olur. Yeni bir yazı stili oluşturulmak 

istenilirse  düğmesi tıklanarak bu gerçekleşebilir. Bilgisayarımızda bulunan herhangi bir 
yazı fontunu Text Style olarak belirleyebiliriz. 

• Text Color 
Renk belirleme listesidir. Belirlenen renk ölçülendirme yazılarının tamamında etkili 

olacaktır. 
• Text Height 

Bu kutucuğa girilen rakamsal değer ölçülendirme yazılarının (rakamlarının) 
yüksekliğini belirler. 

• Fraction Height Scale 
 

Bu haneye girilen sayısal değer kesirli veya 
toleranslı gösterime müsaade edilmişse kesirli 
kısımdaki yazının yüksekliğini belirler. 

 
• Draw Frame Around Text 

Bu onay kutusu işaretlenmişse bütün ölçü yazıları çerçeve içerisine yazılacaktır 
anlamına gelir. 

 
 “Text Placement” bölümü: 

Bu bölüm ölçü yazısının yeri için gerekli ayarların yapıldığı, üç ayrı bölümden oluşan 
kısımdır. 

• Vertical: Bu listede Centered, Above, Outside ve JIS seçenekleri bulunur. 
Yazının dikey konumunu düzenlemek için ayarlar yapılır. 

 
o Centered: Yazı ölçü çizgisi içine yerleştirilir. 
o Above: Yazı ölçü çizgisi üzerine yerleşir. 
o Outside: Yazı ölçülendirme başlangıç noktalarından en uzağa yerleşir 
o JIS: Yazı Japon endüstri standartlarına göre yerleştirilir. 

 

 
Resim 89 : Ölçülendirme yazılarının dikey konumda farklı yazılışları. 

 



 

 77

• Horizontal: Listede bulunan beş seçenek ile ölçü yazısının yataydaki 
konumu ayarlanır. Aşağıdaki şekilde farklı seçimlerin sonuçları 
görülmektedir. 

 

 
Resim 90 : Ölçülendirme yazılarının yatay konumda farklı yazılışları. 

 
 “Offset From Dim Line ” bölümü: 

Bu haneye girilen sayısal değer ölçü yazısı ile ölçü çizgisi arasındaki mesafeyi ayarlar. 
Yazı ölçü çizgisinin içindeyse ölçü çizgisinin minimum uzunluğu buradaki değer olunca 
uzantı çizgileri dışına çıkılır. 

 
Resim 91 : Ölçülendirme yazılarının ölçülendirme çizgisine olan mesafeleri 

 
 “Offset From Dim Line ” bölümü: 

Bu bölümde ölçü yazısı ile ölçü çizgisinin doğrultu bakımından ilişkisinin nasıl 
olacağı ayarlanır. Horizontal, Aligned with Dimension line ve ISO standart olmak üzere 
üç seçenek vardır. Kısaca açıklayacak olursak: 

• Horizontal 
Ölçü yazılarının her durumda yatay yazılmasını sağlar 

• Aligned with Dimension line 
Yazıların ölçü çizgisi doğrultusunda yazılmasını sağlar. 

• ISO standart 
Uzantı çizgileri içindeki yazıların ölçü çizgisi ile aynı doğrultuda, dışındaki yazıların 

ise yatay yazılmasını sağlar. 
 

2.3.3. Ölçüleri Sığdırmak (Fit) 
 
“New Dimension Style” diyalog kutusunun FIT sekmesi işaretlendiğinde karşımıza 

alttaki sayfa açılır. Bu sayfadaki değişkenler dört ana bölümden meydana gelir. Ölçü yazısı, 
oklar ve ölçü çizgisi arasındaki ilişkileri düzenleyen bazı ayarlar yapılır. 
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Resim 92 : NEW DIMENSİON STYLE menüsü içinde fıt sekmesi. 

 
 “Fit Options” bölümü: 

Bu bölümde beş tercih düğmesi ve bir onay kutusu bulunur. Mesafe problemi yoksa 
AutoCAD programı ölçülendirme yaparken okları (veya sembolleri) ve yazıları uzantı 
çizgileri arasına yerleştirir. Fakat ölçülendirme mesafesi ikisinin birden buraya yerleşmesine 
yeterli gelmiyorsa bu seçenekler uygulanır. 

• Either the text 
Yazı veya oklardan hangisi uygunsa uzantı çizgilerinin dışına onun alınacağı 

seçenektir. 
• Arrows 

Böyle bir durumda ilk önce oklar dışarı çıkarılacak demektir. 
• Text 

Böyle bir durumda ilk önce yazılar dışarı çıkarılacak demektir. 
• Both text 

Yazı ve okların birlikte davranmasını sağlar 
• Always keep 

Her zaman yazının uzantı çizgileri arasında kalmasını sağlar. 
• Suppress arrows 

Onay kutusu ile ölçü çizgilerinin uzantı çizgileri dışına çıkması halinde dışarı çıkan 
ölçü çizgisinin çizilip çizilmeyeceği ayarı yapılır. 
 

 “Text Placement” bölümü: 
Bu bölümde üç tercih düğmesi bulunur. Ölçü yazısı, ölçülendirme yapıldıktan sonra 

taşınmak istenildiğinde ölçü çizgisinin davranış ayarları yapılır. 
• Beside the Dimension line 

Bu seçenekte ölçü yazısı veya rakamı yukarı veya aşağıya taşınmak istenildiğinde ölçü 
çizgisi de yazı ile birlikte hareket eder. 

• Over the Dimension line, with a Leader 
Bu seçenekte rakam ve yazılar ölçü çizgisinden bağımsız olarak taşınabilir. Ancak bir 

çizgi ile rakam ve yazıların ait oldukları ölçülendirme çizgisine bağlı kalırlar. 
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• Over the Dimension line, withouth a Leader 
Bu tercihte de rakamlar ve yazılar taşınmak istenildiğinde ölçülendirme çizgisi 

bunlardan bağımsız hareket eder ve olduğu yerde kalır. 
 

 
Resim 93 : DIMEDIT komutu kullanılarak ölçü yazılarının yerlerinin değiştirilmesi 
 

 “Scale for Dimension Features” bölümü: 
Bu bölümde iki tercih düğmesi bulunur. 
• Use overal scale of 

Tercih edildiğinde sayısal girdi hanesi kullanılabilir olur. Buraya girilen değer sayısal 
değere sahip ölçülendirme değişkenlerini o oranda büyültür. Örneğin buraya 1,5 gibi bir 
değer girilirse yazı, ok gibi rakamsal değerlerle büyüklükleri belirlenen öğeler o oranda 
büyür veya küçülür. 

• Scale Dimension 
Bu kutucuk işaretli olursa üstteki DIMSCALE sistem değişkeni 0 (sıfır) olarak kalır. 

 
 “Fine Tuning” bölümü: 

Burada ölçü çizgisi ve yazısının birlikte konumlandırılması ile ilgili ayarlar 
yapılmaktadır. Ölçülendirme yapılırken Mouse ile verilen son nokta ölçü çizgisinin yerini 
belirtmekte ve ölçü yazısının da bunun tam orta yerinde olması sağlanıyor. 

• PlaceText Manually 
Onay kutusu işaretlenirse ölçülendirme yapılırken girilen son nokta, hem ölçü 

çizgisinin yerini hem de ölçü yazısının yerini tespit edebiliriz. Yani bu seçenek işaretli olursa 
yazı ve rakamlar ölçü çizgisinin tam orta yerinde olmak zorunda değildir. 

• Always draw dim line 
Onay kutusu işaretlenmezse oklar, uzantı çizgileri dışında alındığında ölçü çizgisi 

uzantı çizgileri arasında çizilmez. 
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2.3.4. Ölçü Birimi (Primary Units) 
 
“New Dimension Style” diyalog kutusunun Primary Units sekmesi işaretlendiğinde 

karşımıza alttaki sayfa açılır. Bu sayfa iki ana bölümden meydana gelir. Buradaki 
değişkenleri kullanarak ölçülendirme birimine ait bazı ayarlar yapılır.  
 

 
Resim 94 : NEW DIMENSİON STYLE menüsü içinde prımary unıts sekmesi. 

 
 “Linear Dimensions” bölümü: 

Bu bölümde lineer (doğrusal-çizgisel) ölçülendirmelere etkileyecek birim ve 
hassasiyet ayarları yapılır. 
 

• Unit format 
Bu listeden lineer ölçülendirmenin hangi birim sisteminde yapılacağına karar verilir. 

Seçenekler şunlardır: 
o “Scientific”(Bilimsel) 
o “Decimal”(Ondalık Sayılar) 
o “Engineering”(Mühendislik) 
o “Architectural”(Mimari) 
o “Fractional”(Kesirli) 
o “Windows Desktop”( Windows Ayarları) dır. 

Bunlardan birinin seçimi sonunda lineer ölçü değerleri etkilenecektir. 
 

• Precision 
Bu listeden ölçü değerlerinin hassasiyet ayarları yapılır. 
 

• Fraction Format 
“Unit format” listesinden “Architectural” veya “Fractional” seçenekleri seçildiğinde 

bu liste kullanılabilir. Listede şu seçenekler bulunur 
o “Horizontal” (Yatay) 
o “Diagonal” (Çapraz) 
o “Not Stacked” (Ayrık-Toplanmayan) 
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• Decimal Separator 
“Unit format” listesinden “Decimal” seçimi yapıldığında kullanılabilir olur. Ondalık 

ayracı olarak hangi karakterin (Nokta, Virgül, Boşluk) kullanılacağı ayarlanır. 
• Round Off 

Açısal ölçümler hariç ölçüm değerleri buraya girilen değer ve katlarına yuvarlatılır. 
Örneğin bu haneye rakamsal olarak “0,25” değeri girildiğinde “12,42” olan ölçüm sonucu 
“12,50” değerine, “3,18” olan ölçüm sonucu da “3,25” değerine yuvarlatılır. 

• Prefix 
Bu haneye girilen karakter veya karakterler ölçü rakamlarının önüne yerleştirilir. 

Örnek olarak buraya “C.K.” yazılacak olsa ölçüm sonucu çıkan diyelim ki “15” değerini 
artık “C.K.15” olarak yazacaktır. Bunun dışında “Ǿ” gibi bir değer de yazabiliriz, bunun 
sonucunda ölçüm değerini “Ǿ15” olarak yazacaktır. 

• Suffix 
Prefix komutunun tam tersi denilebilir. Burada da ölçümlerin sonuna eklenmek 

istenilen değer (karakter) varsa (Örneğin: mm veya cm gibi ) klavye ile girilir. Ölçüm 
sonucunda “15” değerini “15 mm” veya “15 cm” şeklinde yazacaktır. 

 
 “Measurement Scale” Bölümü: 

Linear Dimensions bölümü içinde tanımlı bulunan bu bölümde ölçüm değeri ile ilgili 
ayarlar yapılır. Seçenekler ve kullanım şekli aşağıdaki gibidir. 
 

• Scale Factor 
Buraya girilecek sayısal değer ölçüm değerini çarpar. Örnek olarak 1/5 ölçeğinde 

çizilen bir resmi 1/1 ölçeğindeki gibi olması istenirse buraya 5 değeri girilmelidir. Ölçülen 
her değer 5 ile çarpılarak ölçü rakamı elde edilir. 

• Apply to layout dimensions only 
Bu onay kutusu işaretlendiğinde Scale Factor hanesinde belirtilen ölçek katsayısı 

sadece kâğıt üzerinde yapılan ölçülendirmelere uygulanacaktır. 
 

 “Zero Suppression” Bölümü: 
Bu bölümde sonucu değiştirmeyecek sıfırların görünüp görünmemesi ile ilgili 

ayarların yapıldığı kısımdır. Seçenekler ve kullanım şekli aşağıdaki gibidir. 
 

• Leading 
Bu onay kutusu işaretlendiğinde ayracın (virgülün) önündeki sıfırların kaldırılması 

sağlanır. Örneğin “0,550” gibi bir değer “,550” olarak görüntülenir. 
• Trailing 

Bu onay kutusu işaretlendiğinde ayracın (virgülün) arkasındaki (sağındaki) sıfırların 
görünmesi engellenir. Örneğin “0,550” gibi bir değer “0,55” olarak görüntülenir. Hem 
Leading hem de Trailing kutuları işaretlenmiş olursa bu defa “0,550” gibi bir değer “,55” 
biçiminde gösterilir. 
 

 “Angular Dimensions” bölümü: 
Bu bölümde açısal ölçülendirmeleri etkileyecek birim ayarları yapılır. Seçenekler ve 

kullanım şekli aşağıdaki gibidir. 
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• Units Format 
Bu listeden açı ölçülerinin hangi birime göre yapılması 

gerektiği ayarlanır. Alt seçenekler şunlardır: 
o Decimal Degrees: Ondalık açı sistemi. 
o Degrees Minutes Seconds: Derece, dakika, saniye 
o Gradians: Grad açı ölçü sistemi 
o Radians: Radyan açı ölçü sistemi. 

• Trailing 
Bu listeden açısal ölçülendirmeler için hassasiyet ayarlaması yapılır. 
 

2.3.5. Alternatif Birimler (Alternate Units) 
 

Bu sayfada anlatılanlarla bir önceki sayfada (Primary Units) anlatılan bilgiler genel 
olarak aynı fakat bu sayfada adından da anlaşılacağı gibi alternatif (ikinci) bir 
ölçülendirmeye de olanak tanınmasıdır. 
 

 
Resim 95 : NEW DIMENSİON STYLE menüsü içinde alternete unıts sekmesi. 

 
Alternate Units sayfası açıldığında normalde bu sayfadaki hiçbir onay kutusu ve değer 

girilebilecek haneler aktif değildir. Ancak alternatif-ikincil bir ölçülendirme yapılmak 
istenilirse ve  kutucuğu işaretlenirse aktif hale gelir. Bu şekilde değişiklik 
yapabiliriz. 

 
Bu sayfa üç ana bölümden meydana gelmektedir. Bunları kısaca açıklayacak olursak; 
 

 “Alternate Units” bölümü. 
Bu bölümde ikincil ölçülendirmelere etkileyecek birim ve hassasiyet ayarları yapılır. 
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• Unit format 
Bu listeden ikincil ölçülendirmelerin hangi birim sisteminde yapılacağına karar verilir. 

Seçenekler şunlardır: 
o “Scientific”(Bilimsel) 
o “Decimal”(Ondalık Sayılar) 
o “Engineering”(Mühendislik) 
o “Architectural”(Mimarî) 
o “Fractional”(Kesirli) 
o “Windows Desktop”( Windows Ayarları) dır. 

• Precision 
Bu listeden ikincil ölçü değerlerinin hassasiyet ayarları yapılır. 

• Multiplier for alt units 
Bu haneye girilecek değer ikincil ölçüm değerinin bulunması için kullanılan dönüşüm 

katsayısıdır. En hassas hane denilebilir. Dünya da en çok kullanılan iki ölçü sisteminden 
birisi metrik sistem, diğeri İngiliz ölçü birimi olan “inç” kullanıldığından bu ikisi arasında 
dönüşümlü kullanılması uygun olur. “1 inç = 2,54 cm” veya “1 inç =25,4 mm” olduğu için 
bu haneye sizin kullandığınız ölçü birimine uygun şekilde “1 / 2,54” veya “1 / 25,4” 
kullanabilirsiniz. Bu değerleri kesirli sayı olarak haneye giremeyeceğimiz için; 

cm cinsinden çalışıyorsak; 1 / 2,54 = 0,393700…  
veya, 
mm cinsinden çalışıyorsak; 1 / 25,4 = 0,0393700… şeklinde yazacağız. 
Unutulmaması gerekenlerden biri de dönüştürme işleminin açısal ölçü değerlerine 

yansımayacağıdır. 
• Round distances to 

Bu haneye girilen değer ikincil ölçülendirme değerinin yuvarlatılmasında kullanılır. 
Kullanımı “Primary Units” sayfasındaki “Round of” hanesinde olduğu gibidir. 

• Prefix 
İkincil ölçülendirme için ön ek kullanılmak istenilirse doldurulan kutucuktur. 

• Suffix 
İkincil ölçülendirme için son ek kullanılmak istenilirse doldurulan kutucuktur. 
Her ikisinin de kullanımı “Primary Units” sayfasındaki “Prefix ve Suffix” hanelerinde 

olduğu gibidir. 
 

 “Zero Suppression” bölümü. 
Bu bölümde sonucu değiştirmeyecek sıfırların görünüp görünmemesi ile ilgili 

ayarların yapıldığı kısımdır. Seçenekler ve kullanım şekli aynen “Primary Units” 
sayfasındaki gibidir. 
 

• Leading 
Bu onay kutusu işaretlendiğinde ayracın (virgülün) önündeki sıfırların kaldırılması 

sağlanır. Örneğin “0,770” gibi bir değer “,770” olarak görüntülenir. 
• Trailing 

Bu onay kutusu işaretlendiğinde ayracın (virgülün) arkasındaki (sağındaki) sıfırların 
görünmesi engellenir. Örneğin “0,880” gibi bir değer “0,88” olarak görüntülenir. 

Hem Leading hem de Trailing kutuları işaretlenmiş olursa bu defa “0,990” gibi bir 
değer “,99” biçiminde gösterilir. 
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  “Placement” bölümü. 
Bu bölümde de ikincil ölçülendirme yazısının nasıl konumlandırılacağının ayarlandığı 

kısımdır. Yani esas ölçülendirmenin önünde, arkasında, altınd gibi ayarlamalar yapılacaktır. 
• After primary value 

Başlangıçta bu hane seçili haldedir. bu ayar birinci ölçülendirmenin ikincil 
ölçülendirmeden önce ve aynı satırda olacağı anlamındadır. 

• Bellow primary value 
Bu hanenin seçili olması ikincil ölçülendirmenin esas ölçülendirmenin altında olacağı 

anlamına gelir. 
 
Yukarıda anlattıklarımız bilgilerden bazıları ile küçük bir örnek verecek olursak; 

aşağıda öncelikle “Alternate Units” sayfasında yapmış olduğumuz değişiklikler ve onun 
neticesinde yapılmış küçük bir ölçülendirme örneği görülmektedir. 

 

 
Resim 96 : ALTERNETE UNITS sekmesi. içinde yapılan değişiklikler 

 

 
Resim 97 : ALTERNETE UNITS sekmesi. içinde yapılan değişikliklerin şekilde gösterilmesi 

 
1.3.6. Ölçü Hata Payı (Tolerances) 

 
Ölçülendirme toleransları ile ilgili ayar ve değişikliklerin yapıldığı sayfadır. Bu sayfa 

iki ana bölümden oluşmaktadır. Bunları şu şekilde açıklayabiliriz. 
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Resim 98 : NEW DIMENSİON STYLE menüsü içinde tolerance sekmesi 

 
 “Tolerance Format” bölümü. 

Bu bölümde yapılan ölçülendirmelere tolerans eklenip eklenilmeyeceği, eğer 
eklenecekse tolerans değerleri yerleşimi ve biçimi ile ilgili ayarlar yapılır. Buradaki 
değişkenler şöyledir; 

• Methot 
Bu listede beş eleman vardır ve toleransın yapılıp yapılmayacağı ve 

yapılacaksa tipi belirlenir. Seçenekler şöyledir: 
o None: Tolerans kullanılmayacağını, 
o Symmetrical: Tolerans verileceği ve alt üst tolerans 

değerlerinin eşit olduğunu, 
o Deviation: Tolerans verileceği ve alt üst tolerans 

değerlerinin farklı olarak verileceğini, 
o Limits: Tolerans değerlerinin ölçüm değerlerine eklenerek elde edilen 

değerlerin altlı üstlü yazılmasını, 
o Basic: Tolerans verilmeyeceğini, ölçü yazısının çerçeve içine alınacağını 

ifade eder. 
• Precision 

Tolerans yazılarının hassasiyetinin ayarlandığı kısımdır. 
• Upper value 

Üst tolerans değerinin girildiği hanedir. 
• Lower value 

Alt tolerans değerinin girildiği hanedir. 
• Scaling for height 

Buraya girilen sayısal değer ölçü sayısı yüksekliği ile çarpılarak tolerans sayısı 
yüksekliğinin tespit edilmesinde kullanılır. Örnek olarak 0,5 değeri girilecek olsa, tolerans 
yazı yüksekliği ölçü yazı yüksekliğinin %50’si kadar olacak anlamındadır. 

• Vertical Position 
Tolerans yazısının ölçü yazısına göre dikey konumu ayarlanır. Alt seçenekler şu 

şekildedir: 
o Bottom: Tolerans yazısı ve ölçü yazısının temel çizgileri aynı hizada 

olacak şekilde yerleşir. 
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o Top: Tolerans yazısı ve ölçü yazısı üst çizgileri aynı hizada olacak şekilde 
yerleştirilir. 

o Middle: Tolerans yazısı ve ölçü yazısı orta çizgileri aynı hizada olacak 
şekilde tolerans ve ölçü yazısı yerleşir. 

 
 “Zero Suppression” bölümü. 

Bu bölümde sonucu değiştirmeyecek sıfırların görünüp görünmemesi ile ilgili 
ayarların yapıldığı kısımdır. Seçenekler ve kullanım şekli aynen “Primary Units” 
sayfasındaki gibidir. 

 
 “Alternate Unit Tolerance” bölümü. 

Bu bölümde ikincil ölçülendirmedeki tolerans hassasiyeti ve sıfırların 
saklanması ayarı yapılır.  

• Precesions: Bu listeden ikincil ölçüdeki tolerans hassasiyeti ayarları yapılır. 
 
2.3.7. Doğrusal Ölçülendirme (DimLİNEAR - linear) 

 
Bu komut ile yatay veya dikey ölçülendirme yapılabilir. Bir başka deyişle koordinat 

eksenlerine dik veya paralel olan boyutları ölçülendirmemizi sağlar.  
 

 Adres 
• Ekran Menüsü :DIMNSION > Linear 
• Kayar Menü :Dimension > Linear 
• Komut Satırı :Dimlinear  

 
Bu ölçülendirme komutunun iki ayrı kullanım şekli ve programın sunduğu bazı alt 

seçenekler vardır. Bunların ilki kısaca şöyledir. Komut çalıştırıldığında komut satırında 
sırasıyla; 

 
Command: _DIMLINEAR 
Specify first extension line origin or <select object>: 
Specify second extension line origin: 
Specify dimension line location or 
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: 
 
iletileri gelir. Bu ilk ölçülendirme seçeneğinde, ölçülendirmek istediğimiz doğrunun 

başlangıç ve bitiş noktalarını girmemiz istenir. İlk noktayı belirlediğimizde ikinci noktayı 
belirlememiz istenir, İkinci noktayı belirlediğimizde AutoCAD ölçülendirmeyi yapmıştır ve 
nesneye olan uzaklığını belirlemeniz için bizden ayrı bir nokta belirlememiz istenir. 

 
İkinci ölçülendirme seçeneğinde ise,  
 
Command: DIMLINEAR 
Specify first extension line origin or <select object>:S 
Select object to dimension: 
Specify dimension line location or 
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[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: 
iletileri gelir. Bu ikinci seçenekte ise sadece ölçülendirmek istediğimiz kenar <select 

object>: uyarısı ile belirlenmemiz istenir. S harfi ile bu moda geçtikten sonra ekranda 
‘‘Mouse’’ un görüntüsü pickbox seçim kutusu halini alır ve nesne seçildiğinde doğrudan 
ölçülendirme yapılmış olur. Bize sadece ölçülendirme çizgisinin konumlandırılacağı noktayı 
belirlemek kalır. Ayrıca girilecek bu son nokta ölçülendirmenin yatay veya dikey olmasını 
da sağlayacaktır. Bu seçenekte doğru veya yayları seçtiğimizde ölçülendirme işlemine 
çizginin uçlarından başlanır. Çember için ise karşılıklı noktalar uzantı çizgilerinin başlangıç 
yeridir. 

 
Resim 99 : Doğrusal ölçülendirme’ye  (dimlinear) örnek 

 
Noktaların belirlenmesinden sonra (veya nesnenin belirlenmesinden sonra) 

ölçülendirme çizgisinin konumlandırılacağı noktayı belirlemek için Mouse u sağa sola 
hareket ettirirsek ölçülendirme DİKEY olacaktır, yukarı aşağı hareket ettirirsek 
ölçülendirmemiz YATAY olacaktır. 

 
Yukarıda anlattığımız konuları içeren basit bir şeklin her iki yöntemle de yapılmış bir 

örneği aşağıda gösterilmiştir. 

 
Resim 100 : Nesnenin köşelerini ve kendini seçerek yapılan iki ayrı doğrusal ölçülendirme 
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Şimdi de en son olarak verilen 

[Mtext/Text/Angle/Horizontal/Vertical/Rotated]:seçeneklerinin kullanımından bahsedecek 
olursak: 

 
 [Mtext] 

Son iletideki uyarıya “m” harfini girerek Mtext seçilirse ekrana “Multi Line Text 
Editor” kutusu gelir. 

 

 
Resim 101 : “Multi line text editor” diyalog kutusu 

 
Editör ekranında yazılı olan  “< >” sembol orijinal ölçülendirme yazısını temsil eder. 

İstenildiğinde bu dizginin önüne veya sonuna rakam ve harfler ilave edilerek ( Örneğin: “< 
>” sembolünün önüne “cd=” yazarak OK tuşu ile çıkacak olursak ölçülendirme çizgisinde 
“cd=70” yazacaktır.) ölçülendirme yazısına eklemeler yapılabilir. Bunun dışında istenilirse 
ölçülendirme yazısı (< > sembolü ) tamamen silinerek yerine istersek rakamsal, istersek de 
harf olarak değişik karakterler girebiliriz. Editörden OK tuşu ile çıkacak olursak aynı ileti 
komut satırında yeniden görünecektir. Ölçülendirme çizgisinin konumlandırılacağı noktayı 
belirlediğimizde ise girdiğimiz karakterler ölçülendirme yazısı gibi ekranda görünecektir. 

  [Text] 
Son iletideki uyarıya “t” harfini girerek Text seçilirse, komut satırında  
“Enter dimension text <70>:” iletisi görülür. Klavye ile komut satırına gireceğimiz 

yeni karakterlerden sonra ‘‘ENTER’’ la çıkacak olursak orijinal ölçülendirme yazısı 
kaybolacak ve bu defa ölçülendirme yazısı olarak bizim girdiğimiz değerler gözükecektir. 

  [Angle] 
Son iletideki uyarıya “a” harfini girerek Angle seçilirse, komut satırında  
“Specify angle of dimension text:” uyarısı gelir. Bu uyarıya vereceğimiz rakamsal 

değerler ölçülendirme yazısının yazılma açısını belirleyecektir. 

  [Horizontal] 
Son iletideki uyarıya “h” harfini girerek Horizontal seçilirse, bu yapılan 

ölçülendirmenin mutlaka YATAY olacağını belirlemiş oluruz. Bu seçenekler kullanılmadan 
yapılan ölçülendirme işleminde ölçülendirme çizgisinin konumlandırılacağı nokta aynı 
zamanda ölçülendirmenin yatay veya dikey olacağını da belirlerdi. Fakat bu seçenek 
kullanıldığında ölçülendirme çizgisinin konumlandırılacağı nokta neresi belirlenirse 
belirlensin ölçülendirme yatay olacaktır. 

 [Vertical] 
Son iletideki uyarıya “v” harfini girerek Vertical seçilirse, bu yapılan ölçülendirmenin 

mutlaka DİKEY olacağı anlamına gelecektir. 
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 [Rotated] 

Son iletideki uyarıya “r” harfini girerek Rotated seçilirse, bu seçenek ile girilen iki 
nokta arasındaki mesafe yatayla belirtilen açıyı yapan doğrultu üzerine iz düşürülerek 
bulunan uzunluk ölçülendirilir. 

 
2.3.8. Hizalı Ölçülendirme (DimALİGNED - Aligned) 

 
Bu komut ile koordinat eksenine eğik konumdaki boyutları ölçülendirmemizi sağlar. 

Doğrusal ölçülendirme komutlarından biridir. Ölçü sınır çizgilerinin uzunlukları birbirine 
eşittir. Ölçü çizgisi ölçülendirilecek yüzeye paralele konumdadır. Seçilen nesne üzerinde 
seçtiğimiz elemana paralel hizalı bir ölçülendirme gerçekleştirir. 

 
 Adres 

• Ekran Menüsü :DIMNSION > Aligned 
• Kayar Menü :Dimension > Aligned 
• Komut Satırı :Dimaligned  

 
Dimaligned komutunda da Dimalinear komutuna benzer iletiler gelir. Ölçü çizgisi 

belirlenen iki nokta arasını ölçerek bu iki noktanın doğrultusuna paralel olacak şekilde 
yerleştirilir.  
 

 
Resim 102 : Nesnenin köşelerini ve kendini seçerek yapılan iki ayrı hizalı ölçülendirme 

 
Son iletideki “[Mtext/Text/Angle]:”seçeneklerinin kullanımı Dimalinear komutundaki 

gibidir. Komut seçildikten sonra ENTER veya Mouse sağ tuşla nesne seçilmesi yoluna 
gidilirse, doğru ve yaylarda nesnenin uç noktaları ölçülendirme uzantı çizgilerinin başlangıç 
yeridir. Çemberde ise seçim noktası ve bu noktadan geçen çap üzerindeki karşı nokta uzantı 
çizgilerinin başlangıç yeridir. 
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Resim 103 : Farklı şekillerdeki nesnelere uygulanan hizalı ölçülendirme 

 
2.3.9. Sıralı Ölçülendirme (Dimordınate - Ordinate) 

 
Bu komut ile bir noktanın X veya Y koordinatları ölçülendirilir. Kullanılan koordinat 

sisteminin orjini (0 – Sıfır noktası ) ile işaretlenen noktanın X veya Y ekseni arasındaki 
uzaklığa göre ölçülendirme yapılır. 

 
 Adres 

• Ekran Menüsü :DIMNSION > Ordinate 
• Kayar Menü :Dimension > Ordinate 
• Komut Satırı :Dimordinate  

 
Ordinate ölçülendirme, basit bir ölçülendirme çizgisi ile X,Y koordinatını 

görüntülememizi, kısaca koordinat ölçülendirmesi yapar. Bu ölçüler aynı zamanda DATUM 
ÖLÇÜLER olarak da bilinmektedir. Ordinate ölçülendirme yapmadan önce Ortho (Dikey) 
modunun açık olması tavsiye edilir. 

 
Ordinate ölçülendirmek istediğimiz noktanın sadece X koordinatını ölçülendirmek için 

X Datum, Y koordinatını ölçülendirmek için de Y Datum seçeneği kullanılabilir. 
 
Komut çalıştırıldığında gelen ilk ileti “Specify feature location:” koordinatını 

ölçülendirilecek noktanın girilmesini ister. Daha sonra gelen ikinci ve son ileti 
“Specify leader endpoint or [Xdatum/Ydatum/Mtext/Text/Angle]:” ile ikinci bir nokta 

daha girilmesini ister. Bu ikinci girilen nokta ilk noktanın hangi koordinatının yazılacağını 
ve ölçü çizgisinin biçimini belirler. İki nokta arasındaki dikey mesafe büyükse ilk noktanın 
X koordinatı ölçülendirilir. X koordinatları DİKEY, Y koordinatları ise YATAY 
yazılırlar. 

 
Son iletideki [Xdatum/Ydatum] seçenekleri belirlediğimiz noktanın X veya Y 

koordinatlarının mı yazılacağını belirlemek için kullanılır. Son belirlenen nokta ise sadece 
ölçü yazısının yerini belirlemek için kullanılır. [Mtext/Text/Angle] seçenekleri DIMLINEAR 
komutunda açıklananlar gibidir. 
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Resim 104 : Sıralı ölçülendirme (dimordinate) ile ilgili bir örnek 

 
Yukarıdaki örnekte şeklin hem X istikametindeki, hem de Y istikametindeki 0,0 

noktası daha iyi anlaşılması için özellikle koordinat ekseninin merkezine alınmıştır. 
 

2.3.10. Yarıçap Ölçülendirme (Dimradıus - Radius) 
 

Seçeceğimiz yay ya da çemberlerin yarıçaplarını ölçülendirmemizi sağlar. Seçilen yay 
veya çemberin büyüklüğüne ölçülendirme stilindeki ayarlara ve çaprazın konumuna göre 
farklı şekillerde yarıçap ölçülendirme yapabiliriz. 

 
Adres: 

 Ekran Menüsü :DIMNSION > Radius 
 Kayar Menü :Dimension > Radius 
 Komut Satırı :dimradius  

 
Komut seçildikten sonra  “Select arc or circle”: uyarısı ile yarıçapını ölçülendirmek 

istediğimiz yay veya çemberi seçmemiz istenir. Seçtiğimiz anda ölçü rakamı belirlenmiştir 
(Dimension text = 25 ) ve bizden ölçülendirme çizgisinin konumlandırılacağı noktayı 
belirlememiz istenir. Specify dimension line location or [Mtext/Text/Angle]: En sondaki 
[Mtext/Text/Angle]:iletilerinin kullanımı DIMLINEAR komutunda açıklananlarla aynıdır. 
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Resim 105 : Yarıçap ölçülendirme (dimradius) ile ilgili örnekler. 

 
2.3.11. Çap Ölçülendirme (Dimdıameter - Diameter) 

 
Seçeceğimiz yay ya da çemberlerin çaplarını ölçülendirmemizi sağlar. Ölçü 

çizgilerinin çember veya yay içinde çizilmemesi ayarı yapılmışsa, seçilen yay veya çemberin 
büyüklüğüne, ölçülendirme stilindeki ayarlara ve çaprazın konumuna göre farklı şekillerde 
çap ölçülendirme yapabiliriz. 

 
 Adres 

• Ekran Menüsü :DIMNSION > Diameter 
• Kayar Menü :Dimension > Diameter 
• Komut Satırı :dimdiameter 

 
Komutlar ve kullanımları DIMRADIUS komutunun kullanımıyla aynıdır. Komut 

seçildikten sonra  “Select arc or circle”: uyarısı ile yarıçapını ölçülendirmek istediğimiz yay 
veya çemberi seçmemiz istenir. Seçtiğimiz anda ölçü rakamı belirlenmiştir ve bizden 
ölçülendirme çizgisinin konumlandırılacağı noktayı belirlememiz istenir. Specify dimension 
line location or [Mtext/Text/Angle]: En sondaki [Mtext/Text/Angle] :iletilerinin kullanımı 
DIMLINEAR komutunda açıklananlarla aynıdır. 
 

 
Resim 106 : Çap ölçülendirme (dimdiameter) ile ilgili örnekler. 
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2.3.11. Açılı Ölçülendirme (Dimangular- Angular) 
 

Çizim öğelerinin açısal geometriye sahip olan boyutlarını ölçülendirmememizi 
sağlayan komuttur. Bir yay ya da çember üzerinde belirleyebileceğimiz iki nokta ya da 
paralel olmayan iki çizgi arasındaki açıyı ölçülendirir. 

 
 Adres 

• Ekran Menüsü :DIMNSION > Angular 
• Kayar Menü :Dimension > Angular 
• Komut Satırı :dimangular 

 
Komut birbirlerine paralel olmayan doğrular arasındaki açıları ölçülendirdiği gibi, 

yaylar ve çemberler üzerinde de uygulanabilir. 
 

 
Resim 107 : Açılı ölçülendirme (dimangular) ile ilgili örnekler 

 

 “_dimangular” komutu seçildiğinde aşağıdaki komut satırında ilk önce;  

“Select arc, circle, line, or <specify vertex>:” uyarısı gelir. Bu uyarıyla komutu 
uygulayacağımız yay, çember ya da doğruyu seçmemiz istenir. Komuta hiçbir seçim 
yapmadan doğrudan ENTER tuşlayarak cevap verirsek; <specify vertex>:moduna geçeriz ve 
sırasıyla aşağıdaki iletiler gelir: 

Specify angle vertex: 

Specify first angle endpoint: 

Specify second angle endpoint: 

Specify dimension arc line location or [Mtext/Text/Angle]: 
 

Yani ilk önce açıyı oluşturan merkez, daha sonra açı kolları işaretlenir. En sonra da 
ölçülendirme çizgisinin konumlandırılacağı noktanın belirlenmesi istenir. 
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Resim 108 : Farklı yöntemlerde yapılan açılı ölçülendirme (dimangular) ile ilgili örnekler–1 
 
[Mtext/Text/Angle]: uyarısının kullanımları DİMLINEAR komutunda olduğu gibidir. 
 
Komut hangi şekilde seçilirse seçilsin ölçülendirme yazısı, yapılan ölçülendirme 

ayarlarına göre farklı konumlarda yerleştirilir. “Specify dimension arc line location” 
uyarısından sonra ölçülendirme yapılmış ve program sizden ölçülendirme elemanlarının 
yerleştirileceği noktayı belirlemeniz için MOUSE ile sürükleyip bırakmanızı ister. Bu 
işlemde ölçülendirdiğiniz şekle ve ölçülendirme ayarlarınıza göre farklılıklar gösterebilir. 
 

 

 
Resim 109 : Farklı yöntemlerde yapılan açılı ölçülendirme (dimangular) ile ilgili örnekler–2 
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2.3.12. Hızlı Ölçülendirme (Dimquıck- Quick) 

 
Hızlı ölçülendirme komutu olarak da bilinen QDIM komutu ile bir defada bir dizi ölçü 

öğesi oluşturulur. Özellikle paralel ve sürekli ölçülendirmenin hızlı yapılabilmesinden dolayı 
komut kullanımı bu yönde artar. 

 
 Adres 

• Kayar Menü :Dimension > Quick Dimension 
• Komut Satırı :qdim 

 
Qdim komutu çalıştırıldıktan sonra “Select geometry to dimension:” uyarısı ile 

ölçülendirilecek nesnenin seçilmesini ister. Bunun için Mouse pickbox seçim kutusu halini 
alır ve nesneleri isterse teker teker üzerlerine tıklayarak, istersek de  

“Specify opposite corner:” iletisi ile bir dikdörtgen içine alarak seçebiliriz. Bu seçim 
işleminden sonra ölçülendirme yapılmış ve Mouse ile sürüklenerek istediğiniz yere 
bırakmanız beklenmektedir. 
 

 
Resim 110 : Hızlı ölçülendirme (quick dimension)’nin uygulanma aşamaları. 

 
Bu komut uygulamasında ölçülendirme çizgilerinin bulunacağı noktayı tespit etmeden 

önce komut satırında aşağıdaki ileti gelir. 
 
Specify dimension line position, or  
[Continuous/Staggered/Baseline/Ordinate/Radius/Diameter/datumPoint/Edit]  
Şimdi kısaca bu alt özellikleri tanımaya çalışalım. 

 
 [Continuous] 

Bir defada bir dizi sürekli ölçülendirme yapabilmemize olanak tanıyan seçenektir. 
 

 [Staggered] 
Bir dizi sürekli ölçü öğesi oluşturmak için kullanılır. Seçilen nesnelere bağlı olarak da oluşan 
ölçü noktaları kullanılır. 
 

 [Baseline] 
Bu seçenek bu sistem ölçülendirmede paralel ölçülendirme yapılabilmesi için kullanılır. 
 

 [Ordinate] 
Bu seçenek ise Ordinate ölçülendirme stilinde ölçülendirme yapmak için kullanılır.  
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“Datum Point” seçeneği ile de başlangıç noktasının yeri değiştirilebilir. 
 

 [Radius] 
Birden fazla yay ve çemberin yarıçaplarının ölçülendirmesini yapabileceğimiz bir seçenektir. 
 

 [Diameter] 
Birden fazla yay ve çemberin çaplarının ölçülendirmesini yapabileceğimiz bir seçenektir. 
 

 
Resim 111 : Hızlı ölçülendirme (quick dimension)’nin çember ve yaylara uygulanması 

 
 [datumPoint] 

Paralel (Dim Baseline) ve Koordinat (Dim Ordinate) ölçülendirmelerinde kullanılan referans 
noktalarının değiştirilmesi için kullanılır. 
 

 [Edit] 
Bu seçenek işaretlendiğinde ölçülendirme için programın tespit ettiği tüm 

ölçülendirme noktaları “X” şeklindeki bir işaretle belirtilir ve komut satırına  
“Indicate dimension point to remove, or [Add/eXit] <eXit>:” iletisi gelir. 

Ölçülendirilmesini istemediğimiz noktanın üzerine Mouse ile tıklayarak iptal edebiliriz. 
Ayrıca yeni nokta eklemek istiyorsak Add seçeneği kullanılarak bunu yapabiliriz. 
Ölçülendirme tamamlandığında istemediğimiz noktalar ölçülendirilmemiş, sonradan 
kendimizin tespit ettiği noktalar ise ölçülendirilmiş olacaktır. 

 
Eğer bütün bu alt uyarıları dikkate almayıp ölçülendirme işlemini yer seçimini 

yaparak sonlandıracak olursanız program sizin [Continuous] seçeneğini seçtiğiniz kabulü ile 
devam ederek ölçülendirme işleminizi tamamlayacaktır. 

 
2.3.13. Paralel Ölçülendirme (Dimbaseline- Baseline) 

 
Birden fazla boyutun birbiriyle ilişkilendirilerek ölçülendirilmesini sağlayan bir 

komuttur. Referans alınan bir noktaya göre boyutların ölçülendirilmelerini sağlar. 
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 Adres 

• Ekran Menüsü :DIMNSION > Baseline 
• Kayar Menü :Dimension > Baseline 
• Komut Satırı :Dimbaseline 

 
Bir önceki Linear (Doğrusal), Angular (Açısal) ya da Ordinate (Ordinat-Merkezi) 

ölçülendirmelerin başlangıç noktasını kendi başlangıcı olarak alan ve aldığı 
ölçülendirmelerin özelliklerini devam ettiren bir ölçülendirme komutudur. 

 
İlk boyut ölçülendirildikten sonra “_dimbaseline” komutu girilince diğer boyutları 

referans noktasını yeniden seçmeden ölçülendirmeye devam eder. 
 

 
Resim 112 : Paralel ölçülendirme (dimbaseline)’nin uygulanması. 

 
Dimbaseline komutu çalıştırıldığında son yapılan ölçülendirmenin birinci uzantı 

çizgisi temel alınarak doğrudan ikinci uzantı çizgisinin başlangıç noktası istenilmektedir. 
Eğer ölçülendirme başka ölçülendirmelerle ilişkilendirilip istemediğimiz şekilde devam 
ederse, ilk baştaki; “Specify a second extension line origin or [Undo/Select]” iletisine boş 
olarak, ENTER ile cevap vermemiz gerekir. Böylece [Select] seçeneği seçilmiş olur, bizde 
istediğimiz ölçülendirme elemanının ilk çizgisini tıklayarak ölçülendirmemize devam 
edebiliriz. 

 
Resim 113 : Paralel ölçülendirme (dimbaseline)’nin farklı nesnelere uygulanması 
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Bu komutta dikkat edilmesi gereken bir nokta da ölçülendirme çizgileri arasındaki 

mesafenin ilk etapta bizim kontrolümüzde olmadığıdır. 
 
“Dimension Style Manager” penceresinden “Modify Dimension Style” kısmına 

geçildiği taktirde “Lines and Arrows” sekmesinde bulunan “Baseline spacing” kutucuğuna 
ölçülendirme ayarlarınızı dikkate alarak (en önce text-yazı yüksekliği) makul bir rakamsal 
ifade girerek ölçülendirme çizgileri arasındaki mesafeyi ayarlayabiliriz. Ancak bu yaptığımız 
değişiklik Modify Dimension Style penceresindeki “ön izleme penceresinden” izlenilemez. 
 

 
Resim 114 : “Baseline Spacing” değişkeninin düzenlenme yerinin gösterilmesi 

 
1.3.14. Sürekli Ölçülendirme (Dimcontınue- Continue) 

 
Birbirine komşu boyutların zincirleme şekilde ölçülendirilmesini sağlar. İlk boyut 

ölçülendirildikten sonra Continue seçeneği girilir ve diğer boyutlar birbirini takip eden 
sınırlara göre ölçülendirilir. 

 
 Adres 

• Ekran Menüsü :DIMNSION > Continue 
• Kayar Menü :Dimension > Continue 
• Komut Satırı :Dimcontinue 

 
Bir önceki Linear (Doğrusal), Angular (Açısal) ya da Ordinate (Ordinat-Merkezi) 

ölçülendirmelerin son noktasını yeni ölçülendirme için başlangıç noktası olarak alan ve 
aldığı ölçülendirmelerin özelliklerini devam ettirerek yeni bir Linear(Doğrusal), Angular 
(Açısal) ya da Ordinate (Ordinat-Merkezi) ölçülendirme işlemi gerçekleştirir. 
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Resim 115 : Sürekli ölçülendirme (dimcontinue)’nin uygulanması. 

 
Kullanımı Dimbaseline komutuna benzer. Komut çalıştırıldığında son yapılan 

ölçülendirme öğesi temel alınarak ölçülendirmeye devam edilir. Son ölçü öğesinin ikinci 
uzantı çizgisi yapılan ölçülendirmenin birinci uzantı çizgisi olur. Eğer son yapılan 
ölçülendirme ile değil de bir başka ölçülendirmenin ardından ölçülendirmeye devam edilmek 
isteniyorsa komuta boş ‘‘ENTER’’ la cevap vermemiz ve istediğimiz ölçü çizgisini 
tıklamamız gerekecektir. Seçim yaparken ölçü öğesinin hangi uzantı çizgisinin yakınından 
seçildiği önemlidir. Çünkü o uzantı çizgisi yeni ölçü öğesi için birinci uzantı çizgisi 
olacaktır. 
 

 
 

Resim 116 : Sürekli ölçülendirme (dimcontinue)’nin farklı şekillerde uygulanması 
 

2.3.15. Ölçüleri Düzenleme 
 
Ölçülendirme işlemi içerisinde kullanılacak elemanların standart özellikleri 

Dimensions Styles diyalog kutusundan ayarlanıyordu. Bir ölçülendirme işleminde kullanılan 
elemanların özelliklerinin değiştirilmesi ise Modify Dimension diyalog kutusu kullanılarak 
yapılır. 

 
Düzenlenecek bir çizim öğesi olarak bir ölçülendirme elemanı seçildiğinde Modify 

Dimension diyalog kutusu görüntülenir. 
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Resim 117 : Modify dimension properties menüsü 

 
Bu diyalog kutusunu kullanarak veya Dimension Edit, Dimension Text Edit ve 

Dimension Update seçeneklerini kullanarak yapılmış ölçülendirmeler üzerinde değişiklikler 
yapılabilir. Şimdi kısaca onlara göz atalım. 

 
Ölçü Geometrisini Düzenleme: 

(Dımedıt ) 
 
Ölçü geometrisini düzenlenmesine olanak sağlar  
 

 Adres 
• Ekran Menüsü :DIMNSION > Dimedit 
• Kayar Menü :Dimension > Oblique 
• Komut Satırı :dimedit 

Komutun Home, New ve Rotate seçenekleri ölçü öğesindeki yazıyı etkiler. Oblique 
seçeneği ise uzantı çizgilerini etkiler. Aynı zamanda DIMEDIT komutu ile birden fazla ölçü 
öğesi seçilebilir. Komut çalıştırıldığında komut satırında; 

“Enter type of dimension editing [Home/New/Rotate/Oblique] <Home>:” iletisi 
görülür. Bunları kısaca açıklayacak olursak; 
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• [Home] 
Bir ölçülendirme öğesindeki ölçü yazısının konumu veya doğrultusu değiştirildikten 

sonra tekrar orijinal haline dönmesi istenirse bu seçenek kullanılır. Home seçeneği 
seçildikten sonra program bizden bir ölçü öğesi belirlememizi ister. Seçme işlemi 
bitirildiğinde seçilen ölçü öğelerindeki yazılar eski konumlarına geri gelirler. Bu işlem 
UNDO ve REDO (geri-ileri) komutları ile karıştırılmamalıdır. Bilgisayarı veya programı 
kapatıp, açsak, arada başka işlemler dahi yapsak yine home komutunu kullanabiliriz. 
 

• [New] 
Bu seçenek alındığında MTEXT komutundaki gibi aşağıdaki “Multiline Text Editor” 

penceresi açılır.  
 

 
Resim 118 : “Multiline text editor” diyalog penceresi. 

 
Burada gerçek ölçü “< >” şeklinde bulunur. Ölçü yazılarının tamamen değiştirilmesi 

istenilirse “< >” dizgisi silinir, yeni metin veya rakamlar yazılır. Sadece ölçü yazıklarına ön 
ya da son ek konulmak isteniyorsa bu defa dizgi silinmez, yazmak istediğimiz ek metin ve 
rakamlar “< >” dizgisinin ön veya arkasına eklenir. 
 

• [Rotate] 
Bu seçenek ile ölçülendirme öğesinin yazıları döndürülebilir. 
Enter type of dimension editing [Home/New/Rotate/Oblique] <Home>: iletisine  

“R”ile cevap verirsek komut satırında ölçülendirme yazısını döndürmek istediğimiz açı 
miktarını soran “Specify angle for dimension text: …”uyarısını görürüz.  Açı değerini 
girdikten sonra ölçülendirme nesne veya nesnelerini (birden fazla seçebiliriz) seçmemiz için 
“Select objects:” uyarısı ile komut sonlandırılır. 

 
• [Oblique] 
Bu seçenek ile ölçü öğesinin uzantı çizgileri döndürülür. Aşağıda perspektif olarak 

çizilmiş bir nesnenin oblique komutu uygulanmadan önceki ve sonraki hali görülmektedir. 
Eğim açısı olarak 30° kullanılmıştır. Select Object iletisine de her üç ölçülendirme öğesi 
birlikte seçilerek aynı anda döndürülmeleri sağlanmıştır. 
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Resim 119 : “Oblique” şeçeneği kullanılarak uzantı çizgilerinin döndürülmesi. 

 
 Ölçü Metnini Düzenleme (Dımtedıt ) 

 
Bu komut ölçü yazısının konumu ve açısı ile ilgili düzenlemeler yapmak için 

kullanılır.  
 

 Adres 
• Ekran Menüsü :DIMNSION > Dimtedit 
• Kayar Menü :Dimension > Align Text > 
• Komut Satırı :dimtedit 

 
Komut çalıştırıldığında komut satırında; öncelikle metnini düzenlemek istediğimiz 

ölçülendirmeyi seçmemiz için “Select dimension:” uyarısı gelir. Ölçülendirme seçilince de  
“Specify new location for dimension text or [Left/Right/Center/Home/Angle]” iletisi 

gelir. Ölçülendirmeyi seçtiğimizde ölçü yazısı ‘‘Mouse’’a bağlı hareket ederek 
sürüklenmeye başlanır. Seçilen ölçü yazısı için yeni bir yer gösterilmesini bekler. Bir nokta 
işaretlendiğinde ölçü yazısının merkezi o nokta olacak şekilde yeri değişir. 
 

 
Resim 120 : “Dimtedit” komutunun uygulanması 
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İletideki diğer alt seçenekleri kısaca açıklayacak olursak: 
 
• [Left] 
Bu seçenek ile seçilen ölçü öğesinin yazısı ölçülendirme çizgisinin sol kenarına 

yaslanır. 
 
• [Right] 
Bu seçenek ile seçilen ölçü öğesinin yazısı ölçülendirme çizgisinin sağ kenarına 

yaslanır. 
 
• [Center] 
Bu seçenek ile seçilen ölçü öğesinin yazısı ölçülendirme çizgisinin merkezine getirilir. 
 

 
Resim 121: “Dimtedit” komutundaki “left”, “right” ve “centre” değişkenlerinin gösterilmesi 

 
• [Home] 
Ölçü yazısını tekrar başlangıç konumuna ya da açısına getirilmesini sağlar. Her bir 

ölçü öğesi teker teker seçilmelidir. 
 
• [Angle] 
Bu seçenek ile ölçü öğesinin yazısı döndürülür. Burada da yalnız bir ölçü öğesi 

seçilebilir. Yazıyı istediğimiz açıyla döndürebiliriz. 0 (sıfır) açısı girersek yazı başlangıçtaki 
açısına dönecektir. 

 
2.3.16. Ölçüleri Güncelleme 

 
Ölçü öğeleri üzerinde AutoCAD düzenleme komutları uygulanabilir. Grup halinde 

davranan ölçü öğeleri taşınabilir, sündürülebilir, vb. ölçü öğeleri üzerinde düzenleme 
işlemleri uygulamanın en kolay ve hızlı yolu “grips” kullanımıdır. Ölçü öğesi seçildiğinde 
oluşan tutamaklar yardımıyla, diğer nesnelerde olduğu gibi ölçü öğeleri de düzenlenir. Bu 
düzenleme esnasında ölçü değişimi oluyorsa bu değişen miktar ölçü rakamına yansıyacaktır.  

 
AutoCAD 2002’den daha önceki sürümler ile oluşturulmuş bir çizim dosyasında 

DIMASSOC sistem değişken değerini DIMASO sistem değişkeninden alır. DIMASSOC 
sistem değişkeni ölçü stilleri üstünde olduğundan ölçü stili içinde saklanmaz. 
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2.3.17. Ölçü Biçim Listesi 

 
AutoCAD programı eski sürümlerinin özelliği olan ölçülendirme moduna geçiş 

işlemleri yeni sürümlerde kullanılmamaktadır. Bu bölümde öğrendiğimiz ölçülendirme 
komutları çok daha yaygın olarak kullanılmaktadır. 

 
Komut satırına “dim” komutu yazılıp çalıştırıldığında ölçülendirme moduna geçilir 

ama sadece bir komut kullanıldıktan sonra kendiliğinde komuttan çıkılır. DIM komutuyla 
ölçülendirme moduna girilmişse modu terk etmek için EXIT komutu veya  “ESC” tuşu 
kullanılır. 

 
Aşağıdaki tabloda ölçülendirme modunda kullanılan komutların eşdeğerleri 

verilmiştir. 
 
Ölçülendirme Modu Komutu Eşdeğer Autocad Komutu 
ALIGNED DIMALIGNED 
ANGULAR DIMANGULAR 
BASELİNE DIMBASELİNE 
CENTER DIMCENTER 
CONTINUE DIMCONTINUE 
DIAMETER DIMDIAMETER 
HOMETEXT DIMEDIT komutunun “Home” seçeneği  
HORIZONTAL DIMLINEAR komutunun “Horızontal” seçeneği 
LEADER LEADER 
NEWTEXT DIMEDIT komutunun “New” seçeneği 
OBLIQUE DIMEDIT komutunun “Oblique” seçeneği 
ORDİNATE DIMORDİNATE 
OVERRIDE DIMOVERRIDE 
RADIUS DIMRADIUS 
RESTORE DIMSTYLE komutunun “Restore” seçeneği 
ROTATED DIMLINEAR komutunun “Rotated” seçeneği 
SAVE DIMSTYLE komutunun “Save” seçeneği 
STATUS DIMSTYLE komutunun “Status” seçeneği 
TEDIT DIMTEDIT 
TROTATE DIMEDIT komutunun “Rotate” seçeneği  
UPDATE DIMSTYLE komutunun “Apply” seçeneği 
VARIABLES DIMSTYLE komutunun “Variables” seçeneği 
VERTICAL DIMLINEAR komutunun “Vertical” seçeneği 
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2.3.18. Ölçü Biçim Diyaloğu 
 

Yeni bir ölçülendirme nesnesi oluşturulurken güncel ölçü stili kullanılır. Yani güncel 
ölçü stiline göre ölçülendirme yapılır. Yeni bir dosya açılırken “Default Settings” 
bölümünden “English” veya “Metric” tercihi “Standart veya “ISO–25” ölçü stilini 
beraberinde getirir. Dolayısıyla biz yeni bir dosya açmış ve herhangi bir ölçülendirme stili 
tanımlamamışsak “ISO–25” ölçü stili aktiftir. Dolayısıyla oluşturacağımız ölçü öğeleri 
“ISO–25” ölçü stilinde tanımlanmış ölçü parametrelerini kullanır.  

 
Bir ölçü stili oluşturmak için DDIM veya DIMSTYLE komutunun ‘Save’ seçeneği 

kullanılır. Ölçü stilinden anlatılmak istenilen ölçü ayarlarını yapan parametreler kümesinin 
bir isim altında saklanmasıdır. Mesela DIMTXT sistem değişkeni ile ölçü yazılarının 
büyüklükleri; DIMASZ sistem değişkeni ile ölçü oklarının büyüklükleri; DIMTOL sistem 
değişkeni ile toleranslı ölçülendirme yapılıp yapılmayacağı vb. ayarlar söz konusudur. 

 
Ölçü öğelerinin değişik ayarlarını yapan birçok sistem değişkenine istenilen değerler 

atanır ve bu değişkenlerin hepsi bir isim altında saklanarak ölçü stili oluşturulur. 
 
Her ölçü öğesinin bir stili vardır. Zaman zaman bir ölçü öğesinin bir ya da birkaç 

parametre haricinde mevcut stillerden birindeki parametrelerin hepsini kullanmasını istenir. 
Bu durumda yeni bir ölçü stili oluşturmak biraz zahmetli ve gereksiz olacaktır. Bunun yerine 
DIMOVERRIDE komutu kullanılarak bir ölçü öğesinin stili değiştirilmeksizin istenilen 
parametrelerini değiştirme olanağına sahip olabiliriz. Böylece çizim dosyamızda sadece bir 
veya birkaç parametresi farklı ölçü stilleri bulunmasından kurtulmuş olunur. Komutun 
çalıştırılabilmesi için menü çubuğundaki “Dimension” başlığında bulunan “Override” 
seçilebilir. 

 
Eğer bir ölçü öğesinin, ait olduğu stildeki parametrelerden bir kaçı değiştirilmiş ve bu 

parametrelerin tekrar stilde tanımlandığı değere döndürülmesi isteniliyorsa “Clear 
Overrider” seçeneği kullanılır. 

 
2.3.19. Ölçüyü Yeniden Bağlama 

 
Ölçülendirme komutları kullanmaya başlandığında “Defpoint” adında bir katman-

layer kendiliğinden oluşur. Ölçü öğelerinin tanım noktalarının bulunduğu bu katmanda 
herhangi bir işlem yapılmaması tavsiye olunur.  

 
Bu tanım noktaları ölçü öğesi dağıtıldığında (EXPLODE komutu ile )silinir. 

DDPTYPE komutunda yapılan ayarlardan etkilenmeyen bu noktalar “NODE” nesne 
kenetleme modu ile yakalanabilirler.  

 
Tanım noktaları genellikle ölçünün verildiği nesnelerin altında kaldığı için 

görünmezler. Ölçü öğesini tutamak yardımıyla düzenlemek için işaretlendiğinde tutamaklar 
oluşur. Her tanım noktası için bir tutamak olmasına rağmen her tutamak bir tanım noktası 
belirtmez. Ayrıca tanım noktaları çıktı alınırken kağıda aktarılmazlar. 
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2.3.19. Ölçüleri Kaydetme 
 

Ölçülendirme işlemini gerçekleştirirken ölçü yazısının, ölçü çizgisinin ne renk olacağı, 
ölçü yazısının hangi büyüklükte yazılacağı, ölçü yazısının ölçü çizgisinden ne kadar 
büyüklükte olacağı gibi değerler ihtiyaç vardır. Bu değerlerin tümüne ÖLÇÜLENDİRME 
SİSTEM DEĞİŞKENLERİ denilir ve Status (Durum) adlı ölçülendirme komutu ile bu 
sistem değişkenlerinin son durumu görüntülenebilir. 
 

 
Resim 122 : Oblique menüsünün gösterilmesi 

 
Override komutu ölçülendirme elemanlarıyla ilgili ayarların DIMSTYLE diyalog 

kutusuna girmeden komut mesaj satırından ayarlanmasını sağlar.  
 
Ölçülendirmede kullanılan her bir elemanın sembolik bir kodu vardır. Örneğin ölçü 

rakamı için kullanılacak rakamın yüksekliğinin kodu txt dir. Bu kodlar OVERRIDE komutu 
çalıştırıldıktan sonra ilgili elemanı ayarlamak ve kaydetmek için kullanılır. 

 
OVERRIDE fonksiyonunu Dimension komutuna girmeden doğrudan komut mesaj 

satırından kullanılması için baş tarafına “Dim” ifadesi eklenir. (Örneğin; DIMTXT gibi). 
 
Bütün bu ayarlar yapıldıktan sonra “New Dimension Style” diyalog kutusu “OK” 

düğmesi işaretlenerek kapatılır. Artık “Dimension Style Manager” kutusunun “Styles” 
bölümünde tanımladığımız ölçü stilinin adı görülür. Ancak bu ayarlar kendiliğinden aktif 
değildir. Kendimizin seçmesi gerekecektir. 
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DEĞERLENDİRME ÖLÇEĞİ 
 
Aşağıda hazırlanan değerlendirme ölçeğine göre kendiniz ya da arkadaşınızın yaptığı 

çalışmayı değerlendiriniz. Gerçekleşme düzeyine göre evet hayır seçeneklerinden uygun 
olanı kutucuğa işaretleyiniz.  

 
DEĞERLENDİRME ÖLÇEĞİ 

Dersin Adı Bilgisayarla Mimari ve Statik Proje Çizimi 
Amaç Ölçülendirmeyi Kuralına Uygun Yapabilmek 
Konu Doğrusal Ölçülendirme (Dim Linear) 

DEĞERLENDİRME KRİTERLERİ EVET HAYIR 

1 Kullanacağınız AutoCAD programını sorunsuz bir şekilde 
açtınız mı?   

2 Ölçülendirme yapacağınız nesneye hangi tip ölçülendirmeyi 
kullanacağınıza karar verdiniz mi?   

3 
Doğrusal Ölçülendirme (Dim Linear) komutunu kurallara uygun 
olarak ekran menüsünden, ölçülendirme araç çubuğundan, kayar 
menüden veya komut satırına yazarak seçtiniz mi? 

  

4 

Komutu seçtikten sonra ekranın alt tarafındaki komut satırını 
okudunuz mu? Nesneyi seçerek mi (Select Object) yoksa 
ölçülendirmek istediğiniz köşeleri belirleyerek (Specify first 
extension line origin) mi işlem yapacağınıza karar verdiniz mi? 

  

5 Yapacağınız ölçülendirmenin yatay mı dikey mi olacağını nasıl 
ayarlayabileceğinizi biliyor musunuz?   

6 Nesnenin kendisini veya iki köşesini belirledikten sonra 
ölçülendirme çizgisi ve yazısı anında ortaya çıktı mı?   

7 Mouse ile ölçülendirme çizgisini istediğiniz yerde 
konumlandırabileceğinizi görüyor musunuz?   

8 
Ölçülendirme çizgisini yerini tespit etmeden önce, sağa-sola ve 
yukarı-aşağı Mouse ile hareket ettirerek ölçülendirmenizin yatay 
veya dikey yapabileceğinizi gördünüz mü? 

  

9 
Komut satırında verilen  
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]:  seçeneklerinin 
ne anlama geldiğini biliyor musunuz? 

  

10 
Yapmış olduğunuz ölçülendirmenin konumlandırılacağı noktayı 
ölçülendirme çizgisinin nesneye olan uzaklığını kurallara uygun 
olarak ayarlayarak belirlediniz mi? 

  

 
 

İşaretleme sonucunda eksik olduğunuzu tespit ettiğiniz konuları tekrar ederek 
eksikliklerinizi tamamlayınız. 

DEĞERLENDİRME ÖLÇEĞİ



 

 108

ÖLÇME VE DEĞERLENDİRME 
 

 
 
Bu faaliyet kapsamında hangi bilgileri kazandığınızı aşağıdaki cümlelerini doğru veya 

yanlış olarak değerlendirerek belirleyiniz. 
 
A) ÖLÇME SORULARI (Doğru-Yanlış) 
 

1. (   ) Ölçülendirme komutları AutoCAD ile yaptığımız çizimleri ölçülendirmemizi sağlar. 
2. (   ) Bütün ölçülendirmeler her meslek grubunda değişmez kurallarla uygulanmak 

zorundadır 
3. (   ) Öncelikle kendimize uygun olan ayarları “DimStyle” komutuyla yapmalı daha sonra 

ölçülendirme işlemine geçmeliyiz. 
4. (   ) Ölçü biçimimizi ölçülendirmeye başlamadan önce oluşturmalıyız, çünkü yapılmış 

olan ölçülendirmeler üzerinde değişiklik yapmak çok zahmetlidir.  
5. (   ) Yeni ölçü sitili oluştururken yapılan değişiklikleri ayarlarımız tamamlanıp komuttan 

çıktıktan sonra görebiliriz. 
6. (   ) Yeni ölçü sitili oluştururken buna istediğimiz ismi verebiliriz. 
7. (   ) Yeni ölçü sitili “New Dimension Style” diyalog kutusundaki “Lines and Arrows” 

sekmesinde-bölümünde ölçülendirme yazısı ile ilgili ayarlamalar yapılır. 
8. (   ) Paralel ölçülendirmelerde (Dimbaseline) ölçülendirme çizgileri arasındaki mesafeyi 

“Baseline spacing” değerini değiştirerek ayarlayabiliriz. 
9. (   ) Dikey konumdaki ölçülendirmelerde ölçülendirme yazısı mutlaka ölçülendirme 

çizgisi gibi dikey olur. 
10. (   ) Ölçülendirme aralığı dar olsun, geniş olsun program ölçülendirme yazısını her 

zaman ölçülendirme çizgisinin üstüne ve ortasına yazar. 
11. (   ) Yeni ölçü sitili “New Dimension Style” diyalog kutusundaki “Primary Units” 

sekmesinde-bölümünde gerekli ayarlamaları yaparak her ölçülendirme yazısının 
önüne ve arkasına “Ф”, “©”, cm, m … gibi metin ve semboller ekleyebiliriz. 

12. (   ) Herhangi bir nesneyi ölçülendirirken aynı anda iki farklı birimde (‘m, cm.’ – ‘mm – 
inç’ v.b.) ölçülendirme yapabiliriz. 

13. (   ) Dimlinear komutu ile koordinat eksenlerine dik veya paralel olan boyutları 
ölçülendirebiliriz. 

14. (   ) Ölçülendirme sonucunda ölçülendirme yazısının biçim ve stilini bozmadan 
istediğimiz şekilde değiştirebilir veya istediğimiz metni yazabiliriz. 

15. (   ) Hizalı ölçülendirmelerde (DimAligned) ölçülendirme çizgisinin eğimini istediğimiz 
gibi ayarlayabiliriz. 

16. (   ) Sıralı Ölçülendirmelerde (Dimordinate) 0 (sıfır) noktası olarak ekranda herhangi bir 
noktayı alabiliriz. 

17. (   ) Hem çap ölçülendirmelerinde (Dimdiameter) hem de yarıçap (Dimradius) 
ölçülendirmelerinde program kendiliğinden ölçü değerinin önüne “Ф” (fi) işaretini 
koyar. 

18. (   ) Açılı ölçülendirme (Dimangular) sadece birbirine paralel olmayan (kesişen veya 
doğrultuları kesişen) doğruların ölçülendirmelerinde kullanılır. 

ÖLÇME VE DEĞERLENDİRME
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19. (   ) Açılı ölçülendirmelerde (Dimangular) ölçülen açı değeri ölçülendirme çizgisinin 
yerleştirilme pozisyonundan etkilenmez, sabit kalır. 

20. (   ) Hızlı ölçülendirme komutu olarak da bilinen Quick Dimension komutu ile bir defada 
bir dizi ölçü öğesi oluşturulabilir. 

21. (   ) Paralel ölçülendirme (Dimbaseline) yaparken her yapılan ölçülendirme sırası için 
hem ilk hem de son noktayı belirlememiz gerekir. 

22. (   ) Mimarî çizimlerin ölçülendirilmesinde işlemi daha hızlı hale getirdiği için Sürekli 
Ölçülendirme (Dimcontinue) daha sık kullanılır. 

23. (   ) “Properties” Menüsü kullanılarak ölçülendirme değerlerinin hemen hemen 
tamamını değiştirebilmemiz mümkündür. 

24. (   ) Ölçülendirme uzantı çizgileri yapıldığı ölçülendirme stiline uygun olarak program 
tarafından ayarlanır. Eğimleri ve uzantıları değiştirilemez. 

25. (   ) Bir çizim dosyasında yapmış olduğumuz ölçülendirme ayarları aynı dosyadaki daha 
önce yapılmış olan ölçülendirmelerde de aynen uygulanır. Başkaca bir işlem 
yapmamıza gerek yoktur.  
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MODÜL DEĞERLENDİRME  
 
Aşağıda ölçüleri verilmiş şekli bilgisayarda AutoCAD programında çiziniz ve 

kurallarına göre ölçülendiriniz. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

MODÜL DEĞERLENDİRME  
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PERFORMANS TESTİ 

Dersin 
Adı Bilgisayarla Mimarî ve Statik Proje Çizimi ÖĞRENCİNİN 

Amaç Verilen Cismi Bilgisayarla Çizip 
Ölçülendirmek Adı Soyadı: 

Konu Değişik Ölçülendirme Şekilleri Sınıfı Nu: 

GÖZLENECEK DAVRANIŞLAR EVET HAYIR 
1 Verilen şekli istenilen ölçülerde çizdiniz mi?   

2 
Dimension Style Manager diyalog kutusu ile yeni ölçü biçimi 
oluşturmak için herhangi bir yöntemle bu diyalog kutusunu 
açtınız mı? 

  

3 
Yeni ölçülendirme stili için bir isim belirleyerek (kendi 
isminiz, dosyanızın ismi vb.) ölçülendirme stilinizi 
oluşturdunuz mu? 

  

4 
Oluşturduğunuz ölçülendirme stilinizde kendi meslek 
gurubunuzun kabul edilmiş ayarlarına göre (yazı gibi, oklar 
gibi) gerekli parametreleri düzenlediniz mi? 

  

5 
Ölçülendirme çizgileri sınır işaretlerinin ve yazı yüksekliğinin 
büyüklüğünü yapmış olduğunuz çizimin kâğıt üzerine çıktısını 
göz önünde bulundurarak ayarladınız mı? 

  

6 Doğrusal (DimLinear) ölçülendirmeyi nesnenin kendisini veya 
köşelerini belirleyerek yaptınız mı?   

7 
Hizalı ölçülendirme (Dimaligned) yaparken ölçülendirme 
çizgisi ile nesnenin aynı paralellikte olduğuna dikkat ettiniz 
mi? 

  

8 

Açısal ölçülendirme (Dimangular) yaparken ölçülendirme 
çizgisini yerleştirdiğiniz yere göre açı değerinin değiştiğini 
(diğer tarafı 360°’ye tamamlayan değer) görerek nereyi 
ölçülendirmek istiyorsanız ölçülendirmeyi oraya yerleştirdiniz 
mi? 

  

9 

Paralel ölçülendirme (Dimbaseline) yaparken ölçülendirmeye 
başlamadan ölçülendirme çizgileri arasındaki mesafe olan 
Baseline Spacing değerini yazı yüksekliğinize ve diğer 
ölçülendirme ayarlarınıza göre belirlediniz mi? 

  

10 Sıralı ölçülendirme (Dimordinate) yapmaya başlamadan önce 
çiziminizi koordinat eksenine göre taşıdınız mı?   

11 
Ölçülendirme işleminiz bittikten sonra çiziminizi kontrol 
ederek fazla ve eksik unsurlar olup olmadığını kontrol ettiniz 
mi? 

  

 
NOT: Zümre öğretmenleri kararı ile farklı bir değerlendirme yapılabilir 
 
Modülü başarı ile bitirmişseniz bir diğer modüle geçebilirsiniz. 



 

 112

CEVAP ANAHTARLARI 
FAALİYET 1 in CEVAP ANAHTARI: 

1 D 11 D 21 D 31 D 

2 Y 12 Y 22 Y 32 Y 

3 Y 13 D 23 D 33 Y 

4 D 14 Y 24 Y 34 Y 

5 D 15 D 25 Y 35 Y 

6 Y 16 D 26 D 36 D 

7 Y 17 Y 27 D 37 Y 

8 Y 18 D 28 D 38 D 

9 D 19 Y 29 D 39 Y 

10 D 20 Y 30 Y 40 D 
 

FAALİYET 2 nin CEVAP ANAHTARI: 
1 D 11 D 21 Y 

2 Y 12 D 22 D 

3 D 13 D 23 D 

4 Y 14 D 24 Y 

5 Y 15 Y 25 D 

6 D 16 D   

7 Y 17 Y   

8 D 18 Y   

9 Y 19 Y   

10 Y 20 D   
 

DEĞERLENDİRME  
 

Cevaplarınızı cevap anahtarı ile karşılaştırınız ve doğru cevap sayınızı belirleyerek 
kendinizi değerlendiriniz. Değerlendirme sonucunda yanlış cevaplarınızı faaliyete dönerek 
tekrarlayınız. 

Cevaplarınızın çoğunluğu doğru ise diğer öğrenme faaliyetine geçiniz. 
 

CEVAP ANAHTARLARI 
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